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NATIONAL CYBERSECURITY CENTER OF EXCELLENCE 1 

The National Cybersecurity Center of Excellence (NCCoE), a part of the National Institute of Standards 2 
and Technology (NIST), is a collaborative hub where industry organizations, government agencies, and 3 
academic institutions work together to address businesses’ most pressing cybersecurity issues. This 4 
public-private partnership enables the creation of practical cybersecurity solutions for specific 5 
industries, as well as for broad, cross-sector technology challenges. Through consortia under 6 
Cooperative Research and Development Agreements (CRADAs), including technology partners—from 7 
Fortune 50 market leaders to smaller companies specializing in information technology security—the 8 
NCCoE applies standards and best practices to develop modular, easily adaptable example cybersecurity 9 
solutions using commercially available technology. The NCCoE documents these example solutions in 10 
the NIST Special Publication 1800 series, which maps capabilities to the NIST Cybersecurity Framework 11 
and details the steps needed for another entity to re-create the example solution. The NCCoE was 12 
established in 2012 by NIST in partnership with the State of Maryland and Montgomery County, 13 
Maryland. 14 

To learn more about the NCCoE, visit https://www.nccoe.nist.gov/. To learn more about NIST, visit 15 
https://www.nist.gov. 16 

NIST CYBERSECURITY PRACTICE GUIDES 17 

NIST Cybersecurity Practice Guides (Special Publication 1800 series) target specific cybersecurity 18 
challenges in the public and private sectors. They are practical, user-friendly guides that facilitate the 19 
adoption of standards-based approaches to cybersecurity. They show members of the information 20 
security community how to implement example solutions that help them align more easily with relevant 21 
standards and best practices, and provide users with the materials lists, configuration files, and other 22 
information they need to implement a similar approach. 23 

The documents in this series describe example implementations of cybersecurity practices that 24 
businesses and other organizations may voluntarily adopt. These documents do not describe regulations 25 
or mandatory practices, nor do they carry statutory authority. 26 

ABSTRACT 27 

Transport Layer Security (TLS) server certificates are critical to the security of both internet-facing and 28 
private web services. A large- or medium-scale enterprise may have thousands or even tens of 29 
thousands of such certificates, each identifying a specific server in its environment. Despite the critical 30 
importance of these certificates, many organizations lack a formal TLS certificate management program, 31 
and the ability to centrally monitor and manage their certificates. Instead, certificate management tends 32 
to be spread across each of the different groups responsible for the various servers and systems in an 33 
organization. Central security teams struggle to ensure certificates are being properly managed by each 34 
of these disparate groups. Where there is no central certificate management service, the organization is 35 
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at risk, because once certificates are deployed, current inventories must be maintained to support 36 
regular monitoring and certificate maintenance. Organizations that do not properly manage their 37 
certificates face significant risks to their core operations, including:  38 

 application outages caused by expired TLS server certificates 39 

 hidden intrusion, exfiltration, disclosure of sensitive data, or other attacks resulting from 40 
encrypted threats or server impersonation 41 

 disaster-recovery risk that requires rapid replacement of large numbers of certificates and 42 
private keys in response to either certificate authority compromise or discovery of 43 
vulnerabilities in cryptographic algorithms or libraries 44 

Despite the mission-critical nature of TLS server certificates, many organizations have not defined the 45 
clear policies, processes, roles, and responsibilities needed for effective certificate management. 46 
Moreover, many organizations do not leverage available automation tools to support effective 47 
management of the ever-growing numbers of certificates. The consequence is continuing susceptibility 48 
to security incidents. 49 

This NIST Cybersecurity Practice Guide shows large and medium enterprises how to employ a formal TLS 50 
certificate management program to address certificate-based risks and challenges. It describes the TLS 51 
certificate management challenges faced by organizations; provides recommended best practices for 52 
large-scale TLS server certificate management; describes an automated proof-of-concept 53 
implementation that demonstrates how to prevent, detect, and recover from certificate-related 54 
incidents; and provides a mapping of the demonstrated capabilities to the recommended best practices 55 
and to NIST security guidelines and frameworks. 56 

The solutions and architectures presented in this practice guide are built upon standards-based, 57 
commercially available, and open-source products. These solutions can be used by any organization 58 
managing TLS server certificates. Interoperable solutions are provided that are available from different 59 
types of sources (e.g., both commercial and open-source products). 60 

KEYWORDS 61 

 Authentication; certificate; cryptography; identity; key; key management; PKI; private key; public key; 62 
public key infrastructure; server; signature; TLS; Transport Layer Security 63 

DOCUMENT CONVENTIONS 64 

The terms “shall” and “shall not” indicate requirements to be followed strictly in order to conform to the 65 
publication and from which no deviation is permitted. 66 

The terms “should” and “should not” indicate that among several possibilities, one is recommended as 67 
particularly suitable, without mentioning or excluding others, or that a certain course of action is 68 
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preferred but not necessarily required, or that (in the negative form) a certain possibility or course of 69 
action is discouraged but not prohibited. 70 

The terms “may” and “need not” indicate a course of action permissible within the limits of the 71 
publication. 72 

The terms “can” and “cannot” indicate a possibility and capability, whether material, physical, or causal. 73 

CALL FOR PATENT CLAIMS 74 

This public review includes a call for information on essential patent claims (claims whose use would be 75 
required for compliance with the guidance or requirements in this Information Technology Laboratory 76 
[ITL] draft publication). Such guidance and/or requirements may be directly stated in this ITL Publication 77 
or by reference to another publication. This call also includes disclosure, where known, of the existence 78 
of pending U.S. or foreign patent applications relating to this ITL draft publication and of any relevant 79 
unexpired U.S. or foreign patents.  80 

ITL may require from the patent holder, or a party authorized to make assurances on its behalf, in 81 
written or electronic form, either:  82 

a) assurance in the form of a general disclaimer to the effect that such party does not hold and 83 
does not currently intend holding any essential patent claim(s); or  84 

b) assurance that a license to such essential patent claim(s) will be made available to applicants 85 
desiring to utilize the license for the purpose of complying with the guidance or requirements in 86 
this ITL draft publication either:  87 

i) under reasonable terms and conditions that are demonstrably free of any unfair 88 
discrimination; or  89 

ii) without compensation and under reasonable terms and conditions that are 90 
demonstrably free of any unfair discrimination.  91 

Such assurance shall indicate that the patent holder (or third party authorized to make assurances on its 92 
behalf) will include in any documents transferring ownership of patents subject to the assurance, 93 
provisions sufficient to ensure that the commitments in the assurance are binding on the transferee, 94 
and that the transferee will similarly include appropriate provisions in the event of future transfers with 95 
the goal of binding each successor-in-interest.  96 

The assurance shall also indicate that it is intended to be binding on successors-in-interest regardless of 97 
whether such provisions are included in the relevant transfer documents.  98 

Such statements should be addressed to tls-cert-mgmt-nccoe@nist.gov. 99 
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1 Introduction  182 

Organizations that improperly manage their Transport Layer Security (TLS) server certificates risk system 183 
outages and security breaches, which can result in revenue loss, harm to reputation, and exposure of 184 
confidential data to attackers. TLS is the most widely used protocol for securing web transactions and 185 
other communications on internal networks and the internet. TLS certificates are central to the 186 
operation and security of internet-facing and private web services. Some organizations have tens of 187 
thousands of TLS certificates and keys requiring ongoing maintenance and management. 188 

The National Cybersecurity Center of Excellence (NCCoE) at the National Institute of Standards and 189 
Technology (NIST) built a laboratory environment to demonstrate how large and medium enterprises 190 
can better manage TLS server certificates in the following ways: 191 

 defining operational and security policies and identifying roles and responsibilities 192 

 establishing comprehensive certificate inventories and ownership tracking 193 

 conducting continuous monitoring of the certificate operation and security status 194 

 automating certificate management to minimize human error and maximize efficiency on a large 195 
scale 196 

 enabling rapid migration to new certificates and keys as needed in response to certificate 197 
authority (CA) compromise or discovery of vulnerabilities in cryptographic algorithms or libraries 198 

The following volumes of this guide show information technology (IT) professionals and security 199 
engineers how we implemented this example solution. We cover all the products employed in this 200 
reference design. We do not re-create the product manufacturers’ documentation, which is presumed 201 
to be widely available. Rather, these volumes show how we incorporated the products together in our 202 
environment. 203 

Note: These are not comprehensive tutorials. There are many possible service and security configurations 204 
for these products that are out of scope for this reference design. 205 

1.1 Practice Guide Structure  206 

This National Institute of Standards and Technology (NIST) Cybersecurity Practice Guide demonstrates a 207 
standards-based reference design and provides users with the information they need to replicate 208 
automated management of TLS server certificates. This reference design is modular and can be 209 
deployed in whole or in part. 210 

This guide contains four volumes: 211 

 NIST SP 1800-16A: Executive Summary 212 

 NIST SP 1800-16B: Security Risks and Recommended Best Practices 213 

 NIST SP 1800-16C: Approach, Architecture, and Security Characteristics–what we built and why 214 
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 NIST SP 1800-16D: How-To Guides—instructions for building the example solution (you are 215 
here) 216 

Depending on your role in your organization, you might use this guide in different ways: 217 

Business decision makers, including chief security and technology officers, will be interested in the 218 
Executive Summary, NIST SP 1800-16A, which describes the following topics: 219 

 recommendations for TLS server certificate management 220 

 challenges that enterprises face in proper deployment, management, and use of TLS 221 

 example solution built at the NCCoE 222 

You might share the Executive Summary, NIST SP 1800-16A, with your leadership team members to help 223 
them understand the importance of adopting standards-based TLS server certificate management. 224 

Senior information technology and security officers will be informed by NIST SP 1800-16B, which 225 
describes the: 226 

 TLS server certificate infrastructure and management processes 227 

 risks associated with mismanagement of certificates 228 

 organizational challenges associated with server certificate management 229 

 recommended best practices for server certificate management 230 

 recommendations for implementing a successful certificate management program 231 

 mapping of best practices for TLS server certificate management to the NIST Framework for 232 
Improving Critical Infrastructure Cybersecurity (Cybersecurity Framework) 233 

 application of specific controls defined within NIST Special Publication (SP) 800-53 to the TLS 234 
server certificate management recommended best practices 235 

Technology or security program managers who are concerned with how to identify, understand, assess, 236 
and mitigate risk will be interested in NIST SP 1800-16C, which describes what we did and why. The 237 
following sections will be of particular interest: 238 

 Section 3.4.1, Threats, Vulnerabilities and Risks, provides a description of the risk analysis we 239 
performed. 240 

 Section 3.4.2, Security Categorization and SP 800-53 Controls, lists the security controls assigned 241 
to address TLS server certificate risks. 242 

 Section 3.4.3, Security Control Map, maps the security characteristics of this example solution to 243 
cybersecurity standards and best practices. 244 

IT professionals who want to implement such an approach will find this whole practice guide useful. You 245 
can use this How-To portion of the guide, NIST SP 1800-16D, to replicate all or parts of the build created 246 
in our lab. This How-To portion of the guide provides specific product installation, configuration, and 247 
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integration instructions for implementing the example solution. We do not re-create the product 248 
manufacturers’ documentation, which is generally widely available. Rather, we show how we 249 
incorporated the products together in our environment to create an example solution. 250 

This guide assumes that IT professionals have experience implementing security products within the 251 
enterprise. While we have used a suite of commercial and open source products to address this 252 
challenge, this guide does not endorse these particular products. Your organization can adopt this 253 
solution or one that adheres to these guidelines in whole, or you can use this guide as a starting point 254 
for tailoring and implementing parts of providing automation support for TLS server certificate 255 
management. Your organization’s security experts should identify the products that will best integrate 256 
with your existing tools and IT system infrastructure. We hope that you will seek products that are 257 
congruent with applicable standards and best practices. Section 1.4.2, Technologies, lists the products 258 
that we used and maps them to the cybersecurity controls provided by this reference solution. 259 

A NIST Cybersecurity Practice Guide does not describe “the” solution, but a possible solution. This is a 260 
draft guide. We seek feedback on its contents and welcome your input. Comments, suggestions, and 261 
success stories will improve subsequent versions of this guide. Please contribute your thoughts to tls-262 
cert-mgmt-nccoe@nist.gov. 263 

1.2 Build Overview 264 

This NIST Cybersecurity Practice Guide addresses the use of commercially available technologies to 265 
develop an example implementation for managing TLS server certificates. This project focuses on 266 
certificate management in medium and large enterprises that rely on TLS to secure customer-facing and 267 
internal applications. The example implementation developed in this project demonstrates how to 268 
manage TLS server certificates to reduce outages, improve security, and enable disaster recovery 269 
activities. It shows how to establish, assign, change, and track an inventory of TLS certificates; automate 270 
management of TLS certificates; perform continuous monitoring of TLS certificates; perform large-scale 271 
replacement of certificates that are not trusted; log all certificate and private-key management 272 
operations; manage certificates and keys on proxy servers, load balancers, and inspection appliances; 273 
and use a Hardware Security Module (HSM). The HSM can securely generate, store, manage, and use 274 
private keys corresponding to TLS server certificates, the signing keys of internal certificate authorities 275 
(CAs), and symmetric keys that must be kept secret.  276 

1.2.1 Usage Scenarios 277 

The example implementation fulfills the following use cases:  278 

 building and maintaining inventory of the enterprise’s deployed TLS server certificates 279 

 automating management of those certificates, including use of an external CA and protection of 280 
private keys and other secrets by using an HSM 281 

mailto:tls-cert-mgmt-nccoe@nist.gov
mailto:tls-cert-mgmt-nccoe@nist.gov
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 continuously monitoring the certificates for validity 282 

 supporting disaster recovery by quickly replacing a large number of certificates 283 

 logging all certificate and private-key management operations 284 

 for those enterprises with a policy to perform passive inspection, copying private keys from 285 
several different TLS servers to the TLS inspection appliance 286 

1.2.1.1 Building the Inventory 287 

The example implementation demonstrates the ability to establish and maintain a systematized 288 
inventory of certificates (and keys) in use on the network. It enables a user to discover certificates not 289 
currently being managed by the inventory, efficiently enroll and provision new certificates (and keys), 290 
store relevant information with those certificates, and discover the absence of an expected certificate 291 
from a machine where it should be installed. It also enables certificates to be revoked and to change the 292 
owner associated with a certificate, as needed.  293 

1.2.1.2 Automation 294 

The example implementation demonstrates the ability to automatically enroll and provision a new 295 
certificate and can replace a certificate approaching expiration. Automated certificate management is 296 
demonstrated on various enterprise systems, including load balancers acting as TLS proxies that use 297 
remote agentless management, web servers with remote agentless management, web servers using the 298 
Automatic Certificate Management Environment (ACME) protocol, and servers that are deployed via 299 
development operations (DevOps) technologies by using a certificate management plug-in to the 300 
DevOps framework. In conjunction with the demonstration of ACME, HSM is used to securely generate, 301 
store, manage, and process the cryptographic key pairs for one TLS server. Remote agentless 302 
management was used to automate management of the certificates and keys for this system. 303 

1.2.1.3 Continuous Monitoring 304 

The example implementation demonstrates the ability to continuously monitor TLS certificates (and 305 
keys) managed by the inventory system and can act upon the status of any certificate (e.g., report the 306 
status of or replace a certificate that has expired, is about to expire, or does not conform to policy). It 307 
can send periodic expiration reports to certificate owners to show which of their certificates are nearing 308 
expiration, and a variety of notifications and escalating alerts if a certificate’s expiration date 309 
approaches. Continuous monitoring also includes periodic network scans to ensure any unaccounted-for 310 
certificates are discovered and added to the inventory. 311 

1.2.1.4 Disaster Recovery 312 

The example implementation demonstrates how to quickly replace large numbers of certificates that are 313 
located across multiple networks and that are on a variety of server types, because the certificates are 314 
no longer trusted. It can replace certificates that: 315 
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 were issued by a given CA (which would require replacement if the issuing-CA were either 316 
compromised or untrusted) 317 

 have associated keys dependent on a specific cryptographic algorithm (which would need 318 
replacement, e.g., if the algorithm they depend on is no longer considered secure) 319 

 have associated keys generated by a specific cryptographic library after a specific date (which 320 
would need replacement, e.g., if a bug invaded a library on that date)  321 

The example implementation can also track and report on replacement of large numbers of certificates, 322 
so the progress of the large-scale certificate replacement effort can be monitored. 323 

1.2.1.5 Logging 324 

The example implementation demonstrates how to log all certificate and private-key management 325 
operations, including certificate creation, installation and revocation key pair generation, certificate 326 
requests and request approvals, certificate and key copying, and certificate and key replacement. 327 

1.2.1.6 Passive Inspection 328 

The example implementation demonstrates how to perform passive inspection of encrypted TLS 329 
connections. The decision to perform this inspection is complex, because it involves important trade-offs 330 
between traffic security and traffic visibility that each organization should weigh for itself. Some 331 
organizations have determined that the security risks posed by inspection of internal TLS traffic are not 332 
worth the potential benefits of visibility into the encrypted traffic. Other organizations have concluded 333 
that the visibility into their internal traffic provided by TLS inspection is worth the trade-off of the 334 
weaker encryption and other risks that come with such inspection. For these organizations, TLS 335 
inspection may be considered standard practice and may represent a critical component of their threat 336 
detection and service assurance strategies. 337 

Organizations that perform TLS traffic inspections can use the example implementation to securely copy 338 
private keys from several different TLS servers to the TLS inspection appliance, securely replace expiring 339 
keys on servers, and immediately copy those keys to the inspection appliance before expiration—340 
manually and via standardized automated certificate installation. See Appendix A for more detail on 341 
passive inspection, including a scenario. 342 

1.2.2 Logical Architecture 343 

Figure 1-1 depicts the example implementation’s logical architecture, which provides a network 344 
structure and components that enable various types of TLS server certificate management operations to 345 
function. Figure 1-1 illustrates the logical architecture of the TLS server certificate management example 346 
implementation—consisting of an external and an internal portion. The external portion contains an 347 
external CA that is used to issue TLS certificates for some TLS servers in the example implementation. 348 
The internal portion of the network is logically organized into three zones that roughly model a defense-349 
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in-depth strategy of grouping components on subnetworks that require increasing levels of security as 350 
one moves inward from the perimeter of the organization. The zones comprise a demilitarized zone 351 
(DMZ) that sits between the internet and the rest of the enterprise; a data center hosting applications 352 
and services widely used across the enterprise; and a more secure data center hosting critical security 353 
and infrastructure components, including certificate management components.  354 

At the ingress from the internet within the DMZ, a load balancer acts as a TLS proxy and distributes the 355 
traffic it receives from external users across three TLS servers behind it—all serving up the same 356 
application: two Apache servers and one Microsoft Internet Information Services (IIS) server. (Note: To 357 
maintain the diagram’s simplicity in depicting this network, the connections between individual 358 
components are not shown. In the actual network architecture, the load balancer’s network connection 359 
to all three TLS servers is shown behind it.) TLS certificate management demonstrates how to enroll and 360 
provision new certificates to the load balancer and servers in the DMZ and how to perform overall 361 
certificate management on these devices, including automatically replacing a certificate that is nearing 362 
expiration.  363 

Within the data center zone of the logical architecture sit various types of web servers, application 364 
servers, and a DevOps framework—all act as TLS servers. These components demonstrate the ability to 365 
automatically enroll and provision a new certificate and can automatically replace a certificate that is 366 
nearing expiration on these different systems. Various types of certificate management are also 367 
demonstrated, including remote agentless management, the ACME protocol, and the DevOps certificate 368 
management plug-in.  369 

Within the DMZ and the data center zones, taps (depicted as white dots) are used on the network 370 
connections between the load balancer and the servers behind it, and on the network connections 371 
between the DMZ servers and the second-tier servers in the data center behind them. Taps enable all 372 
traffic on the encrypted TLS connections to travel to a TLS inspection appliance for passive decryption. 373 
Figure 1-1 depicts this TLS inspection appliance as a faded icon to convey that some organizations, as a 374 
matter of policy, may not want to include it as part of their network architecture. However, 375 
organizations that consider passive inspection as part of their security assurance strategy can use the 376 
certificate manager depicted in the architecture to securely copy private keys from several different TLS 377 
servers to the TLS inspection appliance, and to securely replace expiring keys on those servers and 378 
immediately copy those keys to the decryption device before expiration—manually and via standardized 379 
automated certificate installation. 380 

Figure 1-1 TLS Server Certificate Management Example Implementation: Logical Architecture 381 
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382 
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Within the data center secure zone of the logical architecture sit the components that perform TLS 383 
server certificate management. These components include internal root and issuing CAs, a certificate 384 
manager, a certificate log server, a certificate network scanning tool, a certificate database, and an HSM. 385 
For demonstration purposes, a TLS server connected to an HSM is also present in this zone.  386 

The certificate manager can be used in conjunction with the certificate database and the various types 387 
of servers in the architecture to demonstrate how to establish and maintain a systematized inventory of 388 
certificates (and keys) used on the network. The certificate manager can also continuously monitor TLS 389 
certificates (and keys) managed by the inventory system and act upon the status of any certificate (e.g., 390 
report a certificate that is expired, about to expire, or does not conform to policy, or it can replace an 391 
expired certificate). It can also send expiration reports and notifications to certificate owners and can 392 
support disaster recovery by quickly replacing a large number of certificates located throughout the 393 
network architecture.  394 

The certificate manager can be used in conjunction with the CAs to enroll and provision certificates (and 395 
keys), store attributes with those certificates, and discover the absence of an expected certificate from a 396 
machine where it should be installed. The certificate manager can revoke certificates and change the 397 
owner associated with that certificate.  398 

The certificate network scanning tool can discover certificates not being managed by the inventory. The 399 
certificate log server can record all certificate and private-key management operations, including 400 
certificate creation, installation, and revocation; key pair generation; certificate requests and request 401 
approvals; certificate and key copying; and certificate and key replacement.  402 

All components in this portion of the architecture—except for the certificate database—are configured 403 
to use the HSM, which can securely generate, store, manage, and process the private key corresponding 404 
to the TLS server’s certificate. The HSM is capable of storing and protecting the symmetric keys that 405 
secure sensitive data in the certificate database, and can generate, store, manage, and process internal 406 
CAs’ signing keys. 407 

1.3 Build Architecture Summary 408 

Figure 1-2 depicts the physical architecture of the example implementation deployed in the NCCoE 409 
laboratory.  410 
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Figure 1-2 TLS Server Certificate Management Example Implementation: Laboratory Configuration 411 

 

The NCCoE laboratory environment provided the following supporting infrastructure for the example 412 
implementation: 413 

 firewall-protected connection to the internet where an external CA resides 414 

 Windows 2012 server with remote desktop manager, which acts as a jump box to facilitate 415 
installation, deployment, and management of server software for collaborative projects 416 

 segmented laboratory network backbone that models the separation typically existent between 417 
subnetworks belonging to different parts of a medium-to-large-scale enterprise—for example, a 418 
DMZ, a data center hosting widely used applications and services, a more secure data center 419 
hosting critical security infrastructure components, and a segment containing user workstations 420 

 virtual machine and network infrastructure  421 

 Windows 2012 server serving as a Microsoft Active Directory (AD) primary domain controller 422 

 the Windows 2012 server running AD Certificate Services, including   423 

• an internal Root CA that can issue and self-sign its own TLS certificate  424 
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• an internal issuing CA that:  425 

o issues TLS certificates to servers that request them (issue CAs are subordinate to and 426 
certified by the root CA)  427 

o manages the life cycle of certificates (including request, issuance, enrollment, 428 
publication, maintenance, revocation, and expiration) 429 

 Microsoft structured query language (SQL) Server hosting the database of TLS certificates and 430 
keys, and corresponding configuration data  431 

 DevOps automation framework, including Kubernetes, Docker, and Jetstack, that demonstrates 432 
automated certificate management when performing open-source container orchestration 433 

 Apache, Microsoft IIS, and NGINX servers, which demonstrate various ways of managing TLS 434 
server certificates, including remote agentless certificate management, management via the 435 
ACME protocol (via the Certbot utility), and management via DevOps 436 

 Apache servers used to demonstrate certificate management on second-tier internal application 437 
servers 438 

The following collaborator-supplied components were integrated into the above supporting 439 
infrastructure to yield the TLS server certificate management example implementation: 440 

 Venafi Trust Protection Platform (TPP), which maintains the certificate inventory, performs 441 
automated TLS server certificate and private-key management, including monitoring, 442 
remediation, and rapid replacement of TLS certificates and keys; TLS certificate and key policy 443 
enforcement; automated certificate requests and renewals; automated network scanning for 444 
TLS certificates; and logging of certificate and private-key management operations 445 

 Symantec SSL Visibility (SSLV), a visibility appliance used to inspect intercepted traffic on 446 
encrypted TLS connections 447 

 SafeNet Assured Technologies (SafeNet AT) Luna SA 1700 HSM, used to securely generate, store, 448 
manage, and process the cryptographic key pair; also uses it to sign TLS certificates within a 449 
hardened, tamper-resistant physical appliance. It is also used to store other keys, such as the 450 
database encryption key and the TLS certificate keys for the key manager component (Venafi 451 
TPP) and the CAs 452 

 DigiCert external CA, which issues and renews TLS certificates 453 

 F5 Networks BIG-IP Local Traffic Manager load balancer, which acts as a TLS proxy and 454 
distributes received traffic across a number of other TLS servers 455 

The remainder of this volume describes in detail the installation, configuration, and integration of the 456 
above supporting infrastructure and collaborator components. 457 
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1.4 Typographic Conventions 458 

The following table presents typographic conventions used in this volume. 459 

Typeface/Symbol Meaning Example 

Italics file names and path names; 
references to documents that 
are not hyperlinks; new 
terms; and placeholders 

For detailed definitions of terms, see 
the NCCoE Glossary. 

Bold names of menus, options, 
command buttons, and fields 

Choose File > Edit. 

Monospace command-line input, 
onscreen computer output, 
sample code examples, and 
status codes 

mkdir 

Monospace Bold command-line user input 
contrasted with computer 
output 

service sshd start 

blue text link to other parts of the 
document, a web URL, or an 
email address 

All publications from NIST’s NCCoE 
are available at 
https://www.nccoe.nist.gov. 

1.5 Supporting Infrastructure 460 

This section is the first in a series of how-to guidance offered in this guide. It contains step-by-step 461 
instructions and points to specific, well-known, and trusted information for installing, configuring, and 462 
securely maintaining the supporting infrastructure components outlined in previous sections of this 463 
document.  464 

All supporting infrastructure components in the following how-to subsections are high-level examples of 465 
services and functions that may reside on any network. For example, the Microsoft suite of AD, CA 466 
services, domain name server (DNS), web, and database services would typically reside on most 467 
organizational networks. Each section follows the other in building the prerequisites. This section on 468 
supporting infrastructure is the basis for the subsequent how-to sections on collaborator capabilities. 469 

The lab backbone is the fundamental component of the architecture and forms the basis to develop the 470 
implementers’ understanding of the simulated build experience. Guidance is provided for each 471 
operating system (OS) installation, with specific instructions on the necessary security and system 472 

https://www.nccoe.nist.gov/
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configurations. Finally, specific ancillary services, installation and security configurations for database 473 
services, web services, etc. are provided. 474 

1.5.1 Lab Backbone 475 

The NCCoE has a specific implementation of its supporting lab network infrastructure or lab backbone. 476 
Although implementors using this document may possess some or most of the components in the TLS 477 
lab backbone, they may encounter slight but significant differences in their lab build. These differences 478 
are attributed to how we configured our lab backbone to suit the needs of the TLS lab and the larger 479 
multitiered lab community within the NCCoE.  480 

The components and configuration approaches listed below may help clarify what basic capabilities are 481 
needed at a minimum to simulate the TLS lab infrastructure backbone.  482 

 network topology–designed to provide strict separation of system and workstation duties: 483 

• Data Center Secure Network–provides physical and logically secure separation of critical 484 
security services from nonprivileged or privileged users without specific security 485 
responsibilities 486 

• Data Center Network–provides less privileged users with access to security maintenance 487 
services that do not require special access to critical security management services 488 

• Workstations Network–provides secure, controlled, and monitored access to nonprivileged 489 
authorized users to perform organizational business 490 

• DMZ–provides secure separation and mitigation of risk to the rest of the critical network 491 
services from public access to public-facing services 492 

 multiple virtual local area networks (VLANs) and separate subnets–customized naming 493 
convention for VLAN names and subnets can be used, or follow the TLS lab approach below: 494 

• VLAN 2198 services the Data Center Secure Network 192.168.1.0/24 495 

• VLAN 2199 services the Data Center Network 192.168.3.0/24 496 

• VLAN 2200 services the Workstations Network 192.168.2.0/24 497 

• VLAN 2197 services the DMZ Network 192.168.4.0/24 498 

• VLAN 2196 services connections between the F5 load balancer and lab firewall 499 
192.168.5.0/24 500 

• VLAN 2202 services wide area network connections between the internet and the firewall; 501 
the address used here should mirror whatever is currently used for what the internet 502 
provider gave in a subnet address  503 

 One or more managed layer three switches must be capable of: 504 
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• traffic separation for six VLANs with multiple devices on each VLAN (see the architecture 505 
diagram for more) 506 

• switched port analyzer (SPAN) or port mirroring functions  507 

• VLAN trunk ports when using multiple switches 508 

 One or more manageable advanced firewalls: 509 

• must be capable of accepting at least six Ethernet port connections for all VLANs if using one 510 
firewall 511 

• must be capable of network address translation (NAT) (port forwarding, hide NAT, and static 512 
NAT) 513 

• should at least be stateful  514 

• should support deep packet inspection for every possible subnet where feasible and 515 
financially practical 516 

1.5.2 Supporting Infrastructure Operating Systems  517 

1.5.2.1 Microsoft Windows 518 

Microsoft Windows and Windows Server are within a group of OSs designed by Microsoft to efficiently 519 
manage enterprise needs for data storage, applications, networking, and communications. In addition to 520 
the standard OSs used, additional ancillary Microsoft services were installed. These are native 521 
components of the OS and critical to the TLS lab design. Guidance on configuration of these ancillary 522 
services will be discussed later in this document in the Supporting Infrastructure Component Services 523 
section.  524 

 AD Services 525 

 DNS Services 526 

 CA Services 527 

1.5.2.1.1 Microsoft Windows and Server Prerequisites  528 
Both Microsoft Windows servers and workstations have minimal hardware prerequisites, listed directly 529 
below this paragraph. In addition, TLS lab host configuration information is provided in Table 1-1 and 530 
Table 1-2 below. While it is not imperative that an implementer uses the TLS lab host naming 531 
convention and internet protocol (IP) addressing schemes, the tables below may prove useful with 532 
informing an organization of the servers and workstations needed should there be customizations to the 533 
TLS lab approach.   534 

While the hardware requirements listed below represent the minimum, most business applications of 535 
this effort may have higher but differing requirements. All the applications in this TLS build will greatly 536 
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benefit from adding more than the minimum resources that Microsoft requires, as shown below, in a 537 
production environment.  538 

Microsoft’s Minimum Hardware Requirements: 539 

 Microsoft Windows Servers 2012 540 

• 1 gigahertz (GHz) 64-bit processor 541 

• 512 megabyte (MB) random access memory (RAM) 542 

• 32 gigabytes (GB) disk space 543 

 Microsoft Windows Workstations 2010 544 

• 1 GHz 64-bit processor 545 

• 2 GB RAM 546 

• 20 GB disk space 547 

1.5.2.1.2 Microsoft Windows Server 2012 Installation  548 

 For instructions regarding downloading the Microsoft Windows Server 2012, refer to the 549 
download and deployment guidance at: https://www.microsoft.com/en-550 
us/evalcenter/evaluate-windows-server-2012-r2. 551 

Given that AD and domain services are critical to the adds1 and adds2 installation process, refer to the 552 
Microsoft Active Directory and Domain Services Installation and Configuration section, 1.5.3.1, of this 553 
document for full instructions after initial basic installation of the OS. 554 

Please use the table below to name and assign IP addresses to all Microsoft Windows Servers used in 555 
the TLS lab build. The Windows Server version used in most cases is Windows 2012 version R2.  556 

Table 1-1 Naming and Addressing Information for all Microsoft Windows Servers 557 

Host Name IP Address Subnet  Gateway 
Software 
Selection 

iis1.ext-nccoe.org 192.168.4.4 255.255.255.0 192.168.4.1 Win2012 R2 
adds1.int-nccoe.org 192.168.1.6 255.255.255.0 192.168.1.1 Win2012 R2 

HSMrootca.int-nccoe.org 192.168.1.10 255.255.255.0 192.168.1.1 Win2012 R2 
BaseSubCA.int-nccoe.org 192.168.1.41 255.255.255.0 192.168.1.1 Win2012 R2 
HRhsm 192.168.1.16 255.255.255.0 192.168.1.1 Win2012 R2 
Venafi1 192.168.1.81 255.255.255.0 192.168.1.1 Win2012 R2 
VTPPTrustDB 192.168.1.89 255.255.255.0 192.168.1.1 Win2012 R2 

iis2.int-nccoe.org 192.168.3.5 255.255.255.0 192.168.3.1 Win2012 R2 

https://www.microsoft.com/en-us/evalcenter/evaluate-windows-server-2012-r2
https://www.microsoft.com/en-us/evalcenter/evaluate-windows-server-2012-r2
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Host Name IP Address Subnet  Gateway 
Software 
Selection 

adds2.int-nccoe.org 192.168.3.7 255.255.255.0 192.168.3.1 Win2012 R2 

dmzdc.ext-nccoe.org 192.168.3.8 255.255.255.0 192.168.3.1 Win2012 R2 

1.5.2.1.3 Microsoft Windows 10 Workstations Installation 558 

 For instructions regarding download of the Microsoft Windows 10 workstation used in this TLS 559 
lab build, refer to the guidance at https://www.microsoft.com/en-us/software-560 
download/windows10. 561 

Please use the table below to name and assign IP addresses to all Microsoft Windows 10 workstations 562 
used in the TLS lab build. The Windows 10 version used in most cases is Windows 10 Pro.  563 

Table 1-2 Naming and Addressing Information for all Microsoft Windows 10 Workstations 564 

Host Name IP Address Subnet  Gateway 
Software 
Selection 

win10-1.int-nccoe.org 192.168.2.11 255.255.255.0 192.168.2.1 Win10_Pro 
win10-2.int-nccoe.org 192.168.2.2 255.255.255.0 192.168.2.1 Win10_Pro 
privuser1.int-nccoe.org 192.168.2.3 255.255.255.0 192.168.2.1 Win10_Pro 
privuser2.int-nccoe.org 192.168.2.4 255.255.255.0 192.168.2.1 Win10_Pro 

1.5.2.2 Linux 565 

Linux is a family of free and open-source OSs based on the Linux kernel, an OS kernel first released on 566 
September 17, 1991, by Linus Torvalds. Fedora Server is a Red Hat Corporation-supported, short life- 567 
cycle, and fully community-supported server OS. Fedora enables system administrators of any skill to 568 
freely (in most cases) make use of the very latest technologies available in the open-source community. 569 

The CentOS Linux distribution is no different in its ability to allow mostly free use of world-class security 570 
and general IT capabilities. CentOS is a manageable and reproducible platform derived from the sources 571 
of Red Hat Enterprise Linux (RHEL) by an open-source community of volunteers. 572 

1.5.2.2.1 Linux Prerequisites 573 
Table 1-3 and Table 1-4 include the host names and IPs used in the TLS lab for all Linux machines. The 574 
recommended minimum hardware requirements for the default installations of Fedora and CentOS have 575 
been noted below. An organization’s requirements may differ. However, it is highly recommended that 576 
the maximum optimal configuration (in accordance with the organization’s available resources) for each 577 
system be applied, as all the applications used in this TLS lab build will benefit from more than the 578 
minimum resources in a production environment.  579 

https://www.microsoft.com/en-us/software-download/windows10
https://www.microsoft.com/en-us/software-download/windows10
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 1 GHz or faster processor 580 

 1 GB system memory 581 

 10 GB unallocated drive space 582 

 1 VMXNET 3 network adapter 583 

1.5.2.2.2 Fedora and CentOS Installation 584 
The OS installation process for the TLS lab Linux machines did not deviate from the standard installation 585 
instructions that exist for each Linux distributor. The links below provide standard guidance for the 586 
Fedora and CentOS installations.   587 

When running through the installation process, in some cases, a standard Fedora installation for 588 
software selection will not suffice. Should this occur, use Table 1-3. If the Software Selection column 589 
includes Fedora Server/Basic Web Server, select Fedora Server for Base Environment, then select Basic 590 
Web Server installation for add-ons, and when prompted, select software packages during the 591 
installation.  592 

The CentOS Software Selection column includes Basic Web Server—select this as the software package 593 
to install when prompted during the installation process for CentOS.    594 

 https://docs.fedoraproject.org/en-US/fedora/f28/install-guide/   595 

 https://docs.centos.org/en-US/centos/install-guide/  596 

Please use Table 1-3 for IP, host name, and other installation-specific options for all Fedora-based 597 
systems in the TLS lab build. 598 

Table 1-3 Naming and Addressing Information for All Fedora-Based Systems 599 

Host Name IP Address Subnet Gateway Software Selection 

syslog2.int-nccoe.org 192.168.3.12 255.255.255.0 192.168.3.1 Fedora Server 

finacme.int-nccoe.org 192.168.3.61 255.255.255.0 192.168.3.1 
Fedora Server/ 
Basic Web Server 

mail1.int-nccoe.org 192.168.3.25 255.255.255.0 192.168.3.1 Fedora Server 

dmzdb.ext-nccoe.org 192.168.3.6 255.255.255.0 192.168.3.1 Fedora Server 

syslog1.int-nccoe.org 192.168.1.12 255.255.255.0 192.168.1.1 Fedora Server 

apache1.ext-ncccoe.org 192.168.4.2 255.255.255.0 192.168.4.1 
Fedora Server/ 
Basic Web Server 

apache2.ext-nccoe.org 192.168.4.3 255.255.255.0 192.168.4.1 
Fedora Server/ 
Basic Web Server 

https://docs.fedoraproject.org/en-US/fedora/f28/install-guide/
https://docs.centos.org/en-US/centos/install-guide/
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Host Name IP Address Subnet Gateway Software Selection 

ws1.int-nccoe.org 192.168.3.87 255.255.255.0 192.168.3.1 
Fedora Server/ 
Basic Web Server 

ws2.int-nccoe.org 192.168.3.88 255.255.255.0 192.168.3.1 
Fedora Server/ 
Basic Web Server 

ws3.int-nccoe.org 192.168.3.89 255.255.255.0 192.168.3.1 
Fedora Server/ 
Basic Web Server 

 
Please use Table 1-4 for IP, host name, and other installation-specific options for all CentOS servers used 600 
in the TLS lab build. 601 

Table 1-4 Naming and Addressing Information for All CentOS Servers 602 

Host Name IP Address Netmask Gateway Software Selection 
scanafi.ext-nccoe.org 192.168.4.107 255.255.255.0 192.168.4.1 Infrastructure Server 
cluster1.int-nccoe.org 192.168.3.103 255.255.255.0 192.168.3.1 Basic Web Server 
cluster2.int-nccoe.org 192.168.3.104 255.255.255.0 192.168.3.1 Basic Web Server 
cluster3.int-nccoe.org 192.168.3.105 255.255.255.0 192.168.3.1 Basic Web Server 

1.5.3 Supporting Infrastructure Component Services 603 

1.5.3.1 Microsoft Active Directory and Domain Services Installation and Configuration 604 

Active Directory Services (ADS) and DNS work together to store directory data and make those resources 605 
available to administrators and users. For example, ADS stores information about user accounts such as 606 
names and passwords. Security is integrated with ADS through log-on authentication and enforced 607 
access control for user, file, directory, and other system objects in the directory of services. 608 
Administrators are able to manage directory data and organization roles across the enterprise. They can 609 
assign permissions to users, which allows users to access resources anywhere on the network. ADS 610 
authenticates and authorizes all users and computers in a Windows domain network. ADS works in 611 
conjunction with Group Policies Objects (GPOs) in assigning and enforcing security policies for all 612 
computers.  613 

A DNS is a protocol for how computers translate domain names. It manages a database used to resolve 614 
domain names to IP addresses, allowing computers to identify each other on the network. DNS is the 615 
primary locator service for AD. ADS is highly dependent on the DNS in most cases, and as a result, most 616 
implementations—including the TLS lab—opt to install the DNS service on the same server as the ADS. 617 

1.5.3.1.1 ADS and DNS Prerequisites 618 
Below are the minimum recommended tools, services, and configurations needed to install ADS and 619 
DNS. 620 
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 The adds1 and adds2 hosts should be built with the Windows Server 20012 OS installed. As 621 
described in Section 1.5.2.1.2 of this document, there are two ADS and DNS servers. The TLS lab 622 
ADS and DNS server names used are adds1.int-nccoe.org and adds2.int-nccoe.org. (Note: The 623 
DNS server may be run locally on the same Active Directory Domain Services [ADDS] server.) 624 

 local network configurations–all of the local network VLANs, IP addresses, and proper routes 625 

 familiarity with Server Manager 626 

 627 
Server Manager is a Windows Server management console that allows administrators to install, 628 
configure, and manage server roles and features. Administrators can manage local and remote servers 629 
without having physical access to them. The ADS and DNS installation process is integrated with Server 630 
Manager, which can be used when installing other server roles.  631 

1.5.3.2 ADS and DNS Installation 632 

For instructions on deploying ADS and DNS on a Windows 2012 server, refer to the guidance at one of 633 
the links below: 634 

 Graphical User Interface (GUI)-Based Installation: https://docs.microsoft.com/en-us/windows-635 
server/identity/ad-ds/deploy/ad-ds-installation-and-removal-wizard-page-descriptions 636 

 Command Line-Based Installation: https://docs.microsoft.com/en-us/windows-637 
server/identity/ad-ds/deploy/install-active-directory-domain-services--level-100- 638 

1.5.3.3 Certificate Authority Services 639 

In an organization where public key infrastructure (PKI) has been implemented, a CA is responsible for 640 
validating the identity of users and computers. The CA assigns a trusted credential for use in 641 
authenticating user and system identities, by issuing a digitally signed and trusted certificate. The CA can 642 
also assist in managing revocation and renewal of its signed certificates.  643 

The first CA built and implemented in a PKI environment is often referred to as the root CA. As the 644 
originator and root of trust, the root CA authorizes all subsequent CAs, called subordinates or issuing 645 
CAs. Subordinate CAs can also designate their own subsidiaries as defined by the root CA, which results 646 
in a certificate hierarchy. The metadata supplied in all certificates issued to CAs lower in the hierarchy 647 
from the root CA contain a trace path back to the root. 648 

A compromised root CA will cripple any organization that depends on the integrity of its issued PKI 649 
certificates, even in lightweight transactions. With full control or significant unauthorized access to the 650 
root CA, a malicious actor may fully infiltrate any transaction that relies on the integrity of the trust 651 
chain where that root CA presides as the anchor. It is recommended all organizations—size 652 
notwithstanding—implement an enterprise stand-alone offline root CA and separate issuing subordinate 653 

https://docs.microsoft.com/en-us/windows-server/identity/ad-ds/deploy/ad-ds-installation-and-removal-wizard-page-descriptions
https://docs.microsoft.com/en-us/windows-server/identity/ad-ds/deploy/ad-ds-installation-and-removal-wizard-page-descriptions
https://docs.microsoft.com/en-us/windows-server/identity/ad-ds/deploy/install-active-directory-domain-services--level-100-
https://docs.microsoft.com/en-us/windows-server/identity/ad-ds/deploy/install-active-directory-domain-services--level-100-
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CA(s) topology wherever possible. Doing so mitigates many of the risks associated with compromised 654 
root CAs. 655 

The TLS lab followed Microsoft’s guidance to develop a highly secure offline stand-alone root CA 656 
coupled with an enterprise online issuing CA. The following CA installation and configuration how-to 657 
guidance aligns with that goal.  658 

1.5.3.3.1 CA Prerequisites  659 
The prerequisite steps to configure the CA(s) include: 660 

 Build HSMrootca.int-nccoe.org and BaseSubCA.int-nccoe.org in accordance with the OS 661 
installation and configuration instructions in Section 1.5.2.1.2. 662 

 Join BaseSubCA.int-nccoe.org to the already created int-nccoe.org domain.  663 

 HSMrootca.int-nccoe.org and BaseSubCA.int-nccoe.org should have network connections to all 664 
the TLS lab subnets needed for CA certificate issuance.  665 

1.5.3.3.2 Installation of Offline Root and Issuing CA 666 
In this implementation scenario, the offline root CA is built, configured, and established as the root of 667 
the trust chain. The root CA is then configured to securely sign and issue certificates for all of its 668 
subordinates. Afterward, it is taken completely offline. Being taken offline includes complete power- 669 
down and highly secures physical storage of the root CA device (specifically the hard drive if possible).  670 

Installation of the root CA through the Server Manager console can be done by installing Active 671 
Directory Certificate Services (ADCS). ADCS is used to create CAs and configure their role to issue and 672 
manage certificates. For instructions on installing ADCS on the root CA and issuing CA server, refer to the 673 
steps below: 674 

1. In the Server Manager, select Manage > click on Add Roles and Features.  675 
2. Follow the Add Roles and Features wizard > in Select Installation Types, select Role-Based or 676 

feature installation. 677 
3. In Select destination server, confirm Select a server from the server pool is selected > select 678 

your local computer. 679 
4. In Select server roles > under Roles, select Active Directory Certificate Services > click Add 680 

Features. 681 
5. In Select features > click Next. 682 
6. In Active Directory Certificate Services > click Next. 683 
7. In Select role services > in Roles, select Certification Authority. 684 
8. In Confirm installation records > click Install. 685 
9. When installation is complete, click Close. 686 
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1.5.3.3.3 Offline Root CA Configuration 687 
After installing ADCS, refer to the steps below to configure and specify cryptographic options for the 688 
root CA:  689 

1. Run Post-deployment Configuration wizard > click on Configure Active Directory Services link. 690 
2. In Credentials, read the credentials information. If needed, provide administrator credentials. 691 
3. In Role Services > select Certification Authority. 692 
4. In Setup Type > select Standalone CA. 693 
5. In CA Type > select Root CA. 694 
6. In Private Key > select Create a new private key to specify type of private key. 695 
7. In Cryptography for CA: 696 

• Select a cryptographic provider: RSA#SafeNet Key Storage Provider. 697 
• Key Length = 2048 698 
• Select the hash algorithm for signing certificates issued by this CA: SHA256. 699 

8. In CA Name > specify the name of CA > RootCA. 700 
9. For Validity Period > select 2 Years. 701 
10. Specify the database location > C:\Window\system32\CertLog. 702 
11. Review the CA configuration and click Configure. 703 
12. Click Close when the confirmation message appears.  704 

 705 
To configure the CRL Distribution Point (CDP) and Authority Information Access (AIA) extensions on the 706 
root CA, follow the steps below:  707 

1. In Server Manager, go to Tools > select Certification Authority. 708 
2. Right-click RootCA > click Properties. 709 
3. Click the Extensions tab. Ensure Select Extension is set to CDP.  710 
4. In the Specify locations from which users can obtain a certificate revocation list (CRL), do the 711 

following: 712 
a. Select the entry 713 

file://<ServerDNSName>/CertEnroll/<CaName><CRLNameSuffix><DeltaCRLAllowed>.c714 
rl and then click Remove. In Confirm removal, click Yes. 715 

b. Select the entry 716 
http://<ServerDNSName>/CertEnroll/<CaName><CRLNameSuffix><DeltaCRLAllowed>.717 
crl and then click Remove. In Confirm removal, click Yes. 718 

5. In Specify locations from which users can obtain a certificate revocation list (CRL), click Add.  719 
6. In Add Location, in Location, type 720 

http://BaseSubCA/CertEnroll/<CaName><CRLNameSuffix><DeltaCRLAllowed>.crl and then click 721 
OK. This returns to the CA properties dialogue box. 722 

7. On the Extensions tab, select the following checkboxes: 723 
• Include in CRLs. Clients use this to find the Delta CRL locations. 724 
• Include in the CDP extension of issued certificates.  725 
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8. In Specify locations from which users can obtain a certificate revocation list (CRL), select the 726 
entry that starts with 727 
ldap://CN=CATruncatedName>,CRLNameSuffix>,CN=<ServerShortName>.  728 

9. On the Extensions tab, select the following checkbox: 729 
• Include in all CRLs. Specifies where to publish in the Active Directory when publishing 730 

manually. 731 
• In Specify locations, users can obtain a certificate revocation list (CRL). Select the entry 732 

C:\\Windows\system32\CertSrv\CertEnroll\<CaName><CRLNameSuffix><DeltaCRLAll733 
owed>.crl.  734 

10. On the Extensions tab, select the following checkboxes: 735 
• Publish CRLs to this location. 736 
• Publish Delta CRLs to this location. 737 

11. Change Select extension to Authority Information Access (AIA). 738 
12. In the Specify locations, users can obtain a certificate revocation list (CRL) do the following: 739 

a. Select the entry 740 
http://<ServerDNSName>/CertEnroll/<ServerDNSName>_<CaName><CertificateName741 
>.crt and then click Remove. In Confirm removal, click Yes. 742 

b. Select the entry 743 
file://<ServerDNSName>/CertEnroll/<ServerDNSName>_<CaName><CertificateName>744 
.crt and then click Remove. In Confirm removal, click Yes. 745 

13. In Specify locations, users can obtain a CRL, click Add.  746 
14. In Add Location, in Location, type 747 

http://BaseSubCA/CertEnroll/<ServerDNSName>_<CaName><CertificateName>.crt and then 748 
click OK. This returns to the CA properties dialogue box. 749 

15. On the Extensions tab, select the following checkbox: 750 
• Include in the AIA of issued certificates. 751 

16. In Specify locations from which users can obtain a certificate revocation list (CRL), select the 752 
entry that starts with ldap://CN=CATruncatedName>,CN=AIA,CN=PublicKeyServices.  753 

17. On the Extensions tab, select the following checkbox: 754 
• Include in the AIA extension of issued certificates. 755 

18. In Specify locations, users can obtain a certificate revocation list CRL. Select the entry 756 
C:\\Windows\system32\CertSrv\CertEnroll\<ServerDNSName>_<CaName><CertificateName>757 
.crt.  758 

19. On the Extensions tab, ensure AIA extension of issued certificates is not selected. 759 
20. When prompted to restart Active Directory Certificate Services, click No. Restart that service 760 

later. 761 
21. Go back to RootCA and expand folders to right-click on Revoked Certificates > select All Tasks   762 

> click Publish. 763 
22. When prompted to Publish CRL, select New CRL > click OK. 764 
23. To configure the Registry Settings, run cmd as an administrator and type the following 765 

commands: 766 
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certutil -setreg CA\ValidityPeriod “Years” 767 
certutil –setreg CA\ValidityPeriodUnits 2 768 

 

 769 
 
 

certutil -setreg CA\DSConfigDN “CN=Configuration,DC=int-nccoe,DC=org” 770 
 

 771 
 

cerutil -setreg CA\DSDomainDN “DC=int-nccoe,DC=org” 772 
 

 773 
 

24. For it to accept the new values, restart services > go to Administrative Tools > double-click 774 
Certification Authority. 775 

25. Select the RootCA > right-click to select All Tasks > click Start Service. 776 
26. Go back to RootCA to expand folders > right-click on Revoked Certificates > select All Tasks > 777 

click Publish to publish revoked certificates. 778 

1.5.3.3.4 Enterprise Subordinate/Issuing CA Configuration 779 
After installing ADCS, follow the steps below to configure and specify cryptographic options for the 780 
issuing CA: 781 
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1. Run Post-deployment Configuration wizard > click on Configure Active Directory Services link. 782 
2. In Credentials, read the credentials information. If needed, provide administrator credentials. 783 
3. In Role Services > select Certification Authority. 784 
4. In Setup Type > select Enterprise CA. 785 
5. In CA Type > select Subordinate CA. 786 
6. In Private Key > select Create a new private key to specify type of private key. 787 
7. In Cryptography for CA: 788 

• Select a cryptographic provider: RSA#SafeNet Key Storage Provider. 789 
• Key Length = 2048 790 
• Select the hash algorithm for signing certificates issued by this CA: SHA256. 791 

8. In CA Name > specify the name of the CA > BaseSubCA. 792 
9. In Certificate Request > select Save a certificate request to file on the target machine > specify 793 

folder location > C:\BaseSubCA.int-nccoe.org_int-nccoe-BASESUBCA-CA.req. 794 
10. In CA Database > specify the folder location for the certification database > 795 

C:\Windows\system32\CertLog. 796 
11. In Confirmation > confirm configurations and select Configure > click Close. 797 
12. Copy the BaseSubCA request file from the BaseSubCA server to the RootCA server at  798 

C:\Windows\System32\CertServ\CertEnroll. 799 
13. Copy rootCA.crl and rootCA.crt to the BaseSubCA server at 800 

C:\Windows\System32\CertServ\CertEnroll. 801 
14. To issue a certificate to the BaseSubCA server from the RootCA server, go to Administrative 802 

Tools > double-click Certification Authority.  803 
15. Select BaseSubCA > right-click to select All Tasks > click Submit new request. 804 
16. Select and open the request file in the dialogue box. 805 
17. Go back to the Certification Authority > select BaseSubCA and expand folders > click on 806 

Pending Requests. 807 
18. Right-click the pending certificate > right-click to select All Tasks > click Issue.  808 
19. Go to Issued Certificates to view the issued certificate. 809 
20. Double-click on the issued certificate. 810 
21. Go to the Details tab > click Copy to File. 811 
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 812 
 

22. Follow the Certificate Export wizard and select the desired format: 813 
 

 814 
 

23. Save the file as subCA > file type is PKCS #7 Certificates (*.p7b). 815 
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 816 
 

24. Specify the file name to export: 817 
 

 818 
 

25. Complete the Certificate Export Wizard by confirming settings > click Finish. 819 
26. In Export was successful > click OK. 820 
27. Copy subCA.p7b from the RootCA server at C:\WindowSystem32\CerServ\CertEnroll to the 821 

BaseSubCA server at C:\WindowSystem32\CerServ\CertEnroll. 822 
28. On the BaseSubCA server > shift right-click > open the command prompt. 823 
29. Publish the CA Root certificate into Directory Services with the following command: 824 

 
certutil -dspublish -f (tab to rootCA.crt file) RootCA 825 
 826 
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 827 
 

30. To publish the crl file, type the following command: 828 
certutil -dspublish -f (tab to .crl file) 829 

 

 830 
 

31. Set the Domain Policy to make the RootCA trusted by all domain computers. 831 
32. Install the certificate in the subCA server > go to Administrative Tools > double-click 832 

Certification Authority. 833 
33. Select the CA > right-click to select All Tasks > click Install CA Certificate. 834 
34. Select the .p7b file to complete the CA installation. 835 
35. A warning message will be received that the revocation server is offline > click OK to ignore the 836 

message.  837 
36. Power down the RootCA server.  838 
37. Go to Administrative Tools > right-click the CA > select All Tasks > click Start Service to start 839 

services. 840 
38. Install .crt files on the Default Domain Policy. 841 
39. Go to the domain controller (DC).  842 
40. Go to Administrative Tools > open Group Policy Management console. 843 
41. Go to the organization’s domain > right-click the Default Domain Policy folder > select Edit. 844 
42. Navigate to Computer Configuration, go to Policies > Window Settings > Security Settings > 845 

Public Key Policies > right-click Intermediate Certification Authorities > select Import.  846 
43. Follow the Certificate Import Wizard > click Next. 847 
44. Select the subCA.crt file to import > click Next to import file. 848 
45. Confirm details > click Finish. 849 
46. A dialogue box will pop up to confirm The import was successful. 850 
47. Go to Trusted Root Certification Authority folder and right-click> select Import. 851 
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48. Follow the Certificate Import Wizard > click Next. 852 
49. Select the rootCA.crt file to import > click Next to import file. 853 
50. Confirm details > click Finish. 854 
51. A dialogue box will appear to confirm The import was successful. 855 

1.5.4 Database Services 856 

1.5.4.1 Microsoft SQL Database Services  857 

Microsoft SQL (MSQL) Server is a relational database management system developed by Microsoft. As a 858 
database server and a software product, its primary function is to store and retrieve data as requested 859 
by other software applications. MSQL can operate on the same or another computer across a network. 860 

1.5.4.1.1 Prerequisites for MSQL Database Services  861 
The information below is Microsoft’s recommended minimum for default installation of MSQL. An 862 
organization’s requirements may differ. However, all applications can benefit from more than the 863 
minimum resources in a production environment. 864 

 1.4 GHz 64-bit processor 865 

 1 GB RAM 866 

 6 GB disk space 867 

 administration privileges (local installations must run Setup as an administrator) 868 

One MSQL database was used for the TLS lab build to support the Venafi TPP server. This guide installs 869 
only the basic MSQL application on a server. This prepares the specific configurations that are discussed 870 
in the Venafi TPP How -To guidance section. As a prerequisite, see the OS installation instructions in 871 
Section 1.5.2.1.2 to build the VTPPTrustDB.int-nccoe.org server. 872 

1.5.4.1.2 Installation of MSQL Database Services  873 
To install MSQL on a Windows 2016 Server, follow the Microsoft steps in the link below: 874 

 Download here: https://www.microsoft.com/en-us/sql-server/sql-server-875 
downloads?&OCID=AID739534_SEM_at7DarBF&MarinID=sat7DarBF_340829462634_microsoft876 
%20sql%20download_e_c__68045082145_kwd-343189224165_ 877 

 Install and configure here: https://docs.microsoft.com/en-us/sql/database-engine/install-878 
windows/install-sql-server-from-the-installation-wizard-setup?view=sql-server-2017 879 

 Install MSQL as a stand-alone server. 880 

 Specify the Database Engineer Configuration in step 15 by selecting SQL Server Administrators. 881 

https://www.microsoft.com/en-us/sql-server/sql-server-downloads?&OCID=AID739534_SEM_at7DarBF&MarinID=sat7DarBF_340829462634_microsoft%20sql%20download_e_c__68045082145_kwd-343189224165_
https://www.microsoft.com/en-us/sql-server/sql-server-downloads?&OCID=AID739534_SEM_at7DarBF&MarinID=sat7DarBF_340829462634_microsoft%20sql%20download_e_c__68045082145_kwd-343189224165_
https://www.microsoft.com/en-us/sql-server/sql-server-downloads?&OCID=AID739534_SEM_at7DarBF&MarinID=sat7DarBF_340829462634_microsoft%20sql%20download_e_c__68045082145_kwd-343189224165_
https://docs.microsoft.com/en-us/sql/database-engine/install-windows/install-sql-server-from-the-installation-wizard-setup?view=sql-server-2017
https://docs.microsoft.com/en-us/sql/database-engine/install-windows/install-sql-server-from-the-installation-wizard-setup?view=sql-server-2017
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1.5.4.2 MariaDB Database Services 882 

The original inventors of MySQL developed the MariaDB server, which is highly compatible with MySQL.  883 
This allows a drop-in replacement capability with library binary parity and exact matching with MySQL’s 884 
application programming interfaces and commands.  885 

Like MySQL, the open-source version of MariaDB can scale and performs as well as most enterprise 886 
database servers. The TLS lab uses the MariaDB to serve its public-facing (DMZ) web-based TLS services 887 
described in this document.   888 

1.5.4.2.1 Prerequisites for MariaDB Database Services  889 
The host named dmzdb.ext-nccoe.org should have already been set up within the Fedora OS how-to 890 
guidance of Section 1.5.2.2.2. Complete this setup prior to installing the MariaDB server. 891 

1.5.4.2.2 Installation of MariaDB Database Services  892 

 To download and install MariaDB, please refer to the fedoraproject.org guidance at 893 
https://fedoraproject.org/wiki/MariaDB 894 

1.5.4.2.3 Configuration of MariaDB Database Services  895 
MariaDB is used to serve dynamic web content with the Drupal application. All three web servers used 896 
in the DMZ must be configured via Drupal to point to one database. As a result, the database must be 897 
configured to accept connections from the Drupal web servers. MariaDB can be configured by using the 898 
Fedora Linux command line. To start, first set up a secure password for the root and any other 899 
administrative accounts (see the MariaDB setup instructions on how to specify other accounts). Log in to 900 
the dmzdb.int-nccoe.org by using the local command line shell or secure remote administration client 901 
(ssh, putty, openssh). Once logged into the system, use the following command to launch MariaDB from 902 
the Fedora Linux:  903 

[root@dmzdb ~]# mysql -p   904 

Note: Although the root account is displayed here as the login account, configuring MariaDB 905 
with the root user in a production environment is not recommended.   906 

Configure the database to allow remote connections from either the IP addresses or host names used in 907 
the TLS lab. If the IP addresses and host names were customized (apache1: 192.168.4.2, apache2: 908 
192.168.4.3, iis1: 192.168.4.4), please double-check and change the IP addresses in the database by 909 
using the commands below. If custom host names were used in place of the IP addresses, the database 910 
DNS or host resolution is set to properly resolve to the right IP addresses.  911 

[root@dmzdb ~]# mysql -p 912 

Enter password: 913 

Welcome to the MariaDB monitor. Commands end with ; or \g. 914 
Your MariaDB connection id is 1012018 915 

https://fedoraproject.org/wiki/MariaDB
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Server version: 10.2.16-MariaDB MariaDB Server 916 
 917 

Copyright (c) 2000, 2018, Oracle, MariaDB Corporation Ab and others. 918 

Type 'help;' or '\h' for help. Type '\c' to clear the current input statement. 919 

MariaDB [(none)]>  create database EXT_NCCOE_DB; 920 

MariaDB [(none)]>  grant all privileges on EXT_NCCOE_DB.* to 921 
'EXTADMIN'@'192.168.4.2'  IDENTIFIED BY 'YOUR PASSWORD'; 922 

MariaDB [(none)]>  grant all privileges on EXT_NCCOE_DB.* to 923 
'EXTADMIN'@'192.168.4.3'  IDENTIFIED BY 'YOUR PASSWORD'; 924 

MariaDB [(none)]>  grant all privileges on EXT_NCCOE_DB.* to 925 
'EXTADMIN'@'192.168.4.4'  IDENTIFIED BY 'YOUR PASSWORD'; 926 

MariaDB [(none)]> quit; 927 

Add rules to the local Linux firewall to allow database traffic inbound. Please use the following 928 
commands to allow database traffic to inbound ports on the MariaDB server: 929 

 Type the following command to allow database connections to Apache: 930 
iptables-I INPUT -p tcp –dport 3306 -mstate --state related, ESTABLISHED, new -931 
j ACCEPT 932 

1.5.5 TLS Web Services 933 

1.5.5.1 Microsoft Internet Information Services  934 

The web server (IIS) role in Windows Server 2012 provides a means for hosting websites, services, and 935 
applications. IIS information can be shared with users on the internet, an intranet, or an extranet. IIS is a 936 
unified web platform that integrates IIS, ASP.NET, File Transfer Protocol services, Personal Home Page 937 
(PHP), and Windows Communication Foundation. 938 

The TLS lab utilized the IIS server as a public-facing member of a load balance web cluster for public-939 
facing internet services. It was also used as an intranet server to simulate an employee web-based 940 
knowledge management system that is internal to an organization.  941 

1.5.5.1.1 IIS Prerequisites 942 
Complete the following prerequisite steps prior to installing and configuring IIS: 943 

 Server iis2.int-nccoe.org should ideally be a member of the domain for more streamlined TLS 944 
certificate management. 945 

 The IIS administrator must have Request Certificates permission on the issuing CA. 946 

 The iis1.int-nccoe.org and iss2.int-nccoe.org servers should be set up per Section 1.5.2.1.2. 947 

 Server iis1.int-nccoe.org should be used for the public-facing web-based cluster. 948 
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 Server iis2.int-nccoe.org should be used as the internal intranet server. 949 

1.5.5.2 IIS Installation  950 

IIS is the topic of this section, however, the PHP is a key component of the IIS installation for the TLS lab 951 
implementation of the iis1.int-nccoe.org internet-facing server. PHP is a script language and interpreter 952 
and a server-side language that assists IIS and Drupal in serving dynamic web content.   953 

Please follow the instructions in the link below to install IIS and PHP. The iis2.int-nccoe.org server can be 954 
set up without PHP installed. Please follow the same instructions below for the iis2 server—skip the PHP 955 
part of the installation process.  956 

 https://docs.microsoft.com/en-us/iis/application-frameworks/scenario-build-a-php-website-on-957 
iis/configuring-step-1-install-iis-and-php 958 

Windows 2012 Server provides several methods for enrolling certificates: two of these are the 959 
Certificate Enrollment Policy (CEP) and Certificate Enrollment Service (CES). The CEP web service enables 960 
users and computers to obtain certificate enrollment policy information. This information includes what 961 
types of certificates can be requested and what CAs can issue them. CES provides another web service 962 
that allows users and computers to perform certificate enrollment by using the hypertext transfer 963 
protocol secure (https). To separate traffic, the CES can be installed on a computer that is separate from 964 
the CA. Together with the CEP web service, CES enables policy-based certificate enrollment when the 965 
client computer is not a member of a domain or when a domain member is not connected to the 966 
domain. CEP/CES also enables cross-forest, policy-based certificate enrollment.  967 

For the purpose of the lab, the IIS configuration option selected for authentication type for the CES is 968 
Windows integrated authentication. This option provides Kerberos authentication for devices 969 
connected to the internal network and joined to a domain. The service account selected is the Use the 970 
built-in application pool identity.  971 

To configure the SSL protocol to encrypt network traffic, obtain a certificate for IIS, and configure https 972 
on the default website, please refer to the link below.  973 

 https://social.technet.microsoft.com/wiki/contents/articles/12485.configure-ssltls-on-a-web-974 
site-in-the-domain-with-an-enterprise-ca.aspx 975 

1.5.5.3 Apache Web Services  976 

The Apache HTTP Server is a free and open-source cross-platform web server software, released under 977 
the terms of Apache License 2.0. Apache is developed and maintained by an open community of 978 
developers under the Apache Software Foundation. 979 

https://docs.microsoft.com/en-us/iis/application-frameworks/scenario-build-a-php-website-on-iis/configuring-step-1-install-iis-and-php
https://docs.microsoft.com/en-us/iis/application-frameworks/scenario-build-a-php-website-on-iis/configuring-step-1-install-iis-and-php
https://social.technet.microsoft.com/wiki/contents/articles/12485.configure-ssltls-on-a-web-site-in-the-domain-with-an-enterprise-ca.aspx
https://social.technet.microsoft.com/wiki/contents/articles/12485.configure-ssltls-on-a-web-site-in-the-domain-with-an-enterprise-ca.aspx
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1.5.5.3.1 Apache Web Services Prerequisites 980 
The Apache web server was used extensively throughout the TLS lab architecture to demonstrate the 981 
various means of automated and manual management of TLS certificates. The following servers should 982 
be built in accordance with the instructions in Section 1.5.2.2.2.  983 

 apache1.ext-ncccoe.org 984 

 apache2.ext-nccoe.org 985 

 ws1.int-nccoe.org 986 

 ws2.int-nccoe.org 987 

 ws3.int-nccoe.org 988 

1.5.5.3.2 Apache Installation 989 
PHP is a key component of the Apache installation for the TLS lab implementation of all of the above 990 
web servers. PHP assists Apache and Drupal in serving dynamic web content. Please follow the 991 
instructions below for installing Apache and PHP.  992 

For the Apache web server installation, please refer to this guidance: https://docs.fedoraproject.org/en-993 
US/fedora/f28/system-administrators-guide/servers/Web_Servers/ 994 

All Drupal installations have dependencies on the base PHP application and its supplemental modules. In 995 
addition to the base PHP installation, also install the additional modules by using the following 996 
command. 997 

 dnf install drush php php-mysqli php-json php-mbstring php-gd php-dom php-xml 998 
php-simplexml php-cli php-fpm php-mysqlnd php-pdop-gd php-dom php-xml php-999 
simplexml php   1000 

1.5.5.3.3 Apache Web Services Configuration 1001 
The TLS lab enabled https on the Apache web servers. For instructions on setting up OpenSSL, refer to 1002 
the “Using mod_ssl” section from the following link: https://docs.fedoraproject.org/en-US/quick-1003 
docs/getting-started-with-apache-http-server/ 1004 

To allow http and https connections through the local Fedora firewall to Apache, perform the following 1005 
steps: 1006 

 Type the following command to allow http connections to Apache: 1007 
iptables-I INPUT -p tcp –dport 80 -mstate --state related, ESTABLISHED, new -j 1008 
ACCEPT 1009 

 Type the following command to allow https connections to apache: 1010 
iptables-I INPUT -p tcp –dport 443 -mstate --state related, ESTABLISHED, new -j 1011 
ACCEPT 1012 

Save the newly created firewall rules with the following command: iptables-save 1013 

https://docs.fedoraproject.org/en-US/fedora/f28/system-administrators-guide/servers/Web_Servers/
https://docs.fedoraproject.org/en-US/fedora/f28/system-administrators-guide/servers/Web_Servers/
https://docs.fedoraproject.org/en-US/quick-docs/getting-started-with-apache-http-server/
https://docs.fedoraproject.org/en-US/quick-docs/getting-started-with-apache-http-server/
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1.5.5.4 Drupal Web Content Management Services 1014 

Drupal is a scalable, open platform for web content management. Drupal can be installed on multiple 1015 
OSs, including, Fedora, CentOS, and IIS. The TLS lab utilized Drupal to serve web pages on all three of the 1016 
load balanced web servers in the public-facing DMZ.  1017 

1.5.5.4.1 Drupal Prerequisites 1018 

 PHP 5.5.9 or higher 1019 

 MySQL 5.5.3 or MariaDB 5.5.20 1020 

 Apache or IIS web server 1021 

1.5.5.4.2 Drupal Web Content Management System Download and Installation 1022 
One server should run throughout the setup process, including the database setup. The remaining two 1023 
servers should be set up to point to the existing database once the first server has been set up. All web 1024 
servers should be set up to use MariaDB, not MSQL. Use the guidance below for download, installation, 1025 
and configuration of Drupal to simulate the TLS lab architecture: 1026 

 download: https://www.drupal.org/download 1027 

 Apache installation and configuration: https://www.drupal.org/docs/7/install 1028 

 IIS installation and configuration: https://www.drupal.org/docs/develop/local-server-1029 
setup/windows-development-environment/installing-on-windows-server 1030 

1.5.5.4.3 Web Services Drupal Configuration 1031 
A web service is a software system designed to support machine-to-machine interaction over a network. 1032 
A web service is normally accessed over a network and then executed on a remote system hosting the 1033 
requested services. Web services protocols normally use application programming interfaces (APIs) 1034 
based on RESTful, simple object access protocol (SOAP), and extensible markup language (XML) 1035 
protocols. It is a best practice to execute web services that carry critical personally identifiable 1036 
information and other sensitive information by using TLS-based encrypted communication channels.   1037 

The TLS lab tested implementation of passive monitoring for TLS-enabled web services traffic. The 1038 
rationale behind this approach is covered in the Symantec How-To guide section of this document. In 1039 
Appendix A, Passive Inspection, see the full description of how the passive monitoring network was 1040 
configured.  1041 

The web services servers are configured to test the basic passive TLS monitoring capability and are not 1042 
typical of a fully operational web services implementation. The RESTful, SOAP, and XML protocols are 1043 
not used in the TLS Lab. Rudimentary machine-to-machine communication over a secured TLS network 1044 
is configured within each DMZ web server by using JavaScript, PHP, and Drupal’s in-line What-You-See-1045 
Is-What-You-Get (also known as WYSIWYG) hypertext markup language (HTML) content creation editor. 1046 

https://www.drupal.org/download
https://www.drupal.org/docs/7/install
https://www.drupal.org/docs/develop/local-server-setup/windows-development-environment/installing-on-windows-server
https://www.drupal.org/docs/develop/local-server-setup/windows-development-environment/installing-on-windows-server
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A simple PHP script that was created for each web service prompted each of the three web services 1047 
servers to retrieve and push its current times to the main web server. The JavaScript included in the 1048 
Drupal-based DMZ servers was set to grab updates of the time each second by using https connectivity. 1049 
Use the steps below to re-create this setup. 1050 

Part 1: Drupal DMZ Servers Configuration  1051 

1. Log in to Drupal by using the content administrator with enough rights to create a basic page. 1052 
2. Navigate to the following administrative menu item (top of the page on the left side, then use 1053 

the links within the Content administration page itself to navigate to the remaining sections):  1054 
Content > Add Content > Basic Page 1055 

3. Verify that a page is displayed that allows entry of data by using a Title and Body HTML form. 1056 
4. Give this page any title.  1057 
5. Before populating the body section of the page, ensure that the Text Format is set to Full Html 1058 

and PHP. If that selection is not present, enable the PHP Filter module in the Drupal Modules 1059 
section of Drupal, and try again. 1060 

6. Upon completing step 5, paste the following code into the body of the new document: 1061 
<div id="timeid"></div> 1062 
 
<?php 1063 
 1064 
$serveraddress = $_SERVER['SERVER_ADDR'];  1065 
 1066 
$javagettime = <<<EOFF 1067 
<script> 1068 
mydata = "TEST"; 1069 
function ExportValues(mydata) { 1070 
         var xhttp; 1071 
        if (window.XMLHttpRequest) { 1072 
                // code for modern browsers 1073 
                xhttp = new XMLHttpRequest(); 1074 
        } else { 1075 
                // code for IE6, IE5 1076 
                xhttp = new ActiveXObject("Microsoft.XMLHTTP"); 1077 
        } 1078 
        xhttp.onreadystatechange = function() { 1079 
                if (this.readyState == 4 && this.status == 200) { 1080 
                        document.getElementById("timeid").innerHTML = 1081 
this.responseText; 1082 
                } 1083 
        }; 1084 
 1085 
        xhttp.open("GET", "https://$serveraddress/PHPTIME.php", true); 1086 
        xhttp.send(); 1087 
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} 1088 
 1089 
ExportValues(mydata); 1090 
setInterval(function(){ ExportValues(mydata); }, 1000); 1091 
</script> 1092 
 1093 
EOFF; 1094 
echo $javagettime; 1095 
 1096 
?> 1097 

7. Click on the Publishing options tab below, then make sure that Published and Promoted to 1098 
front page are selected as options. 1099 

8. Save the page.  1100 
9. Repeat these steps for each web services server.  1101 

Part II: Drupal DMZ Servers Configuration  1102 

The code above in Part I instructs the DMZ web server to connect to itself and execute the script 1103 
PHPTIME.php within its own Drupal directory. This file will be created here in Part II. The PHPTIME.php 1104 
file uses a curl script to simulate secure TLS server-to-server communication between the DMZ web 1105 
server and its designated web services server. Follow the steps below to create this file on all the DMZ 1106 
web servers.  1107 

1. Log in to the local web administration account for each of the three DMZ-based web servers. 1108 
Navigate to the local Drupal stored file system where Drupal is served to the public. On Apache 1109 
servers, this will be /var/www/html/<DRUPAL DIRECTORY NAME USED>. On IIS servers, this will 1110 
be the Drupal document root for the website instantiation.  1111 

2. Launch a text editor (notepad++ or notepad for Windows or VIM or VI editor for Linux), then 1112 
paste the following into that file: 1113 
<?php 1114 
 header("Access-Control-Allow-Origin: *"); 1115 
 $ch = curl_init(); 1116 
 1117 
 curl_setopt($ch, CURLOPT_URL, 'https://ws2.int-nccoe.org'); 1118 
 curl_setopt($ch, CURLOPT_RETURNTRANSFER, 1); 1119 
 curl_setopt($ch, CURLOPT_SSL_VERIFYHOST, false); 1120 
 curl_setopt($ch, CURLOPT_SSL_VERIFYPEER, false); 1121 
 1122 
 $result = curl_exec($ch); 1123 
 if (curl_errno($ch)) { 1124 
      echo 'Error:' . curl_error($ch); 1125 
 } 1126 
 curl_close ($ch); 1127 
 1128 
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 echo $result; 1129 
?> 1130 

3. The following line will need to be changed on each DMZ web server and customized with the 1131 
individual host name for the web services server assigned to the specific DMZ web server. Each 1132 
DMZ web server should have its own individual web services server: 1133 
 curl_setopt($ch, CURLOPT_URL,’https://CHANGE TO YOUR MACHINE NAME’); 1134 

4. Save this file with a .php extension into the root base directory of the Drupal site created for this 1135 
demonstration. 1136 

Web Services Server Configuration 1137 

The web services server must be configured to check its own time and send the results back to the 1138 
requesting DMZ web server via secure communication. Use the following guidance to set up the web 1139 
services server.  1140 

1. Log in to the command line for each web services server, and navigate to the Apache document 1141 
root configured in the httpd.conf file for Apache. In most cases it is /var/www/html. 1142 

2. Open a VIM/VI editor and paste the following into that file: 1143 
<?php 1144 
 1145 
$sourceip = $_SERVER['HTTP_ORIGIN']; 1146 
 1147 
if (isset($_SERVER["HTTP_ORIGIN"]) === true) { 1148 
        $origin = $_SERVER["HTTP_ORIGIN"]; 1149 
        $allowed_origins = array( 1150 
 1151 
                // ANY 1152 
                $_SERVER['HTTP_ORIGIN'] 1153 
 1154 
                // SPECIFIC 1155 
                 "https://192.168.4.2", 1156 
                 "https://apache1.ext-nccoe.org", 1157 
                 "https://tls.nccoe.org", 1158 
                 "https://apache2.ext-nccoe.org", 1159 
                 "https://192.168.4.3", 1160 
                 "https://iis1.ext-nccoe.org", 1161 
                 "https://192.168.4.4" 1162 
        ); 1163 
        if (in_array($origin, $allowed_origins, true) === true) { 1164 
                header('Access-Control-Allow-Origin: ' . $origin); 1165 
                header('Access-Control-Allow-Credentials: true'); 1166 
                header('Access-Control-Allow-Methods: POST'); 1167 
                header('Access-Control-Allow-Headers: Content-Type'); 1168 
        } 1169 
        if ($_SERVER["REQUEST_METHOD"] === "OPTIONS") { 1170 
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                exit; // OPTIONS request wants only the policy, we can stop 1171 
here 1172 
        } 1173 
} 1174 
 1175 
$timetime = exec('date'); 1176 
 1177 
echo "WEB SERVICES SERVER2's TIME AN DATE IS: ". $timetime; 1178 
 1179 
?> 1180 

3. Remember to save the file in the document root directory under the same name used in the 1181 
previous section with the .php extension. 1182 

4. Ensure the Apache service is running:  service httpd restart  1183 

Web Services Testing Process 1184 

1. Navigate to the public IP of the Drupal web servers (should be the F5 virtual ip or if behind a 1185 
firewall, the IP address of the firewall used to NAT to the web server cluster behind the F5). 1186 

2. There should be at least three Basic Pages listed on the main site landing page. These should be 1187 
the pages created in this section to point to the web services server. 1188 

3. Choose one by clicking on its title or Read more link beside the title.  1189 
4. The time should be automatically updating each second to indicate the web server is using its 1190 

designated web services server to check time via TLS connection (indicated by the https). 1191 
5. If the time updates are not being seen, there could be an issue with the browser application 1192 

accepting the valid certificate. If self-signed untrusted certificates instead of a trusted certificate 1193 
are being used on the DMZ web servers, then the web client used (Chrome, Internet Explorer, or 1194 
Edge) may not trust the individual server being accessed. To discover the issue, press the F12 1195 
key on the keyboard, then select the Console tab. If there is an error stating  1196 
Net::ERR_CERT_AUTHORITY_INVALID or any other certificate validation error with an associated 1197 
IP address, open a new tab and navigate directly to the IP address listed by using 192.168.3.85. 1198 
If there is the standard certificate error for an untrusted site, then accept the risk if this is a 1199 
laboratory environment. The time should pop up afterward, and the other tabs with the Drupal 1200 
time connection will also work now. If this is production system, then a valid certificate will need 1201 
to be placed on the machine with the IP listed. The client that browses that machine should 1202 
trust the certificate.  1203 

1.5.5.5 Mail Services 1204 

The TLS lab utilizes a Simple Mail Transfer Protocol (SMTP) service to accept alerts from all the 1205 
configured components on the network. The SMTP service was created on a Linux server running 1206 
Fedora. The mail system was composed of a Dovecot Mail Transfer Agent (MTA) and a Postfix Mail User 1207 
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Agent (MUA). The following section provides guidance on download, installation, and configuration of 1208 
each service. 1209 

1.5.5.5.1 Mail Services Prerequisites 1210 
Before installing Dovecot and Postfix, set up the mail1.int-nccoe.org server by using the guidance in 1211 
Section 1.5.2.2.2. 1212 

1.5.5.5.2 Installation and Configuration of Mail Services Postfix Mail Transfer Agent  1213 
Postfix is a free and open-source mail transfer agent that routes and delivers electronic mail. To 1214 
download and install the Postfix MTA, follow the instructions in the following link: 1215 

 https://docs.fedoraproject.org/en-US/Fedora/12/html/Deployment_Guide/s3-email-mta-1216 
postfix-conf.html 1217 

Note: The actual main.cf file used in the TLS lab build is in Appendix F. 1218 

1.5.5.5.3 Installation and Configuration of Mail Services Dovecot Mail Transfer Agent  1219 
Dovecot is an open-source Internet Message Access Protocol (IMAP) and Post Office Protocol 3 Mail 1220 
User Agent server for Linux systems. It allows TLS administrators to manage and view email received by 1221 
the Postfix server. To download and install the Dovecot MUA, please refer to the instructions in the 1222 
following link: 1223 

 https://wiki.dovecot.org/BasicConfiguration 1224 

Note: The actual dovecot.conf file used in the TLS lab build is in Appendix F. 1225 

1.5.5.6 Log Aggregation and Correlation Services 1226 

“ELK” stands for three open-source projects:  1227 

 Elasticsearch–a search and analytics engine 1228 

 Logstash–a server‑side data processing pipeline that ingests data from multiple sources 1229 
simultaneously, transforms it, and then sends it to a “stash” like Elasticsearch 1230 

 Kibana–lets users visualize data with charts and graphs in Elasticsearch  1231 

The TLS lab utilized the ELK stack log aggregation and correlation services to manage and visualize the 1232 
remote logging services for all capable supplemental and collaborator products.   1233 

The following diagram depicts a view of the TLS lab logging infrastructure. 1234 

https://docs.fedoraproject.org/en-US/Fedora/12/html/Deployment_Guide/s3-email-mta-postfix-conf.html
https://docs.fedoraproject.org/en-US/Fedora/12/html/Deployment_Guide/s3-email-mta-postfix-conf.html
https://wiki.dovecot.org/BasicConfiguration
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Figure 1-3 TLS Lab Logging Infrastructure 1235 

 1236 

1.5.5.6.1 Prerequisites for Log Aggregation and Correlation Services  1237 
In accordance with the logging architecture above, the TLS lab utilized the hosts below. Both hosts must 1238 
be configured with Fedora, based on the OS configuration guidance in Section 1.5.2.2.2. Configure both 1239 
servers with rsyslog. 1240 

 syslog1.int-nccoe.org 1241 

 syslog2.int-nccoe.org 1242 

 Logstash requires Java 8 or Java 11. 1243 

1.5.5.6.2 Remote System Logging Services 1244 
Rsyslog is an open-source software utility used on UNIX and UNIX-like computer systems for forwarding 1245 
log messages in an IP network. 1246 

 To install rsyslog use the command dnf install rsyslog  1247 

For more information on configuring rsyslog, refer to the following link: 1248 

 https://docs.fedoraproject.org/en-US/fedora/rawhide/system-administrators-1249 
guide/monitoring-and-automation/Viewing_and_Managing_Log_Files/# 1250 

https://docs.fedoraproject.org/en-US/fedora/rawhide/system-administrators-guide/monitoring-and-automation/Viewing_and_Managing_Log_Files/
https://docs.fedoraproject.org/en-US/fedora/rawhide/system-administrators-guide/monitoring-and-automation/Viewing_and_Managing_Log_Files/
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1.5.5.6.3 Elasticsearch Installation and Configuration 1251 
Elasticsearch is a search engine based on the Lucene library. It provides a distributed, multitenant-1252 
capable full-text search engine with an http web interface and schema-free JavaScript Object Notation 1253 
documents. Elasticsearch is developed in Java. 1254 

To install and configure Elasticsearch, please refer to the following link: 1255 

 https://www.elastic.co/guide/en/elasticsearch/reference/current/rpm.html 1256 

1.5.5.6.4 Kibana Installation and Configuration 1257 
Kibana is an open-source data visualization plug-in for Elasticsearch and provides visualization 1258 
capabilities on top of the content indexed on an Elasticsearch cluster. Users can create bar, line, and 1259 
scatter plots (or pie charts) and maps on top of large volumes of data. 1260 

To install and configure Kibana, please refer to the following link: 1261 

 https://www.elastic.co/guide/en/kibana/current/rpm.html 1262 

1.5.5.6.5 Logstash Installation and Configuration 1263 
Logstash is an open-source, server-side data processing pipeline that ingests data from a multitude of 1264 
sources simultaneously, transforms it, and then sends it to the user’s favorite stash. 1265 

To install and configure Logstash, please refer to the following link: 1266 

 https://www.elastic.co/guide/en/logstash/current/installing-logstash.html#package-1267 
repositories 1268 

1.5.6 DevOps Services 1269 

To show the automated management of TLS server certificates in a container-based environment, we 1270 
used Kubernetes with Docker, NGINX, and Jetstack Cert-Manager. 1271 

1.5.6.1.1 Kubernetes Installation and Configuration 1272 
Instructions for installing Kubernetes are available at the following link: 1273 

 https://kubernetes.io/docs/setup/ 1274 

We installed Kubernetes on three CentOS Linux systems (cluster1, cluster2, cluster3.int-nccoe.org). 1275 

1.5.6.1.2 Weave 1276 
We used Weave as the virtual network to facilitate communications between the Kubernetes master 1277 
and nodes. Instructions for installing Weave can be found at the following link: 1278 

 https://www.weave.works/docs/net/latest/install/ 1279 

https://www.elastic.co/guide/en/elasticsearch/reference/current/rpm.html
https://www.elastic.co/guide/en/kibana/current/rpm.html
https://www.elastic.co/guide/en/logstash/current/installing-logstash.html#package-repositories
https://www.elastic.co/guide/en/logstash/current/installing-logstash.html#package-repositories
https://kubernetes.io/docs/setup/
https://www.weave.works/docs/net/latest/install/
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1.5.6.1.3 Docker Installation and Configuration 1280 
We used the community edition of Docker with Kubernetes. Instructions for installing Docker on CentOS 1281 
are found at the following link: 1282 

 https://docs.docker.com/install/linux/docker-ce/centos/ 1283 

1.5.6.1.4 Jetstack Cert-Manager Installation and Configuration  1284 
We installed Jetstack Cert-Manager on Kubernetes with the necessary components to request 1285 
certificates from Venafi TPP by using the following command: 1286 

kubectl apply -f https://raw.githubusercontent.com/jetstack \ 1287 
/cert-manager/venafi/contrib/manifests/cert-manager/with-rbac.yaml 1288 

This automatically created a namespace named “cert-manager,” which we used for the rest of our 1289 
configuration. 1290 

1.5.6.1.5 NGINX Installation and Configuration 1291 
NGINX was used as the web server and ingress on Kubernetes. Certificates were associated with the 1292 
NGINX ingress. Instructions for installing and configuring NGINX on Kubernetes are found at the 1293 
following link: 1294 

 https://www.nginx.com/ 1295 

In our implementation, we installed NGINX on Kubernetes with the following command into the cert-1296 
manager namespace. 1297 

kubectl create deployment nginx –image=nginx -n cert-manager 1298 
 

We then created a service for NGINX by using the following command: 1299 

kubectl create service nodeport nginx –tcp=80:80 -n cert-manager 1300 

2 Product Installation and Configuration Guides 1301 

This section of the practice guide contains detailed instructions for installing and configuring all of the 1302 
TLS collaborator products used to build an instance of the example solution. Each major subsection (2.1, 1303 
2.2, 2.x) is dedicated to a collaborator’s product capability. Within each product capability section, 1304 
descriptions of each product capability align with a Day 0, Day 1, and Day N concept. It is important to 1305 
note that each day builds on the previous day(s) for prerequisites, and each collaborator capability does 1306 
the same. So, if the implementer’s intent is to fully replicate the TLS lab environment, then following the 1307 
order of days and component installations will help make that endeavor more successful.  1308 

 Day 0 provides how-to guidance from a first-day installation perspective. It is assumed the 1309 
implementer is getting acclimated with the collaborator product. The implementer should 1310 
complete all prerequisites, which include complete installations of other collaborator products 1311 
in some instances or the Supporting Architecture described in Section 1.3. The expectation is for 1312 

https://docs.docker.com/install/linux/docker-ce/centos/
https://www.nginx.com/
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only basic crucial configuration functions to get the system up and running. Otherwise, other 1313 
configurations should be executed on Day 1, or there may be issues with prerequisites that have 1314 
not been executed.  1315 

 Day 1 assumes all Day 0 activities have been completed, including all prerequisites. Expected 1316 
activities include how-to guidance on more advanced security configuration of functioning in the 1317 
TLS environment. Day 1 also assists the implementer with configuration guidance for integration 1318 
with any other collaborator product capabilities.  1319 

 Day N assists the implementer with all necessary configurations and integrations of systems that 1320 
help facilitate ongoing security management and maintenance. In most cases, the minimum Day 1321 
N configuration and integration include security event audit and event logging for TLS systems. 1322 
In all cases, there are variations of services and offerings, which each collaborator describes in 1323 
their respective sections.  1324 

2.1 Product Installation Sequence (Example Build) 1325 

Figure 2-1 shows the dependencies among components deployed for the example build. A solid line with 1326 
a single arrow signifies hard dependencies. The component from which the arrow points should be 1327 
installed before the component to which the arrow points. This facilitates phased and secure 1328 
deployment. A dashed line with a double arrow indicates that integration between the components is 1329 
not dependent on the installation sequence (i.e., either component can be installed first). 1330 

Figure 2-1 Overview of Dependencies Among Components Deployed for the Example Build 1331 

 1332 
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2.2 SafeNet AT Luna SA 1700 Hardware Security Module 1333 

HSMs are specialized hardware devices dedicated to maintaining the security of sensitive data 1334 
throughout its life cycle. HSMs provide tamper-evident and intrusion-resistant protection of critical keys 1335 
and other secrets, and off-loading of processing-intensive cryptographic operations. By performing 1336 
cryptographic operations within the HSM, sensitive data never leaves the secure confines of the 1337 
hardened device. 1338 

The SafeNet AT Luna SA for Government is a network-attached HSM with multiple partitions to 1339 
effectively provide a many-in-one solution to multiple tenants—each with its own security officer 1340 
management credentials. Depending on security needs, the Luna SA can be used with or without a 1341 
secure personal identification number entry device (PED) for controlling management access to the HSM 1342 
partitions. Utilizing the PED takes the HSM from a Federal Information Processing Standards (FIPS) 140-2 1343 
Level 2 certified device to Level 3. The Luna SA also comes in two performance models: the lower 1344 
performance 1700, and the high-performance 7000 for transaction-intensive use cases. 1345 

2.2.1 Day 0: Product Installation and Standard Configuration 1346 

2.2.1.1 Prerequisites 1347 

2.2.1.1.1 Rack Space 1348 
Installation of the HSM requires rack space with the following characteristics: 1349 

 standard 1u 1 gin rack mount chassis 1350 

 dimensions: 19" x 21" x 1.725" (482.6 millimeters [mm] x 533.4 mm x 43.815 mm) 1351 

 weight capacity: 28 pounds (lb) (12.7 kilograms [kg]) 1352 

 input voltage: 100-240 V.50-60 hertz 1353 

 power consumption: 180 watts (W) maximum, 155 W typical 1354 

 temperature: operating 0 degrees Celsius (C)–35 degrees C, storage 20 degrees C–60 degrees C 1355 

 relative humidity: 5% to 95% (38 degrees C) noncondensing 1356 

2.2.1.1.2 Networking 1357 
One of two approaches to networking may be used. The steps for the commands in this document 1358 
assume the NCCoE’s laboratory networking environment will be replicated. An organization may also 1359 
opt to use its own network settings. In either case, the following Luna SA HSM appliance parameters 1360 
information will be needed:  1361 

 IP address that will be assigned to this device (Static IP is recommended) 1362 

 Host name for the HSM appliance (registered with network DNS) 1363 
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 a domain name where the device will reside 1364 

 default gateway IP address  1365 

 DNS Name Server IP address(es) 1366 

 Search Domain name(s) 1367 

 device subnet mask 1368 

 Ethernet device (use eth0, which is the uppermost network jack on the HSM appliance back 1369 

panel, closest to the power supply, and labeled 1 ) 1370 

The network must be configured for optimal use of Luna appliances. The following bandwidth and 1371 
latency recommendations are optimal for performance settings: 1372 

 bandwidth 1373 

• minimum supported: 10 megabit (Mb) half-duplex 1374 

• recommended: at least 100 Mb full duplex—full gigabit Ethernet is supported 1375 

Note: Ensure the network switch is set to AUTO negotiation, as the Luna appliance 1376 
negotiates at AUTO. If the network switch is set to use other than automatic 1377 
negotiation, there is a risk that the switch and the Luna appliance will settle on a much 1378 
slower speed than is actually possible in the organization’s network conditions.  1379 

 network latency 1380 

• maximum supported: 500 milliseconds (ms) 1381 

• recommended: 0.5 ms 1382 

2.2.1.1.3 Unpacking the Appliance 1383 
Follow this checklist to verify that all of items required for the installation are in hand. 1384 

Qty Item 

 1  

 
Luna SA HSM appliance 
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Qty Item 

2 

 
power supply cord (one for each power supply; style to suit country for which was 

ordered) 

1 

 
null modem serial cable 

1 

 
Universal Serial Bus 2.0 to RS232 serial adapter 
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Qty Item 

1 

 
Set of:  
- 2 front mounting brackets with screws  
- 2 side bracket guides  
- 2 sliding rear brackets (Fit into the guides for rear support adjustable positioning.) 

1 

 
client/software development kit (SDK) software 

2.2.1.2 Rack-Mount the Appliance 1385 

1. Install and adjust rails and brackets to suit the equipment rack. 1386 

 1387 

2. Mount the appliance in the equipment rack. Alternatively, ignore the rails and mounting tabs, and 1388 
rest the Luna SA appliance on a mounting tray or shelf suitable for the organization’s specific style 1389 
and brand of equipment rack. 1390 

CAUTION: Support the weight of the appliance until all four brackets are secured.   1391 
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 1392 

 1393 
3. Insert the power (a) and network (b) cables at the rear panel. For proper redundancy and best 1394 

reliability, the power cables should connect to two completely independent power sources. 1395 

 1396 
4. Press and release the Start/Stop switch, on the rear panel. 1397 

 

 1398 

2.2.1.3 Initial Appliance Configuration 1399 

This section describes the process to prepare the new HSM Server and one client system for operation 1400 
with the application. It includes the following steps: 1401 

 process for first-time login and changing passwords  1402 
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 verify and set the date and time 1403 

 configure HSM appliance’s IP and network parameters (using static or Dynamic Host 1404 
Configuration Protocol [DHCP]. In general, we strongly recommend against using DHCP for HSM 1405 
appliances.) 1406 

 make network connections (To make a network connection, refer to Section 1.1.1.3.)  1407 

 HSM initialization process  1408 

 restart services so configuration changes can take effect 1409 

2.2.1.3.1 Process for First-Time Login and Changing Passwords  1410 
1. To perform initial login to the HSM appliance, connect a serial cable to serial port on the front of 1411 

the appliance. 1412 

 1413 
2. On the management laptop, open the PuTTY application and select a Connection type of Serial 1414 

with a Speed of 115200. 1415 
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 1416 
 

3. Navigate to the Serial Category on the bottom left side of the window. 1417 
4. Configure the serial connection to support the SSL Visibility Appliance’s console speeds by 1418 

selecting the following options: 1419 

 Speed (baud): 115200 1420 

 Data bits: 8 1421 

 Stop bits: 1 1422 

 Parity: None 1423 

 Flow control: None 1424 
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 1425 
5. Log in to the appliance by using the default credentials of: 1426 

 username: bootstrap 1427 

 password: bootstrap 1428 

6. For security purposes, the user is immediately prompted to change the factory-default password 1429 
for the admin account. 1430 

[localhost] ttyS0 login: admin  1431 
Password:  1432 
You are required to change your password immediately (root enforced)  1433 
Changing password for admin  1434 
(current) UNIX password: 1435 

A valid password should be a mix of upper and lower case letters, digits, and 1436 
other characters. You can use an 8 character long  1437 
password with characters from at least 3 of these 4 classes.  1438 
An upper case letter that begins the password and a digit that  1439 
ends it do not count towards the number of character classes used.   1440 
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Enter new password:   1441 
Re-type new password: 1442 

Luna SA 5.4.0-14 Command Line Shell - Copyright (c) 2001-2013 SafeNet, Inc. All 1443 
rights reserved. 1444 

Command Result: 0 (Success)  1445 
lunash:> 1446 

The above represents a local serial connection; text will differ slightly for a Secure Shell (SSH) 1447 
connection. 1448 

              Note: The username and passwords are case-sensitive. 1449 

Note: To protect the HSM appliance and its HSM from vulnerabilities due to weak 1450 
passwords, new passwords must be at least eight characters in length and must include 1451 
characters from at least three of the following four groups:  1452 

– lowercase alphabetic (abcd...xyz) 1453 

– uppercase alphabetic (ABCD...XYZ) 1454 

– numeric (0123456789) 1455 

– special (nonalphanumeric, #*@#$%&...) 1456 

Note: Login must occur within two minutes of opening an administration session, or the 1457 
connection will time out. 1458 

2.2.1.3.2 Date and Time 1459 
To configure the HSM’s date and time, perform the following steps: 1460 

1. Verify the current date and time on the HSM Server. 1461 

2. At the lunash prompt, type the command: 1462 
lunash:> status date 1463 

3. If the date, time, or time zone is incorrect for the location, change them by using the lunash 1464 
sysconf command. For example:  lunash:> sysconf timezone set Canada/Eastern 1465 
Timezone set to Canada/Eastern 1466 

4. Use sysconf time to set the system time and date <HH:MM YYYYMMDD> in the format shown. 1467 
Note that the time is set on a 24-hour clock (00:00 to 23:59).  1468 
lunash:> sysconf time 12:55 20190410 Sun April 10 12:55:00 EDT 2019  1469 

5. Optionally to configure Network Time Protocol (NTP), use the following command: 1470 
lunash:> sysconf ntp addserver 192.168.1.12  1471 

6. Activate the NTP service with the following command: 1472 
sysconf ntp enable 1473 
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2.2.1.3.3 Network Configuration 1474 
1. Use the network show command to display the current settings and to see how they need to be 1475 

modified for the network.  1476 
lunash:>net show  1477 
    Hostname:         HSM  1478 
    Domain:           int-nccoe.org  1479 
    IP Address (eth0): 192.168.1.13 1480 
    HW Address (eth0): 00:15:B2:AB:D6:D6  1481 
    Mask (eth0): 255.255.255.0 1482 
    Gateway (eth0):   192.168.1.1  1483 
 1484 

Name Servers: 192.168.1.6 1485 
    Search Domain(s): <not set>  1486 

Kernel IP routing table  1487 
Destination Gateway Genmask Flags Metric Ref Use Iface  1488 
Link status  1489 
  eth0: Configured  1490 
        Link detected: yes  1491 
  eth1: Configured 1492 
        Link detected: no  1493 
 1494 
Command Result : 0 (Success)  1495 
lunash:> 1496 

2. Use network hostname to set the host name of the HSM appliance (use lowercase characters).  1497 
lunash:> network hostname HSM 1498 

3. Use network domain to set the name of the network domain in which the HSM Server (appliance) is 1499 
to operate.  1500 
lunash:> net domain int-nccoe.org  1501 

4. Use network dns add nameserver to set the Nameserver IP Address (address for the local name 1502 
server).  1503 
lunash:> net dns add nameserver 192.168.1.6 1504 

5. Use net dns add searchdomain to set the DNS Search Domain (the search list to be used for host 1505 
name lookups).  1506 
lunash:> net dns add searchdomain int-nccoe.org 1507 

6. Use network interface to change network configuration settings.  1508 
 1509 
All of the network interface parameters are required for the IP setup of the Ethernet device and 1510 
must be set at the same time for the HSM appliance to connect with the network.  1511 
[HSM] lunash:>net interface -device eth0 -ip 192.168.1.13 -netmask 255.255.255.0 -1512 
gateway 192.168.1.1  1513 

7. View the new network settings with network show. 1514 
 lunash:> network show 1515 
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2.2.1.3.4 Generate a New HSM Server Certificate 1516 
Although the HSM appliance came with a server certificate, good security practice dictates that a new 1517 
one be generated. 1518 

1. Use sysconf regenCert to generate a new server certificate:  1519 
 1520 
lunash:> sysconf regenCert 192.168.1.13 1521 
WARNING !! This command will overwrite the current server certificate and private 1522 
key.  1523 
All clients will have to add this server again with this new certificate.  1524 
If you are sure that you wish to proceed, then type 'proceed', otherwise type 1525 
'quit'  1526 
> proceed  1527 
Proceeding...  1528 
'sysconf regenCert' successful. NTLS must be (re)started before clients can 1529 
connect.  1530 
Please use the 'ntls show' command to ensure that NTLS is bound to an appropriate 1531 
network device or IP address/hostname for the network device(s) NTLS should be 1532 
active on. Use 'ntls bind' to change this binding if necessary. 1533 
 1534 
Command Result: 0 (Success) 1535 
lunash:> 1536 

2.2.1.3.5 Bind the Network Trust Link Service 1537 
From the factory, the network trust link service (NTLS) is bound to the loop-back device by default. To 1538 
use the appliance on the network, bind the NTLS to one of the two Ethernet ports— ETH0 or ETH1—or 1539 
to a host name or IP address. Use the ntls show command to see current status.  1540 

1. Use ntls bind to bind the service: 1541 
lunash:>ntls bind eth0 -bind 192.168.1.13 1542 
Success: NTLS binding hostname or IP Address 192.168.1.13 set. 1543 
NOTICE: The NTLS service must be restarted for new settings to take effect. 1544 
If you are sure that you wish to restart NTLS, then type 'proceed', otherwise 1545 
type 'quit' 1546 
> proceed 1547 
Proceeding... 1548 
Restarting NTLS service... 1549 
Stopping ntls:                                             [   OK  ] 1550 
Starting ntls:                                             [   OK  ] 1551 
Command Result : 0 (Success) 1552 
[myluna] lunash:>ntls show 1553 
NTLS bound to network device: eth0  IP Address: "192.168.1.13" (eth0) 1554 
Command Result : 0 (Success) 1555 

  

NOTE: The “Stopping ntls” operation might fail in the above example, because NTLS is not 1556 
yet running on a new HSM appliance—ignore this message. The service restarts regardless 1557 
if the stop was needed. 1558 
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2.2.1.3.6 Enabling Federal Information Processing Standards 140-2 Mode 1559 

In many areas of the information security industry, validations against independent or government 1560 
standards are considered a desirable or essential attribute of a product. NIST’s FIPS 140 is the pre-1561 
eminent standard in the field of cryptography. Enabling FIPS 140-2 ensures the HSM uses strong 1562 
cryptographic modules in its operations. 1563 

1. Log in to the APPLIANCE management console (LunaSH) as admin.  1564 
a. SSH into the APPLIANCE  1565 
b. Use these credentials: Username: admin Password: ****YOUR admin PASSWORD****  1566 

2. Check if FIPS 140 mode is enabled.  1567 
a. Command: hsm show  1568 
b. In the results, look for “The HSM is in FIPS 140-2 approved operation mode.” If this is seen, 1569 
then stop: FIPS 140-2 mode is already enabled on the HSM. Otherwise, continue.  1570 

3. Log in to the admin role.  1571 
a. Command: hsm login  1572 
b. Password: ****YOUR admin PASSWORD****  1573 

4. View HSM Capabilities and Policies.  1574 
a. Command: hsm showPolicies  1575 
b. In the results, look for “Allow non-FIPS algorithms” and record its value and code.  1576 

5. Edit HSM Capabilities and Policies.  1577 
a. Command: hsm changePolicy -policy <code>  -value <desired_value>  1578 

i. hsm changePolicy -policy 12 -value 1  1579 
ii. When prompted type: proceed  1580 

6. Confirm FIPS 140 mode is enabled.  1581 
a. Command: hsm show  1582 
b. In the results, look for “The HSM is in FIPS 140-2 approved operation mode.” If this is seen, 1583 
then stop: FIPS 140-2 mode is already enabled on the HSM. Otherwise, further investigation is 1584 
required. 1585 

2.2.1.4 HSM Initialization 1586 

In this section, initialize the HSM portion of the Luna appliance and set any required policies. In normal 1587 
operations, these actions are performed when first commissioning the Luna appliance.  1588 

2.2.1.4.1 Initialize a Password-Authenticated HSM 1589 
1. To initialize the HSM, type the following command: 1590 

hsm -init -label HSM 1591 

 [HSM] lunash:> hsm -init -label HSM 1592 
> Please enter a password for the security officer 1593 
> ******** 1594 
Please re-enter password to confirm: 1595 
> ******** 1596 
Please enter the cloning domain to use for initializing this 1597 
HSM (press <enter> to use the default domain): 1598 
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> ******** 1599 
Please re-enter domain to confirm: 1600 
> ******** 1601 
CAUTION:  Are you sure you wish to re-initialize this HSM? 1602 
All partitions and data will be erased. 1603 
Type 'proceed' to initialize the HSM, or 'quit' 1604 
to quit now. 1605 
>proceed 1606 
‘hsm - init’ successful. 1607 

2. When activity is complete, lunash displays a “success” message. 1608 

2.2.2 Day 1: Product Integration Configuration 1609 

2.2.2.1 Prerequisites 1610 

 NTL–This step will need to be completed for each system; refer to Section 2.2.2.2. 1611 

 ADCS–Windows server needs to be running; refer to guide. 1612 

 IIS–Windows server needs to be running; refer to guide. 1613 

 Venafi–must be installed and configured; refer to Section 2.2.2.2. 1614 

2.2.2.2 Network Trust Link 1615 

This section provides directions to configure a Luna Client to communicate with the network-attached 1616 
Luna SA HSM. A client may have multiple Luna SA HSMs connected—using a slot designation when 1617 
referencing an assigned Luna SA. The client also assumes the Luna SA is installed and operational but 1618 
without a partition created for the new client. 1619 

The Luna Client is available in Windows and Linux. For Linux systems, refer to SafeNet AT’s Configuring a 1620 
Network Trust Link documentation. In this document, the necessary commands and screenshots are 1621 
listed for Windows-based systems. 1622 

2.2.2.2.1 Install the Luna Client Software 1623 
To install the Luna Client software, perform the following steps: 1624 

1. Log in to Windows as Administrator or as a user with administrator privileges. 1625 
2. Insert the Luna Client Software DVD into the optical drive. 1626 
3. Open a file explorer and navigate to D:\windows\64\. 1627 
4. Double-click Luna Client.msi. 1628 
5. Click Next at the welcome screen.  1629 
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 1630 

6. Accept the software license agreement by clicking “I accept the terms in the license 1631 
agreement” and clicking Next. 1632 

 1633 
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7. In the Choose Destination Location dialogue, accept the default offered and click Next. 1634 

 1635 

8. Ensure the following options are selected and click Next: 1636 
● Luna CSP (CAPI)/Luna KSP (CNG) 1637 
● Luna SDK              1638 

 1639 

9. On the Ready to Install page, click Install. 1640 
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10. If Windows presents a security notice asking if the user wishes to install the device driver from 1641 
SafeNet AT, click Install to accept. 1642 

 1643 

11. When the installation completes, click Finish. 1644 

2.2.2.2.2 Configure the Luna Client 1645 
To establish the NTL, first create a client certificate, and then the client and server certificates are 1646 
exchanged. The Luna SA appliance is then added as a trusted server in the client. 1647 

2.2.2.2.3 Create the Client Certificate 1648 
First, create the client certificate by using the SafeNet AT VTL command line. This results in a .pem 1649 
certificate file being created in a \cert\client subfolder.  1650 

1. On the client system, from the Windows command environment, run as administrator and 1651 
navigate to the folder C:\Program Files\Safenet\LunaClient. 1652 
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 1653 

2. Enter the following command: 1654 

vtl createcert –n <client IP address> 1655 

 1656 



NIST SP 1800-16D: Securing Web Transactions: TLS Server Certificate Management 59 

2.2.2.2.4 Transfer the Client Certificate to the Luna SA 1657 
Now, transfer the newly created client certificate to the Luna SA by using the PuTTY Secure Copy 1658 
Protocol (PSCP) or Secure Copy Protocol (SCP) tool. 1659 

1. On the client system using Windows, enter the following command: 1660 

pscp “C:\Program Files\SafeNet\LunaClient\cert\client\192.168.1.16.pem” 1661 
admin@192.168.1.13: 1662 

 1663 

2. When prompted, enter the appliance administrative password for the Luna SA. The transfer 1664 
automatically takes place. 1665 

2.2.2.2.5 Transfer the Server Certificate from the Luna SA 1666 
Using PSCP or SCP, transfer the Luna SA’s server certificate to the client. 1667 

1. On a client system using Windows, enter the following command: 1668 
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pscp admin@192.168.1.13:server.pem  1669 

 1670 

2. When prompted, enter the administrative password for the Luna SA. The transfer will 1671 
automatically take place. 1672 

2.2.2.2.6 Register the HSM on the Client 1673 
The final step in configuring the client is to register the Luna SA’s certificate with the client. 1674 

1. On a client system, enter the following command: 1675 
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vtl addServer -n <HSM IP Address> -c server.pem 1676 

 1677 

At this point, the client is fully configured and ready to establish a secure link with the HSM. 1678 

2.2.2.2.7 Create a Partition (Password Authentication) 1679 
1. Connect into the HSM via SSH or Serial. 1680 

2. At the lunash:> prompt on the Luna SA, enter the following command:  1681 

partition create –partition <partition name> -domain <domain name> 1682 
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 1683 

3. When prompted, enter and re-enter to confirm the partition password. 1684 

4. Enter proceed when prompted. 1685 

2.2.2.2.8 Register the Client on the HSM and Assign It to a Partition 1686 
Register the client on the HSM and assign it to a partition. Because the HSM was previously created and 1687 
the client certificate was transferred to it, the HSM can find the certificate file based on the IP address. 1688 
Assign a name for the client for easy recognition.   1689 

1. On the Luna SA, enter the following command to register the client: 1690 

client register –client HRhmsiis -ip 192.168.1.16 1691 

 1692 

2. On the Luna SA, enter the following command to assign the client to the previously created 1693 
partition. 1694 

client assignPartition -client <client name> -partition <partition name> 1695 

 1696 

3. On the Luna SA, enter the following command to verify the client is assigned to the proper 1697 
partition. 1698 

client show -client <client name> 1699 
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 1700 

At this point, the HSM is configured, and in the next section, the user will return to the client to verify 1701 
connectivity and the ability to request cryptographic operations from the client. 1702 

2.2.2.2.9 Verify the Network Trust Link 1703 
Return to the client and verify it can view the Luna SA and its associated slot and partition. Run the 1704 
Multitoken2 utility to verify the client can request cryptographic operations from the HSM. 1705 

2.2.2.2.10 Verify the Luna SA in Client Server Lists 1706 
Verify the Luna SA is in the client’s server lists. 1707 

1. On the client system, from the Windows command environment run as administrator, 1708 
navigate to the folder C:\Program Files\Safenet\LunaClient. 1709 

2. On the client system, enter the following command and verify the Luna SA is in the list of 1710 
servers: 1711 

           vtl listservers 1712 

   1713 

2.2.2.2.11 Verify the Slot and Partition 1714 
Verify the slot and the assigned HSM partition can be seen. 1715 

1. On the client system using either Windows and Linux, enter the following command to verify 1716 
the Luna SA slot and partition are known to the client: 1717 

vtl verify 1718 
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 1719 

Should this verification fail, check the times on the client and HSM to ensure they are set properly.   1720 

2.2.2.2.12 Request Cryptographic Operations on the HSM 1721 
Request an actual crypto operation on the HSM to verify full functionality. The Multitoken utility to use 1722 
is described in the Luna SA product documentation. 1723 

1. On the client system, enter the following command: 1724 

multitoken2 –mode rsasigver –key 1024 –slots 1,1,1,1,1 1725 

2. When prompted, if continuing, enter y. 1726 

3. Enter the partition password when prompted. The test will begin. 1727 

4. Press the Enter key to terminate the test after verifying that RSA signatures were successfully 1728 
performed in the statistics table.   1729 
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 1730 

2.2.2.3 ADCS Integration Configuration 1731 

This section provides the necessary steps for configuring an ADCS CA to use the SafeNet AT Luna SA 1732 
1700 HSM for Government, to secure the CA’s private key. This section assumes the Luna HSM client has 1733 
been installed and configured, as detailed in Section 2.2.1. 1734 

Perform the following steps: 1735 

 Verify the Network Trust Link (NTL) between the Windows Server and the HSM. 1736 

 Register the Key Storage Provider (KSP) on the Windows Server. 1737 

 Add the CA role. 1738 

 Verify the private key for the CA was created on the HSM. 1739 

2.2.2.3.1 Prerequisites 1740 
To configure Microsoft CA to use the Luna HSM, the following prerequisites must be met: 1741 

 The SafeNet AT Luna HSM is installed and operational. 1742 

 The SafeNet AT Luna Client is installed on the Windows Server where the CA is being added. 1743 
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 The NTL is established between the Luna Client and the Luna HSM. If not, see Section 2.2.2.2. 1744 

2.2.2.3.2 Verify the HSM Configuration 1745 
Verify the HSM client configuration prior to proceeding by following the steps below: 1746 

1. Open a Command Prompt as Administrator, and change into the Luna Client directory, typically1747 
C:\Program Files\SafeNet\LunaClient\.1748 

2. Execute the command VTL.exe verify to check that the client is configured correctly and the1749 
partition is visible. Slot/Partition information should be displayed in response.1750 

1751 

3. Execute the command cmu list to see the list of current objects on the HSM, and enter the1752 
password when prompted. If nothing has been created on the partition, this list will be blank.1753 
Once the CA is configured, the keys created on the HSM are listed.1754 

1755 

2.2.2.3.3 Register the Key Storage Provider 1756 
Beginning with Windows Server 2008, the older CryptoAPI CSP has been superseded by the newer 1757 
CNGKSP. The Luna Client installation includes a utility to register the SafeNet AT HSM for Government as 1758 
a KSP for use in Windows applications. To register, follow these instructions: 1759 

1. Open Windows Explorer, browse to the KSP folder in the Luna Client installation folder, and1760 
double-click on the KSPConfig.exe utility.1761 
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             1762 

2. Double-click on Register Or View Security Library, then click Browse. 1763 

             1764 

3. Browse to the Luna Client folder, select cryptoki.dll, and click Open. 1765 
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             1766 

1767 
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4. Click on Register to complete the library registration. 1768 

              1769 

5. Double-click Register HSM Slots on the left to open the slot registration page. Select the 1770 
Administrator account and the Domain for the user that will be configuring the CA role. For a 1771 
server joined to a domain, this should be a Domain or Enterprise Admin account rather than the 1772 
local machine Administrator. Select the slot for the HSM, enter the Slot Password, and click 1773 
Register Slot. 1774 
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 1775 

6. Repeat the slot registration for the user SYSTEM with Domain NT AUTHORITY, and click 1776 
Register. This is the account used for the CA service—it must also have access to the HSM. 1777 
Verify the registration by selecting user and domain and clicking View Registered Slots. 1778 

2.2.2.3.4  Add CA Role 1779 
For instructions on CA installation and configuration, refer to Section 1.5.3.3.2 on root CAs. 1780 

2.2.2.3.5 Verify the Successful Integration on the HSM 1781 
As a final step, verify the private key and the public key are stored on the HSM. 1782 

1. Open a command prompt and change to the Luna Client directory, typically C:\Program 1783 
Files\SafeNet\LunaClient\.  1784 

2. Run cmu list to verify the private and public keys for the CA are present on the HSM. They are 1785 
represented by two “handles.”  1786 

The screenshot below shows running the cmu list command before configuring the CA and then after 1787 
the configuration has been completed. 1788 
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 1789 

This completes integration of the SafeNet AT Luna SA 1700 HSM for Government with Microsoft Active 1790 
Directory Certificate Services.  1791 

2.2.2.4 IIS Integration Configuration 1792 

This section provides the steps necessary to integrate the Microsoft IIS web server and the SafeNet AT 1793 
Luna SA 1700 HSM. The benefit of the integration is that the root private key for IIS is stored in a 1794 
hardened, FIPS 140-2-certified device.  1795 

The following steps explain how to register the SafeNet AT Luna SA 1700 HSM as a KSP to store the root 1796 
certificate’s private key in the HSM. 1797 

2.2.2.4.1 Prerequisites 1798 

 IIS is installed or ready to be installed. The firewall rules may need to be edited to allow https 1799 
access (typically port 443) and optionally block http (port 80). 1800 

 If mutual authentication is being performed, the trusted CA’s certificate has been installed. 1801 

2.2.2.4.2 Register the Luna KSP 1802 
For IIS integration, two accounts need access to the HSM. First, the DOMAIN\Administrator account is 1803 
used for setting up the server—creating the certificate request and installing the certificate. Second, the 1804 
NT Authority\System account is used by the server to start the IIS service. The KSPConfig utility is used 1805 
to register the HSM as a KSP for these accounts. 1806 

1. Navigate to the KSP directory under the Luna installation directory, which is typically 1807 
C:\ProgramFiles\SafeNet\LunaClient. 1808 

2. Run KspConfig.exe to launch the wizard. 1809 

3. When the wizard launches, double-click Register Or View Security Library on the left side of the 1810 
pane, and then click the Browse button on the right. 1811 
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 1812 

4. Browse to and select the cryptoki.dll library in the Luna Client directory. 1813 

 1814 

5. Having selected the dll, click the Register button. The message “Success registering the security 1815 
library!” displays. 1816 
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 1817 

6. Double-click Register HSM Slots on the left side of the pane. 1818 

7. Verify the correct User and Domain are selected (the Administrator account on the server) and 1819 
slot is selected (can be registered by slot label or slot number), and enter the Slot Password 1820 
(HSM partition password). 1821 

8. Click Register Slot to register the slot for that User/Domain. Upon successful registration, a 1822 
message “The slot was successfully and securely registered” displays.  1823 
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 1824 

9. Repeat the steps above to register the slot for the User SYSTEM and Domain NT AUTHORITY.  1825 

 1826 
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To verify the registered slot, select a User/Domain, and click the View Registered Slots button. 1827 

2.2.2.4.3 Setup Synopsis 1828 

 Verify the NTL between the server and the HSM. 1829 

 Register the HSM as a KSP. 1830 

 Install IIS and configure it to use an HSM. 1831 

 Create a certificate request for IIS, and get it signed. 1832 

 Install the signed certificate.  1833 

 Bind the certificate to the web server. 1834 

2.2.2.4.4 Install Microsoft IIS 1835 
The next step is to install the Web Server (IIS) role by using Server Manager. There are no special 1836 
considerations surrounding the IIS integration with an HSM. Please follow the installation and 1837 
configuration steps in Section 1.5.5.2. 1838 

 1839 

2.2.2.4.5 Create and Install a Certificate for IIS 1840 
IIS will need a certificate installed that has been signed by a trusted CA. This involves creating a 1841 
certification signing request (CSR), then the CA signs it and installs it back in the server. IIS Manager 1842 
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provides an easy way for creating a CSR, but it cannot be used when a key is generated on an external 1843 
HSM. Instead, use a Microsoft command line utility. 1844 

Clients attempting to securely connect to the web server will see an alert if the fully qualified domain 1845 
name (FQDN) in the Common Name (CN) field (or on more recent browsers, the FQDN in the Subject 1846 
Alternate Name field) does not match the uniform resource locator (URL) they are accessing. An alert 1847 
also occurs if the certificate was not issued by a trusted root CA. For this integration, use the FQDN in 1848 
the CN and Subject Alternative Name (SAN) fields. 1849 

2.2.2.4.6 Create a Certificate Signing Request and Private Key 1850 
Instructions follow for using the certreq.exe utility to create the CSR and private key in the HSM. 1851 

1. Create a file called request.inf that will contain the necessary information for the utility to create 1852 
the CSR. The contents of the file are as follows—only those items in blue italics will vary per the 1853 
organization’s environment and requirements. The CN in the subject and the dns name in the SAN 1854 
extension must match the full host name that clients enter as the URL in a web browser. 1855 

Copying and pasting the text may insert line breaks or change quotation marks to smart (curly) 1856 
quotation marks. Ensure that each entry is on a single line and that all quotation marks are standard, 1857 
straight, and double.  1858 

In this document, some entries may appear with line breaks such as the Subject=… and 1859 
%szOID_ENHANCED_KEY_USAGE… lines, but they must be on a single line. In addition, if using Notepad, 1860 
change the file type to “all files” so it does not create the file with an extension of .txt. The “hide 1861 
extensions for known file types” option may need to be disabled in Windows Explorer to verify the file is 1862 
an .inf file rather than a .txt file. The text of the .inf file follows, as well as an image of the how the file 1863 
should look. 1864 

 [Version] 1865 
Signature= "$Windows NT$" 1866 
 1867 
[NewRequest] 1868 
Subject = "C=US,CN=HRhsm.int-1869 
nccoe.org,O=SafeNetAT,OU=TLSLAB,L=Gaithersburg,S=Maryland" 1870 
HashAlgorithm = SHA256 1871 
KeyAlgorithm = RSA 1872 
KeyLength = 2048 1873 
ProviderName = "Safenet Key Storage Provider"  1874 
KeyUsage = 0xf0 1875 
MachineKeySet = True 1876 
[EnhancedKeyUsageExtension] 1877 
OID=1.3.6.1.5.5.7.3.1 1878 

[Strings]  1879 

szOID_SUBJECT_ALT_NAME2 = "2.5.29.17"  1880 
szOID_ENHANCED_KEY_USAGE = "2.5.29.37"  1881 
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szOID_PKIX_KP_SERVER_AUTH = "1.3.6.1.5.5.7.3.1" szOID_PKIX_KP_CLIENT_AUTH = 1882 
"1.3.6.1.5.5.7.3.2" 1883 

[Extensions]  1884 
%szOID_SUBJECT_ALT_NAME2% = "{text}dns=HRhsm.int-nccoe.org" 1885 
%szOID_ENHANCED_KEY_USAGE% = 1886 
"{text}%szOID_PKIX_KP_SERVER_AUTH%,%szOID_PKIX_KP_CLIENT_AUTH%" 1887 

Example image of file with correct line breaks: 1888 

 1889 

2. With the information file created, execute the certreq utility to generate a key on the HSM, and the 1890 
certificate request. The CSR will be output to the file name that the user provides. 1891 

certreq.exe –new request.inf <CSR_filename> 1892 
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 1893 

2.2.2.4.7 Get the CSR Signed by a Trusted CA 1894 
A trusted CA must sign the generated CSR (example below). The CA authenticates the request and 1895 
returns a signed certificate or a certificate chain. When the certificate file is received back, save it in the 1896 
current working directory.  1897 

 1898 
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The CSR was signed by using an Enterprise CA. Follow the steps below to create a new template and to 1899 
sign the certificate request: 1900 

1. Search for and run certsrv.msc, or from Server Manager select Tools > Certification Authority to 1901 
view the CA. Expand the CA > right-click Certificate Templates > select Manage. 1902 

2. In the Certificate Templates Console, scroll down to find the Web Server template and right-click > 1903 
select Duplicate Template.  1904 

 1905 
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3. Fill out the various sections of the properties with settings that adhere to the company’s security 1906 
policies. For this guide, the only thing altered is the Template name in the General tab. This will be 1907 
the name used when signing the request on the command line. 1908 

 1909 
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4. Select the Subject Name tab, and verify that Supply in the request is selected. The FQDN is specified 1910 
in both the CN and SAN fields in the request file created, and the certificate will use these values. 1911 

 1912 

5. Click OK to finish creating the new template. 1913 
6. Close the Certificate Templates Console > return to the Certificate Authority window.  1914 
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7. Click on Action > New > Certificate Template to Issue 1915 

 1916 

8. Select the certificate template created > click OK. 1917 



NIST SP 1800-16D: Securing Web Transactions: TLS Server Certificate Management 83 

 1918 

9. Generate a certificate from the certificate request: 1919 

certreq -attrib "CertificateTemplate:<TemplateName>" -submit <certificate 1920 
request filename> 1921 

 1922 
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The user will be prompted to select the CA to use for signing, and a location and file name to save the 1923 
signed certificate. Once the signed certificate file is created, it can be copied to the IIS server to continue 1924 
with the integration. 1925 

2.2.2.4.8 Install the Signed Certificate 1926 
Once the CSR is signed and the signed certificate file is received back, accept and install it by using the 1927 
certreq utility. 1928 

certreq.exe –accept <newcert.crt>  1929 

 1930 

If this step fails, the most common cause is that the issuing CA root certificate is not installed in the 1931 
server’s certificate store. Verify the issuing CA is trusted, or install the CA certificate into the Local 1932 
Machine—Trusted Root CA certificate store. 1933 

2.2.2.4.9 Bind the Certificate to the IIS Web Server 1934 
The final step is to bind the certificate to the IIS web server: 1935 

1. Open the IIS Manager from Start > Administrative Tools > Internet Information Services (IIS) 1936 
Manager. 1937 

2. Under Sites on the left side of the IIS Manager window, select the desired website. 1938 

3. On the right side of the IIS Manager, click Bindings. 1939 

4. In the Site Bindings window, click Add. 1940 
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 1941 

5. Select the protocol as https. 1942 

6.  Select the IP address of the machine running IIS from the IP Address drop-down list, or leave   1943 
blank to use all available network interfaces.  1944 

7.    Enter port 443. 1945 



NIST SP 1800-16D: Securing Web Transactions: TLS Server Certificate Management 86 

 1946 

8. In the SSL certificate: drop-down, select the certificate that was just installed. 1947 
9. Complete the certificate binding in support of SSL/TLS, then click OK. 1948 
10. Verify the connection is working, open a browser, and enter your URL (e.g., https://hrhsm.int-1949 

nccoe.org:443). There may be a prompt to accept the certificate for the site. The host name 1950 
must match the name used in the certificate request and must be registered with the DNS 1951 
server to resolve the host name to the IP address of the IIS server. 1952 
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 1953 

2.2.2.5 Venafi Integration Configuration 1954 

This section covers the necessary information to integrate Venafi with the SafeNet AT Luna SA 1700 for 1955 
Government HSM. When integrated with the Luna, Venafi can create and store the master encryption 1956 
key used to encrypt and decrypt the Venafi database. In this configuration, the Venafi TPP services will 1957 
not start unless the key stored in the HSM is accessible. This provides an additional hardened layer of 1958 
security to protect data in the database. 1959 

2.2.2.5.1 Prerequisites 1960 
To integrate Venafi with the Luna SA HSM, the following prerequisites must be met: 1961 

 The SafeNet AT Luna HSM is installed and operational. 1962 

 The SafeNet AT Luna Client is installed on the Venafi server. 1963 

 The NTL is established between the Luna Client and the Luna HSM as described in Section 1964 
2.2.2.2.9. 1965 

 The NTL between the Venafi server and the HSM has been verified. 1966 

 Venafi has been configured to use the Luna SA HSM. 1967 

 The master encryption key was created on the Luna SA HSM and has been verified. 1968 
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2.2.2.5.2 Verify the Network Trust Link Between Venafi and the HSM 1969 
The Luna Client installed on the server enables communication between Venafi and the HSM via a 1970 
secure connection or an NTL. If the NTL has not been set up during HSM/client installation, reference 1971 
Section 2.2.2.2 of this guide. 1972 

Use the vtl verify command in the installed client directory (typically C:\Program 1973 
Files\SafeNet\LunaClient) to determine if the connection was established and that a partition exists on 1974 
the HSM that the client can access. If no slot and partition are found, the NTL is not established. 1975 

The slot number and partition password will be needed when configuring Venafi to use the HSM. 1976 

vtl verify 1977 

  1978 

For further configuration between the HSM and Venafi TPP, please reference Section 2.6.13.3. 1979 

2.2.3 Day N: Ongoing Security Management and Maintenance 1980 

2.2.3.1 Prerequisites 1981 

 remote system logging server 1982 

2.2.3.2 Remote System Logging 1983 

Refer to the Luna SA syslog commands to use the remote system logging on any UNIX/Linux system that 1984 
supports the standard syslog service. Refer to the Luna SA syslog commands under “syslog remotehost” 1985 
(subcommands “add,” “delete,” and “list”) for more information. The remote host must have User 1986 



NIST SP 1800-16D: Securing Web Transactions: TLS Server Certificate Management 89 

Datagram Protocol (UDP) port 514 open to receive the logging. Refer to the hostʼs OS and firewall 1987 
documentation for more information. 1988 

1. Type the command below on the Luna SA appliance:   1989 

lunash:>syslog remotehost add 192.168.1.12 1990 

2. Start syslog with the “-r” option on the receiving or target system to allow it to receive the logs 1991 
from the Luna SA appliance(s). 1992 

2.2.3.3 Audit Logging 1993 

With Luna SA, the audit logs can be sent to one or more remote logging servers. Either UDP or 1994 
Transmission Control Protocol (TCP) protocol can be specified. The default is UDP and port 514. 1995 

2.2.3.3.1 UDP Logging 1996 
If using UDP protocol for logging:    1997 

 The following is required in /etc/rsyslog.conf 1998 

$ModLoad imudp 1999 

$InputUDPServerRun (PORT) 2000 

 Possible approaches include: 2001 

1.  With templates: 2002 

 $template AuditFile,"/var/log/luna/audit_remote.log" 2003 

  $syslogfacility-text == 'local3' then ?AuditFile;AuditFormat 2004 

2. Without templates: 2005 

   local3.* /var/log/audit.log;AuditFormat 2006 

3. Dynamic file name: 2007 

  $template DynFile,"/var/log/luna/%HOSTNAME%.log" 2008 

  if $syslogfacility-text == 'local3' then ?DynFile;AuditFormat 2009 

 The important thing to remember is that the incoming logs go to local3, and the Port/Protocol 2010 
that is set on the Luna appliance must be the same that is set on the server running rsyslog. 2011 

2.2.3.3.2 TCP Logging 2012 
Here is an example to set up a remote Linux system to receive the audit logs by using TCP. 2013 

 Register the remote Linux system IP address or host name with the Luna SA:    2014 
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lunash:> audit remotehost add -host 172.20.9.160 -protocol tcp -port 1660 2015 

2.3 DigiCert Certificate Authority 2016 

2.3.1 Day 0: Installation and Standard Configuration 2017 

2.3.1.1 Certificate Prerequisites for Domain Validation and Organization Validation  2018 

 organization validation–can be an individual or group/team 2019 

 domain validation process–DNS text (TXT) record validation 2020 

 must have resolvable FQDN entered in zone file (tls.nccoe.org, app1.tls.nccoe.org) 2021 

 access to DigiCert’s web-based registration system 2022 

 account sign-up 2023 

2.3.1.2 Standard Configuration 2024 

2.3.1.2.1 Account Sign-Up 2025 
1. Start the account sign-up process at https://www.digicert.com/account/signup/. 2026 

2. Complete the Your information, Organization information, and Account information sections. 2027 

3. Read and accept the terms of the Certificate Services Agreement. Check the box to acknowledge 2028 
acceptance of the terms. 2029 

4. Click the Sign Up button to create a CertCentral account. 2030 

https://www.digicert.com/account/signup/


NIST SP 1800-16D: Securing Web Transactions: TLS Server Certificate Management 91 

 2031 

2.3.1.2.2 Language Preferences 2032 
Currently, CertCentral supports the following languages: 2033 

 Deutsch 2034 

 English 2035 

 Español 2036 

 Français  2037 

 Italiano 2038 

 Português 2039 

 한국어 2040 

 日本語 2041 

 简体中文 2042 

 繁體中文 2043 

1. To change the language in the CertCentral account, click the account name at the upper-right 2044 
side of the screen and select My Profile from the drop-down list. 2045 



NIST SP 1800-16D: Securing Web Transactions: TLS Server Certificate Management 92 

2. On the Profile Settings page in the Language drop-down list, select the language preference for 2046 
the account. 2047 

3. Click Save Changes. The language in CertCentral should now be the same as the one selected. 2048 

2.3.1.2.3 Billing Contact 2049 

To edit the assigned Billing Contact in the CertCentral account: 2050 

1. In the sidebar menu, click Finances > Settings. 2051 

2. On the Finance Settings page, click Edit under Billing Contact in the right column. 2052 

3. In the Edit Billing Contact window, set or change the contact information. 2053 

4. Click Update Billing Contact to save the change. 2054 

2.3.1.2.4 Authentication Settings 2055 
Authentication settings allow control over the user login options for the CertCentral account and to set 2056 
security standards for password requirements and alternative authentication methods. 2057 
 2058 
To access the CertCentral authentication options: 2059 

1. In the CertCentral account in the sidebar menu, click Settings > Authentication Settings. 2060 
On this page, the following settings can be changed: 2061 

o Minimum Length: Change the minimum allowed password character length. 2062 

o Minimum Categories: Change the variety of characters allowed (uppercase, lowercase, 2063 
numbers, and symbols). 2064 

o Expires After: Change the password expiration policy. 2065 

o Two-Factor Authentication: Enable or disable onetime password two-factor 2066 
authentication for CertCentral users. 2067 

2. Configure the authentication settings as desired, then click Save Settings. 2068 

2.3.1.2.5 Security Assertion Markup Language (SAML) Single Sign-On Prerequisites 2069 
SAML is a highly recommended DigiCert feature for secure user authentication. However, it is not 2070 
required to duplicate the TLS lab setup. For more information on SAML, please refer to guidance at: 2071 

 https://pages.nist.gov/800-63-3/sp800-63-3.html 2072 

Before beginning, make sure the following prerequisites are met: 2073 

 Have a CertCentral account. 2074 

 Have SAML enabled on the CertCentral account. (To get the SAML features turned on for the 2075 
CertCentral account, contact the DigiCert account representative or the DigiCert support team. 2076 
Once activated, in the sidebar menu, under Settings, see the Single Sign-On and SAML 2077 
Certificate Request menu options.) 2078 

https://pages.nist.gov/800-63-3/sp800-63-3.html
https://www.digicert.com/contact-us/
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 Have an identity provider (IdP). 2079 

 Have the IdP metadata (dynamic or static). 2080 

 Have admin privileges on the CertCentral account (or have manager privileges on the 2081 
CertCentral account with the Allow access to SAML settings permission). 2082 

 2083 

2.3.1.2.6 Organization Validation 2084 
To validate an organization, DigiCert firsts verifies the organization requesting a certificate is in good 2085 
standing. This may include confirming good standing and active registration in corporate registries. It 2086 
may also include verifying the organization is not listed in any fraud, phishing, or government-restricted 2087 
entities and anti-terrorism databases. Additionally, DigiCert verifies  the organization requesting a 2088 
certificate is, in fact, the organization to which the certificate will be issued. DigiCert also verifies the 2089 
organization contact. 2090 

1. In the CertCentral account, using the sidebar menu, click Certificates > Organizations. 2091 
2. On the Organizations page, click New Organization. 2092 
3. On the New Organization page, under Organization Details, enter the specified organization 2093 

information: 2094 

Legal Name Enter the organization’s legally registered name. 

Assumed Name If the organization has a doing-business-as name and the name should 
appear on the certificates, enter the name here. 
If not, leave this box blank. 

Organization Phone 
Number 

Enter a phone number at which the organization can be contacted. 

Country In the drop-down list, select the country where the organization is legally 
located. 

Address 1 Enter the address where the organization is legally located. 

Address 2 Enter a second address, if applicable. 

City Enter the city where the organization is legally located. 

State/Province/ 
Territory/Region/ 
County 

Enter the state, province, territory, region, or county where the 
organization is legally located. 

Zip Code/Postal 
Code 

Enter the zip or postal code for the organization’s location. 
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4. Under Validation Contact, provide the contact’s information: 2095 

First Name Enter the contact’s first name. 

Last Name Enter the contact’s last name. 

Job Title Enter the contact’s job title. 

Email Enter an email address at which the contact can be reached. 

Phone Number Enter a phone number at which the contact can be reached. 

Phone Extension Enter the contact’s extension, if applicable. 

5. When finished, click Save Organization. 2096 
Submit an organization for validation. 2097 

6. In the CertCentral account, using the sidebar menu, click Certificates > Organizations. 2098 
7. On the Organizations page, use the drop-down list, search box, and column headers to filter the 2099 

list of organizations. 2100 
8. Click the link for the organization being submitted for validation and authorization for 2101 

certificates. 2102 
9. On the organization’s information page in the Submit Organization for Validation section, select 2103 

the validation types (certificates) needed for DigiCert to validate the organization’s information 2104 
below: 2105 

o OV—Normal Organization Validation (Recommended) 2106 

o EV—Extended Organization Validation (EV) 2107 

o Private SSL—DigiCert Private SSL Certificate 2108 

o CS—Code Signing Organization Validation 2109 

o EV CS—Code Signing Organization Extended Validation (EV CS) 2110 

o DS–Document Signing Validation 2111 

o Add verified contact (EV/EV CS, and CS). 2112 

If the organization validation chosen is not OV, refer to https://docs.digicert.com/manage-2113 
certificates/organization-domain-management/managing-domains-cc-guide/ for additional 2114 
details.  2115 

10. When finished, click Submit for Validation. 2116 

2.3.1.2.7 Domain Validation 2117 
DigiCert’s domain validation process ensures the organization requesting a certificate is authorized to 2118 
request a certificate for the domain in question. Domain validation can include emails or phone calls to 2119 
the contacts listed in a domain’s WHOIS record as well as emails to default administrative addresses at 2120 

https://docs.digicert.com/manage-certificates/organization-domain-management/managing-domains-cc-guide/
https://docs.digicert.com/manage-certificates/organization-domain-management/managing-domains-cc-guide/
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the domain. For example, DigiCert may send an authorization email to the administrator@domain.com 2121 
or webmaster@domain.com but would not send an authorization email to tech@domain.com. 2122 

Note: To validate a domain by using DNS TXT, see the steps below. To use an alternative method, refer 2123 
to Error! Hyperlink reference not valid.https://docs.digicert.com/manage-certificates/organization-2124 
domain-management/managing-domains-cc-guide/. 2125 

Step I: Add and Authorize a Domain for TLS/SSL Certificates 2126 

1. In the CertCentral account in the sidebar menu, click Certificates > Domains. 2127 
2. On the Domains page, click New Domain. 2128 
3. On the New Domain page, under Domain Details, enter the following domain information: 2129 

a. Domain Name 2130 
In the box, enter the domain name that the certificates will secure (for 2131 
example, yourdomain.com). 2132 

b. Organization 2133 
In the drop-down list, select the organization to assign to the domain. 2134 

4. Under Validate This Domain For, check the validation types needed for the domain to be 2135 
validated: 2136 

o OV—Normal Organization Validation (Recommended) 2137 
Use this option to order Standard SSL, Secure Site SSL, Wildcard SSL, Secure Site 2138 
Wildcard SSL, Multi-Domain SSL, and Secure Site Multi-Domain SSL certificates for this 2139 
domain. 2140 

5. Under Domain Control Validation (DCV) Method, select DNS TXT Record. 2141 
Note: The default DCV method is by verification email. 2142 

6. When finished, click Submit for Validation. 2143 
 

Step II: Use DNS TXT Record to Demonstrate Control Over the Domain 2144 

1. Create the DNS TXT record: 2145 
a. Under User Actions in the Your unique verification token box, copy the verification 2146 

token. 2147 
To copy the value to the clipboard, click in the text field. 2148 
Note: The unique verification token expires after 30 days. To generate a new token, click 2149 
the Generate New Token link. 2150 

b. Go to the organization’s DNS provider’s site and create a new TXT record. 2151 
c. In the TXT Value field, paste the verification code copied from the CertCentral account. 2152 
d. Host field 2153 

i. Base Domain 2154 
If validating the base domain, leave the Host field blank, or use the @ symbol 2155 
(dependent on the DNS provider requirements). 2156 

mailto:tech@domain.com
https://docs.digicert.com/manage-certificates/organization-domain-management/managing-domains-cc-guide/
https://docs.digicert.com/manage-certificates/organization-domain-management/managing-domains-cc-guide/
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ii. Subdomain 2157 
In the Host field, enter the subdomain being validated. 2158 

e. In the record type field (or equivalent), select TXT. 2159 
f. Select a Time-to-Live value, or use the organization’s DNS provider’s default value. 2160 
g. Save the record. 2161 

2. Verify the DNS TXT record: 2162 
a. In the CertCentral account, using the sidebar menu, click Certificates > Domains. 2163 
b. On the Domains page in the Domain Name column, click the link for the domain. 2164 
c. On the domain information page (e.g., example.com) at the bottom of the page, 2165 

click Check TXT. 2166 

2.3.2 Day 1: Integration Configuration 2167 

2.3.2.1 Generate API Key 2168 

DigiCert Services API provides the foundation for the CertCentral web portal. Because DigiCert 2169 
developed CertCentral as an API-first web application, the DigiCert Services API allows one to automate 2170 
CertCentral web application workflows and typical certificate processes and to streamline certificate 2171 
management. To access DigiCert Services API documentation, see the DigiCert Developers Portal. The 2172 
services API uses RESTful conventions. The DigiCert Services API requires a DigiCert Developer API key, 2173 
which is included in the header as part of each request.  2174 

Generate API Key 2175 

1. In the CertCentral account, using the side bar menu, click Account > Account Access. 2176 
2. On the Account Access page in the API Key section, click Add API Key. 2177 
3. In the Add API Key window, in the Description box, enter a description/name for the API key. 2178 
4. In the User drop-down, select the user to whom they key should be assigned/linked. 2179 

Note: When linking a key to a user, link that user’s permissions to the key. The API key has the 2180 
same permissions as the user and can perform any action that the user can. 2181 

5. Click Add API Key. 2182 
6. In the New API Key window, click on the generated key to copy it. 2183 
7. Save the key in a secure location. 2184 

Note: The API keys will be displayed only one time. If the window is closed without recording 2185 
the new API key, the key cannot be recorded again. 2186 

8. When done, click I understand I will not see this again. 2187 

2.3.2.2 Venafi Integration (Automated) 2188 

Venafi integrates with the DigiCert Services API. The integrated solution leverages DigiCert’s Online 2189 
Certificate Status Protocol (OCSP) infrastructure and API integration with Venafi’s machine identity 2190 
protection platform. Customers can customize specific features, from fully automating certificate 2191 

https://dev.digicert.com/
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provisioning to enforcing internal policies, allowing them to address industry regulations such as 2192 
Payment Card Industry Data Security Standard, Health Insurance Portability and Accountability Act of 2193 
1996, and General Data Protection Regulation. The integrated solution also simplifies integration of 2194 
machine identity protection across a wide variety of systems and allows customers to fulfill certificate 2195 
requests. 2196 

2.3.2.3 Order Certificate Directly Through CertCentral (Manual Process) 2197 

The TLS certificate life cycle begins when a TLS certificate is ordered. The process for requesting any of 2198 
the available certificates is the same: 2199 

 Create a CSR. 2200 

 Fill out the order form by clicking the Request a Certificate button from the left navigation bar. 2201 

 Complete domain control validation for the domains on the order (in other words, demonstrate 2202 
control over the domains). 2203 

 Complete organization validation for the organization on the certificate order.  2204 

2.3.2.4 Order an OV Single- or Multi-Domain TLS Certificate 2205 

When ordering Multi-Domain SSL certificates, add Other Hostnames (SANs) to the certificate order. This 2206 
option is not available for the single-domain certificates. 2207 

1. Create the CSR. 2208 
2. Select the OV Single- or Multi-Domain SSL/TLS certificate. 2209 

a. In the CertCentral account in the sidebar menu, click Request a Certificate, and then 2210 
under All Products, click Product Summary. 2211 

b. On the Request a Certificate page, look over the certificate options and select the 2212 
certificate. 2213 

3. Add the CSR. 2214 
On the Request page, under Certificate Settings, upload the CSR to or paste it in the Add Your 2215 
CSR box. 2216 
When copying the text from the CSR file, make sure to include the -----BEGIN NEW CERTIFICATE 2217 
REQUEST----- and -----END NEW CERTIFICATE REQUEST----- tags. 2218 

4. Common Name 2219 
Type the common name in the box, or under Common Name, expand Show Recently Created 2220 
Domains, and select the domain from the list. 2221 

5. Other Hostnames (SANs) 2222 
In the Other Hostnames (SANs) field, enter the additional host names needed for the certificate 2223 
to be secure. 2224 
For Multi-Domain certificates, four SANs are included in the base price of each certificate. 2225 
Additional SANs (over those included in the base price) increase the cost of the certificate. 2226 

6. Validity Period 2227 
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Select a validity period for the certificate: one year, two years, custom expiration date, or 2228 
custom length. 2229 
Custom Validity Periods 2230 

o Certificate pricing is prorated to match the custom certificate length. 2231 

o Certificate validity cannot exceed the industry-allowed maximum life-cycle period for 2232 
the certificate. 2233 
For example, a 900-day validity period cannot be set for a certificate. 2234 

7. Additional Certificate Options 2235 
The information requested in this section is optional. 2236 
Expand Additional Certificate Options and provide information as needed. 2237 

a. Signature Hash 2238 
Unless there is a specific reason for choosing a different signature hash, DigiCert 2239 
recommends using the default signature hash: Secure Hash Algorithm 256. 2240 

b. Server Platform 2241 
Select the server or system generated on the CSR. 2242 

c. Organization Unit(s) 2243 
Adding organization units is optional. This field can be left blank. If the CSR includes an 2244 
organization unit, we use it to populate the Organization Unit(s) box. 2245 
Note: If an organization’s units are included in the order, DigiCert will need to validate 2246 

them before issuing a certificate. 2247 
d. Auto-Renew 2248 

To set up automatic renewal for this certificate, check Auto-renew order 30 days before 2249 
expiration. 2250 
With auto-renew enabled, a new certificate order will be automatically submitted when 2251 
this certificate nears its expiration date. If the certificate still has time remaining before 2252 
it expires, DigiCert adds the remaining time from the current certificate to the new 2253 
certificate (as long as 825 days or approximately 27 months). 2254 
Note: Auto-renew cannot be used with credit card payments. To automatically renew 2255 

a certificate, the order must be charged to an account balance.  2256 
8. To add an organization, click Add Organization. Add a new organization or an existing 2257 

organization in the account. 2258 
Note: When adding a new organization, DigiCert will need to validate the organization before 2259 

issuing a certificate. 2260 
9. Add Contacts 2261 

Two different contacts can be added to the order: Organization and Technical. 2262 
Organization Contact (required) 2263 
The Organization Contact is someone who works for the organization included in the certificate 2264 
order. DigiCert will contact the Organization Contact to validate the organization and verify the 2265 
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request for OV TLS/SSL certificates. DigiCert also sends this person an order confirmation and 2266 
renewal emails. 2267 
Technical Contact (optional) 2268 
In addition to the Organization Contact, the Technical Contact will receive order emails, 2269 
including the one with the certificate attached, as well as renewal notifications. 2270 

10. Additional Order Options 2271 
The information asked for in this section is optional. 2272 
Expand Additional Order Options and add information as needed. 2273 

a. Comments to Administrator 2274 
Enter any information the administrator might need for approving the request, such as 2275 
the purpose of the certificate. 2276 

b. Order Specific Renewal Message 2277 
To create a renewal message for this certificate right now, type a renewal message with 2278 
information possibly relevant to the certificate’s renewal. 2279 

Note: Comments and renewal messages are not included in the certificate. 2280 
11. Additional Emails 2281 

Enter the email addresses (comma separated) for the people who want to receive the certificate 2282 
notification emails, such as certificate issuance, duplicate certificate, and certificate renewals.  2283 
Note: These recipients cannot manage the order; however, they will receive all the certificate-2284 

related emails. 2285 
12. Select Payment Method 2286 

Under Payment Information, select a payment method to pay for the certificate. 2287 
13. Certificate Services Agreement 2288 

Read the agreement and check I agree to the Certificate Services Agreement. 2289 
14. Click Submit Certificate Request. 2290 

2.3.2.5 Manage Order Within CertCentral (Manual) 2291 

After submitting the TLS certificate order, DCV and organization validation must be completed before 2292 
DigiCert can issue the certificate. 2293 

If the certificate does not immediately issue, please ensure all Day 0 activities have been completed 2294 
(Organization Validation and Domain Validation). 2295 

2.3.2.6 Download a Certificate from the CertCentral Account 2296 

After DigiCert issues the certificate, access it from inside the CertCentral account.  2297 
1. In the CertCentral account, go to the Orders page. 2298 

In the sidebar menu, click Certificates > Orders. 2299 
2. On the Orders page, use the filters and advanced search features to locate the certificate to be 2300 

downloaded. 2301 
3. In the Order # column of the certificate to be downloaded, click the Quick View link. 2302 
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4. In the Order # details pane (on the right), using the Download Certificate As drop-down, select 2303 
the certificate format to be used. 2304 

o .crt (best for Apache/Linux) 2305 
Download the certificate in a .crt format, best for Apache/Linux platforms. 2306 

o .pb7 (best for Microsoft and Java) 2307 
Download the certificate in a .pb7 format, best for Microsoft and Java platforms. 2308 

5. (OPTIONAL) In the Download Certificate As drop-down, click More Options to see more Server 2309 
Platform options and File Type options or to download only the Certificate, the Intermediate 2310 
Certificate, or the Root Certificate. 2311 

6. Download a Combined Certificate File 2312 
In the Download Certificate window, under Combined Certificate Files, use any of these options 2313 
to download the combined SSL certificate file. 2314 

a. Platform specific 2315 
In the Server Platform drop-down, select the server where the SSL/TLS certificate will be 2316 
installed, and then click Download. 2317 

b. File type specific 2318 
In the File Type drop-down, select the SSL/TLS file format to be downloaded, and then 2319 
click Download. 2320 

7. In the Download Certificate window, under Individual Certificate Files, use one of these options 2321 
to download an individual certificate file. 2322 

a. Server certificate file 2323 
Under Certificate, click the Download link. Save the server certificate file to the server 2324 
or workstation, making sure to note the location. 2325 

b. Intermediate certificate file 2326 
Under Intermediate Certificate, click the Download link. Save the intermediate 2327 
certificate file to the server or workstation, making sure to note the location. 2328 

c. Root certificate file 2329 
Under Root Certificate, click the Download link. Save the root certificate file to the 2330 
server or workstation, making sure to note the location. 2331 

2.3.3 Day N: Ongoing Security Management and Maintenance 2332 

2.3.3.1 Ongoing Auditing 2333 

Once the users, divisions, domains, and organizations have been added, an account audit may need to 2334 
be executed to highlight areas where training is required, reconstruct events, detect intrusions, and 2335 
discover problem areas. 2336 
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2.3.3.2 Run an Audit 2337 

1. In the CertCentral account, using the sidebar menu, click Account > Audit Logs. 2338 
2. On the Audit Logs page, use the filters to filter the results of the audit. 2339 

a. Choose a filter (for example, User).  2340 
b. In the filter drop-down, select an option (for example, select a user).  2341 
c. Wait for the filter to modify the audit log before using another filter. 2342 

2.3.3.3 Set Up Audit Log Notifications 2343 

To be of help to the organization, log data must be reviewed. The audit log notifications feature can be 2344 
used to keep aware of certain activities as well as make log review more meaningful.  2345 

1. In the CertCentral account, using the sidebar menu, click Account > Audit Logs. 2346 
2. On the Audit Logs page, click Audit Log Notifications. 2347 
3. On the Audit Log Notifications page, under Create a New Notification, take the following steps: 2348 

Email Address Enter the email address of the person to whom the audit log 
notifications are to be sent. 

Division In the drop-down, select the divisions whose account activity 
needs to be monitored. 

Notify me about Check any of the following options:  
• Order Changes  

Alerts if any changes are made to certificate orders.  
• User Changes  

Alerts if any edits are made to any user accounts.  
• User Logins  

Alerts of all account logins. 
• Logins from Invalid IP Addresses  

Alerts if any account logins are made from invalid IP 
addresses.  

• Certificate Revocations  
Alerts to all certificates are revocations. 

4. When finished, click Save Changes. 2349 
The designated individual should start receiving the selected audit log notifications. 2350 

2.3.3.4 Notification Management 2351 

Typically, notifications are not strictly required when utilizing Venafi to manage certificates, as expiring 2352 
certificates are renewed automatically (or not) based on configured policy within Venafi. However, it is 2353 
beneficial to configure renewal notifications within CertCentral. 2354 
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2.3.3.4.1 Account Notifications 2355 
Before sending email from an account, assign an email address to receive a copy of any message sent 2356 
(e.g., approval notifications). Configure renewal notifications and add default renewal messages that 2357 
include renewal notifications. 2358 

 2359 

2.3.3.4.2 Set Up Email Notification Accounts 2360 
1. In the CertCentral account’s sidebar menu, click Settings > Notifications. 2361 
2. On the Notifications page in the Send all account notifications to box, add the email addresses 2362 

that should be copied on all emails sent from the account. 2363 
Note: When setting up multiple notification accounts, use commas to separate the email 2364 

addresses. 2365 
3. When finished, click Save. 2366 

2.3.3.4.3 Certificate Renewal Notifications 2367 
After DigiCert has issued the first certificate, configure the Certificate Renewal Settings (such as when 2368 
renewal notifications are sent and to whom notifications are sent) to help prevent unexpected 2369 
certificate expirations. 2370 
 2371 
When configuring the certificate renewal settings, there are two options: 2372 

1. Nonescalation Certificate Renewals 2373 
This option sends renewal notifications to the same email addresses at every stage as 2374 
certificates get closer to expiration or after they have expired. 2375 

2. Escalation Certificate Renewals 2376 
This option configures email escalation settings in which additional email addresses can receive 2377 
renewal notifications at critical stages as certificates get closer to expiring or after they have 2378 
expired. This allows additional oversight of certificate expiration. 2379 
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2.3.3.4.4 Configure Nonescalation Renewal Notifications 2380 
Use the steps below to send all renewal notifications to the same email addresses at every stage as 2381 
certificates get closer to expiring or after they have expired. 2382 

1. In the CertCentral account’s sidebar menu, click Settings > Preferences. 2383 
2. On the Division Preferences page, scroll down to the Certificate Renewal Settings, and 2384 

uncheck Enable Escalation. 2385 
3. In the Send request renewal notifications to box, enter the email addresses for the people who 2386 

should receive the renewal notifications (comma separated). 2387 
4. Under When certificates are scheduled to expire in, check the boxes to indicate when to send 2388 

renewal notices. 2389 
Note: These options determine when email notifications are sent. For example, if only 30 2390 

days, 7 days, and 3 days are checked, no email notifications will be sent 90 days or 60 2391 
days before certificates expire. 2392 

5. In the Default Renewal Message box, type an optional renewal message for inclusion in all the 2393 
renewal notification emails. 2394 

6. Click Save Settings when finished. 2395 

2.3.3.4.5 Configure Escalation Renewal Notifications 2396 
Email escalation settings allow control over what email addresses will receive renewal notifications at 2397 
each stage as certificates approach or reach expiration. 2398 

1. In the CertCentral account’s sidebar menu, click Settings > Preferences. 2399 
2. On the Division Preferences page, scroll down to Certificate Renewal Settings, and 2400 

check Enable Escalation. 2401 
3. Under Days before expiration, check the boxes for when renewal notices should be sent. 2402 
4. Under Additional email addresses or distribution lists, enter the email addresses for the people 2403 

who should receive each renewal notification (comma separated). 2404 
5. In the Default Renewal Message box, type an optional renewal message for inclusion in all 2405 

renewal notification emails. 2406 
6. Click Save Settings when finished. 2407 

2.3.3.5 Managing Custom Order Fields 2408 

CertCentral allows users to add custom fields to certificate order forms. Use the custom field metadata 2409 
to search or sort a set of certificate orders that match the metadata search criteria. 2410 

Note: The Custom Fields feature is off by default. To enable this feature for a CertCentral account, 2411 
please contact a DigiCert account representative. 2412 

Once enabled for a CertCentral account, the Custom Order Fields menu option is added to the sidebar 2413 
menu under Settings (Settings > Custom Order Fields). 2414 
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2.3.3.5.1 Custom order form field features 2415 

 Apply to Future and Present Requests–When a custom order form field is added, the field is also 2416 
added to pending requests. If the field is required, the pending requests cannot be approved 2417 
until the field is completed. 2418 

 Apply to Entire Account–When custom order form fields are added, the fields are applied to the 2419 
order forms for the entire account. Custom order form fields cannot be set per division. 2420 

 Apply to All Certificate Types–When custom order form fields are created, the fields are added 2421 
to the order forms for all certificate types (SSL, Client, Code Signing, etc.). A custom order form 2422 
field cannot be added to the order forms for only SSL certificate types. 2423 

 Apply to Guest URLs–When custom order form fields are added, these fields are added to the 2424 
certificates ordered from directly inside the CertCentral account as well as from any guest URLs 2425 
that have been sent. 2426 

 Different Types to Choose From–When custom order form fields are created, different types of 2427 
fields can be added such as single-line and multiple-line text boxes and email address and email 2428 
address list boxes. 2429 

 Required or Optional–When custom order form fields are added, they can be required or 2430 
optional. Required fields must be completed before the order can be approved. Optional fields 2431 
can be left blank. 2432 

 Deactivated or Activated–After a custom order form field has been added, the field can be 2433 
deactivated (removed) and activated (added back) as needed. Deactivated fields are removed 2434 
from pending requests but not from issued orders. Activated fields are added to pending 2435 
requests. If the field is required, it must be completed before the request can be approved. 2436 

2.3.3.5.2 Add a Custom Field to Request Forms 2437 
1. In the CertCentral account in the sidebar menu, click Settings > Custom Order Fields. 2438 
2. On the Custom Order Form Fields page, click the Add Custom Order Form Field link. 2439 
3. In the Add Custom Order Form Field window, configure the custom field: 2440 

Label In the box, type a name/label for the field (e.g., Direct Report’s Email 
Address). 

Input Type In the drop-down list, select an input type for the field (i.e., email 
address). 
Input Types: 

 Anything: Single-line text box 

 Text: Multiline text box 

 Integer: Number box (limited to nondecimal whole 
numbers) 

 Email Address: Single email address box 



NIST SP 1800-16D: Securing Web Transactions: TLS Server Certificate Management 105 

 Email Address List: Multiple email address box 

This field should be 
required for all new 
requests 

If the field needs to be completed before the request can be 
submitted (or approved for pending requests), check this box. 
Note: If this box is not checked, the field appears on the order form 
with the word “optional” in the box. The requester does not need to 
complete the box for the request to be submitted (or approved for 
pending requests). 

4. When finished, click Add Custom Form Field. 2441 

2.3.3.6 User Management 2442 

Add a user to the CertCentral account. 2443 

1. In the CertCentral account in the sidebar menu, click Account > Users. 2444 
2. On the Users page, click Add User. 2445 
3. On the Add User page in the User Details section, enter the new user’s information. 2446 
4. In the User Access section, assign the user a role, and configure their division access if 2447 

applicable: 2448 
Username We recommend using the user’s email address. 
Restrict this user to specific divisions Check this box if the role should be restricted to 

specific divisions.  
Note: This option appears only if divisions within the 
CertCentral account are being used. 

User is restricted to the following 
divisions 

Select the divisions to which the role is restricted. 
Note: This drop-down appears only if “Restrict this 
user to specific divisions” is checked. 

Allow this user to log in only through 
SAML Single Sign-On SSO 

Check this box if this user should be restricted from 
being able to log in with username and password. 
Note: SAML SSO must be configured in the account 
and the IdP must be configured with this user’s 
information. 

Role Select a role for the new user: Administrator, 
Standard User, Finance Manager, or Manager.  

Limit to placing and managing their 
own orders 

To create a Limited User role, select Standard User, 
and check this box. 

5. When finished, click Add User. 2449 
 

What’s next 2450 
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The newly added user will receive an email with instructions for setting up their account credentials and 2451 
can use them to sign in to their CertCentral account. 2452 

2.3.3.7 Revalidation Processes 2453 

Organization and domain validation typically expire in two years. When the validation status nears 2454 
expiration, CertCentral sends a notification and automatically initiates a revalidation process. The user 2455 
should complete the steps outlined in Day 0 Organization Validation and Domain Validation. The 2456 
standards governing the requirements surrounding (re)validation processes are encapsulated in the 2457 
CA/Browser Forum’s Baseline Requirements (https://cabforum.org/baseline-requirements-2458 
documents/). The specific allowed methods of validation will change over time. 2459 

Note: This revalidation process is outside the Venafi certificate management processes.  2460 

 OV validation and revalidation: two years 2461 

 DV validation and revalidation: two years 2462 

 EV validation and revalidation: one year 2463 

Note: Extended Validation provides additional levels of vetting surrounding the legal entity represented 2464 
in a certificate. Vetting ensures that a complete picture of the identity, which has proven control over 2465 
the domain in the certificate, is available to user agents verifying the certificate. 2466 

2.4 F5 BIG-IP Local Traffic Manager (LTM) 2467 

BIG-IP Virtual Edition (VE) is a version of the BIG-IP system that runs as a virtual machine in specifically 2468 
supported hypervisors. BIG-IP VE emulates a hardware-based BIG-IP system running a VE-compatible 2469 
version of BIG-IP software. 2470 

2.4.1 Day 0: Installation and Standard Configuration 2471 

2.4.1.1 Prerequisites 2472 

 VMware ESX 6.5 2473 

 2 virtual Central Processing Units (CPUs) 2474 

 4 GB RAM 2475 

 1 x VMXNET3 virtual network adapter or Flexible virtual network adapter (for management) 2476 

 x virtual VMXNET3 virtual network adapter  2477 

 1 x 100 GB Small Computer System Interface disk, by default  2478 

 connection to a common NTP source 2479 

 SMTP for BIG-IP to send email alerts 2480 

https://cabforum.org/baseline-requirements-documents/
https://cabforum.org/baseline-requirements-documents/
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 a computer with internet (browser) access to activate license 2481 

 license key for F5 BIG-IP 2482 

 F5 Support ID account 2483 

2.4.1.2 Download the Virtual Appliance 2484 

To deploy BIG-IP VE, download the open virtualization appliance (OVA) file to your local system. 2485 

1. Open the F5 Downloads page at https://downloads.f5.com. 2486 

2. Log in with an F5 Support ID. 2487 

3. In the Downloads Overview page, click Find a Download button. 2488 

4. In the Select a Product Line page, click the BIG-IP v13.x / Virtual Edition… link. 2489 

5. In the Select a Product Version… page, click the 13.1.1.4_Virtual-Edition link. 2490 

6. In the Software Terms… page, review, then click I Accept button to agree to terms and 2491 
conditions. 2492 

7. In the Select a Download page, click the BIGIP-13.1.1.4-0.0.4.ALL-scsi.ova link. 2493 

8. In the Download Locations page, click the link nearest to the correct region. 2494 

9. Save the OVA file to the local computer. 2495 

2.4.1.3 Deploying the BIG-IP OVA 2496 

Use the Deploy Open Virtualization Format (OVF) Template wizard from within the VMware vSphere 2497 
client. Follow the steps in this procedure to create an instance of the BIG-IP system that runs as a virtual 2498 
machine on the host system. 2499 

1. Start the vSphere Client and log in. 2500 
2. Launch the Deploy OVF Template wizard. 2501 
3. Select an OVF template from Local file. Select the previously downloaded OVA file. 2502 
4. In the Virtual machine name field, type in F5lb1.ext-nccoe.org. Then select the location for 2503 

this virtual machine. Click Next. 2504 
5. Select the compute resource and click Next. 2505 
6. Verify that the OVF template details are correct, then click Next. 2506 
7. Review the template details, then click Next. 2507 
8. Review License agreements. Select “I accept…” and click Next. 2508 
9. Read and accept the license agreement, and click Next. 2509 
10. Accept the default value 2 CPUs and click Next. 2510 
11. Accept the default value Thick Provision Lazy Zeroed and click Next. 2511 

https://downloads.f5.com/


NIST SP 1800-16D: Securing Web Transactions: TLS Server Certificate Management 108 

12. Assign the networks to the network interface cards (NICs) and click Next. 2512 

o NIC 1: VLAN 2199 (Datacenter Secure) 2513 

o NIC 2: VLAN 2201 2514 

o NIC 3: VLAN 2197 (DMZ) 2515 

13. Review information and click Finish. 2516 

2.4.1.4 Assigning a Management IP Address to a BIG-IP VE Virtual Machine 2517 

The BIG-IP VE virtual machine needs an IP address assigned to its virtual management port. 2518 

1. In the main vSphere client window, Power On the BIG-IP. 2519 

2. Launch a Console session for the BIG-IP. 2520 

3. At the login prompt, log in as root / default. 2521 

4. At the config # prompt, type config. 2522 

The Configure Utility panel appears. 2523 

5. Press Enter for OK. 2524 

The Configure IP Address panel appears. 2525 

6. For “Automatic configuration…”, choose No. 2526 

7. For IP Address, type 192.168.3.85 Choose OK. 2527 

8. For Netmask, type 255.255.255.0. Choose OK.  2528 

9. For Management Route, choose Yes. 2529 

10. For Management Route, type 192.168.3.1 Choose OK. The Confirm Configuration panel 2530 
appears. (This Gateway address is used for management traffic.) 2531 

11. Review the IP information, and choose Yes. Return to the config # prompt. 2532 

2.4.1.5 Log in to BIG-IP for the First Time 2533 

After the initial login to the BIG-IP, the Setup Utility will guide through the initial setup process. 2534 

1. Open the browser and navigate to the BIG-IP address https://192.168.3.85. 2535 

2. Log in as the default admin/admin. 2536 
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 2537 

3. The Setup Utility panel appears, then click Next. 2538 

4. For License, click Activate. 2539 

5. As a prerequisite, the user should already have a BIG-IP VE license key. Copy the key and paste 2540 
in the Base Registration Key field. 2541 

6. This step is dependent on internet access for the BIG-IP. 2542 

a. If the management route configured in the previous section has a path to internet, 2543 
select Automatic. Click Next. Review the End User License Agreement (EULA) and click 2544 
Agree. Then go to step 7. 2545 

b. Otherwise, select Manual. Click Next. 2546 

c. Left-click in the Dossier field, and select all the encrypted text with Ctrl-A. Copy the 2547 
selected text with Ctrl-C. 2548 

d. Assuming the administration computer has internet access, click the “Click here to 2549 
access F5…” link. A new browser tab appears. 2550 

e. In the Enter Your Dossier field, paste in the copied text. Click Next. 2551 

f. Review the EULA, and select “I have read and agree… .” Click Next. 2552 

g. Left-click the license text field, and select all text with Ctrl-A. Copy selected text with 2553 
Ctrl-C. 2554 

h. Return to the BIG-IP Setup Utility. In the License field, paste in the copied text. Click 2555 
Next. 2556 

7. Some BIG-IP services will restart and log the user off the BIG-IP. It will automatically resume. 2557 
Click Continue. 2558 

8. Review the License page. Click Next. 2559 
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9. On the Resource Provisioning page, verify that the only default value, Local Traffic (LTM), is 2560 
selected and set to Nominal. Click Next. 2561 

10. On the Device Certificates page, leave the default as self-sign device Certificate. Click Next. 2562 

11. On the Platform page, fill these values. Then click Next. 2563 

Field Value Comments 

Management Port 
Configuration 

443  

IP Address 192.168.3.85  

Network Mask 255.255.255.0  

Management Route 192.168.3.1  

Host Name f5lb1.ext-nccoe.org  

Time Zone EST  

Root Account <your password> Refer to NIST SP 800-63B for 
password guidance. 

Admin Account <your password> Refer to NIST SP 800-63B for 
password guidance. 

 2564 

 2565 

12. System logs off the user with password change. Log back in with the new admin password. 2566 



NIST SP 1800-16D: Securing Web Transactions: TLS Server Certificate Management 111 

13. In the Standard Network Configuration page, click Next. 2567 

14. In the Redundant Device Wizard Options page, Un-Select Display configuration synchronization 2568 
options. 2569 

15. In the Internal Network Configuration page, fill in these values. 2570 

Address 192.168.4.85 

Netmask 255.255.255.0 

VLAN Interfaces internal 

Tagging untagged 

 

16. Click Add, then click Next. 2571 

17. In the External Network Configuration page, fill in these values. 2572 

Address 192.168.5.86 

Netmask 255.255.255.0 

VLAN Interfaces external 

Tagging untagged 

 

18. Click Add, then click Finished. 2573 

2.4.1.6 BIG-IP Configuration Utility 2574 

There are at least two ways to administer the BIG-IP. 2575 

 Use SSH to connect to the BIG-IP to access the command line interface, referred to as traffic 2576 
management shell (TMSH). 2577 

 With a web browser, navigate to the management URL—referred to as Configuration utility and 2578 
mainly used in this guide. 2579 

1. Open browser and navigate to the BIG-IP address https://192.168.3.85. 2580 

2. Log in as admin, and use the password modified from the default during Setup wizard. 2581 
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 2582 
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 2583 

2.4.1.7 Configure NTP 2584 

Time synchronization is crucial when multiple BIG-IPs are in a cluster (not covered in this guide). It is also 2585 
necessary for accuracy of logging information. 2586 

1. Log on to the Configuration utility. 2587 

2. Navigate to Main > System. Then click Configuration > Device > NTP. 2588 

The NTP panel appears. 2589 
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 2590 

3. In the Address field, type time-a-g.nist.gov. Click Add. 2591 

4. In the Address field, type time-b-g.nist.gov. Click Add. 2592 

5. Click Update. 2593 

2.4.1.8 Configure SMTP 2594 

BIG-IP can be configured to send email alerts. 2595 

1. Navigate to Main > System. Then click Configuration > Device > SMTP. 2596 

The SMTP panel appears. 2597 

2. In the upper right corner, click the Create button. 2598 

The New SMTP Configuration panel appears. 2599 

3. Fill in these values. 2600 
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Name mail1 

SMTP Server Host Name mail1.int-nccoe.org 

Local Host Name f5lb1-ext-nccoe.org 

From Address f5-big-ip@nccoe.org 

 

4. Click Finish. 2601 

2.4.1.9 Configure Syslog 2602 

Log events either locally on the BIG-IP system or remotely by configuring a remote syslog server. 2603 

1. Log on to the Configuration utility. 2604 

2. Navigate to System > Logs > Configuration > Remote Logging. 2605 

3. In Remote IP field, type 192.168.3.12. 2606 

4. Click Add. 2607 

5. Click Update. 2608 

2.4.1.10  Secure BIG-IP to NIST SP 800-53 2609 

This section provides guidance on using the F5 iApp for NIST SP 800-53 (Revision 5) to configure a BIG-IP 2610 
device to support security controls according to NIST SP 800-53 (Revision 4): Security and Privacy 2611 
Controls for Federal Information Systems and Organizations (updated January 2, 2015). 2612 

Some controls (policies plus supporting technical measures) that organizations adopt by complying with 2613 
NIST SP 800-53 (Revision 5) relate to the BIG-IP configuration.  2614 

This practice guide discusses the security controls in Appendix F of NIST SP 800-53 (Revision 5) that 2615 
apply to BIG-IP configuration and shows how to support them. It also focuses on configuring the 2616 
management features of the BIG-IP system rather than the network-traffic-processing modules of a 2617 
system such as BIG-IP Local Traffic Manager. This approach helps the user manage the BIG-IP system as 2618 
an entity responsive to NIST SP 800-53 (Revision 5) controls. Using BIG-IP as a tool to help control other 2619 
entities, such as network-based applications, is beyond the scope of this project. 2620 

2.4.1.10.1 F5 iApp 2621 
F5 iApp is a feature in the BIG-IP system that provides a way to simplify BIG-IP configurations. An iApp 2622 
template brings together configuration elements, architectural rules, and a management view to deliver 2623 
an application reliably and efficiently. 2624 
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2.4.1.10.2 Download the iApp for NIST SP 800-53 (Revision 5) Compliance 2625 
1. In a browser, open the F5 Downloads page at https://downloads.f5.com. 2626 

2. Log in with an F5 Support ID. 2627 

3. In the Downloads Overview page, click Find a Download button. 2628 

4. In the Select a Product Line page, under Product Line column, click iApp Templates. 2629 

5. In the Select a Product Version… page, click iApp-Templates. 2630 

6. Review the EULA, then click I Accept. 2631 

7. In the Select a Download page, click iapps-1.0.0.546.0.zip. 2632 

8. In the Download Locations page, click on the link nearest to the user’s region. 2633 

9. Save the zip file to the local computer. 2634 

2.4.1.10.3 Import iApp to BIG-IP 2635 
1. Unzip the downloaded file. 2636 

2. Open browser and navigate to the BIG-IP address https://192.168.3.85. 2637 

3. Log in as admin/admin. 2638 

4. On the left menu, click Main > iApps > Templates. Then on the right side, click Import button. 2639 

 2640 

5. Browse to the file unzip location and to the subfolder 2641 
\iapps-1.0.0.546.0\Security\NIST\Release_Candidates. Select the file f5.nist_sp800-2642 
53.v1.0.1rc5.tmpl, then click Open. 2643 

6. Click Upload. 2644 

7. On page 2 of the Template List, verify that the f5.nist_sp800-53.v1.0.1rc5 template has been 2645 
uploaded. 2646 

https://downloads.f5.com/
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2.4.1.10.4 Deploy the NIST iApp 2647 
1. On the left menu, click Main > iApps > Application Services. Then on the right side, click Create 2648 

button. 2649 

The Template Selection panel appears. 2650 

2. In the Name field, type nist-800-53. 2651 

3. In the Template pull-down, select f5.nist_sp800-53.v1.0.1rc5. 2652 

The New Application Service panel appears. 2653 

  2654 

4. Fill in the iApps with parameters in the following table. Leave everything else as default values. 2655 

Password Strength Policy—IA-5(1)  

Do you want to enforce custom local password 
policy? 

“Yes, enforce a custom…” 
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How many days should pass before the 
password expires? 

0 

How many changes before reuse? 0 

How many characters should be the minimum 
for each setting? 

Length = 8 

Maximum Failed Login Attempts—AC-7  

Disable account after several failed login 
attempts? 

“Yes, limit fail…” 

Allow how many consecutive login failures 
before disabling the account? 

9 

NTP Configuration—AU-8(1,2)  

What is the IP address or FQDN of the primary 
NTP server? 

time-a-g.nist.gov 

What is the IP address or FQDN of the first 
alternate NTP server? 

time-b-g.nist.gov 

Syslog Configuration—AU-8, AU-9(2), AU-12(2)  

Should log messages use International 
Standards Organization (ISO) date format? 

“Yes, log messages…” 

Do you want to add syslog servers? “Yes, use this iApp…” 

Which syslog servers do you want to add? Server: syslog2.int-nccoe.org 

 

5. Click Finished. 2656 

2.4.2 Day 1: Product Integration Configuration 2657 

2.4.2.1 Prerequisites 2658 

 Venafi installed 2659 

 web servers for load balance 2660 
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2.4.2.2 Venafi Integration 2661 

For information on integration with Venafi TPP, see Section 2.6.13.1. 2662 

2.4.2.3 Load Balance Web Servers 2663 

2.4.2.3.1 Create a Pool to Manage https Traffic 2664 
A pool (a logical set of devices, such as web servers, that are grouped together to receive and 2665 
process https traffic) can be created to efficiently distribute the load on the server resources. 2666 

1. On the Main tab, click Local Traffic > Pools. 2667 

 The Pool List screen opens. 2668 

2. Click Create. 2669 

 The New Pool screen opens. 2670 

3. In the Name field, type app1_pool. 2671 

4. For the Health Monitors setting, assign https by moving it from the Available list to the Active 2672 
list. 2673 

5. Use the New Members setting to add each resource to include in the pool: 2674 

a. In the Address field, type 192.168.4.2. 2675 

b. In the Service Port field type 443. 2676 

c. Click Add. 2677 

6. Repeat step 5 for these three IP addresses. 2678 

a. 192.168.4.3 2679 

b. 192.168.4.4 2680 

c. 192.168.4.7 2681 

7. Click Finished. 2682 

The https load balancing pool appears in the Pool List screen. 2683 

2.4.2.3.2 Create Client SSL Profile 2684 
Profile for BIG-IP to decrypt traffic from browser 2685 

1. On the Main tab, click Local Traffic > Profiles > SSL > Client. 2686 

 The SSL Client List screen opens. 2687 
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2. Click Create. 2688 

 The New Client SSL Profile screen opens. 2689 

3. In the Name field, type app1_client-ssl. 2690 

4. In the Certificate Key Chain setting, select the checkbox on the right. Then click Add. 2691 

 The Add SSL Certificate to Key Chain screen opens. 2692 

5. For Certificate pull-down, select app1.tls.nccoe.org-<value>. 2693 

6. For Key pull-down, select app1.tls.nccoe.org-<value>. 2694 

7. Click Add. 2695 

8. Click Finished. 2696 

2.4.2.3.3 Create Server SSL Profile 2697 
Profile for BIG-IP to encrypt traffic to web servers: 2698 

1. On the Main tab, click Local Traffic > Profiles > SSL > Server. 2699 

 The SSL Server List screen opens. 2700 

2. Click Create. 2701 

 The New Server SSL Profile screen opens. 2702 

3. In the Name field, type app1_server-ssl. 2703 

4. In the Certificate setting, select the checkbox on the right. Then select app1.tls.nccoe.org-2704 
<value> in the pull-down. 2705 

5. In the Key setting, select the checkbox on the right. Then select app1.tls.nccoe.org-<value> in 2706 
the pull-down. 2707 

 The Add SSL Certificate to Key Chain screen opens. 2708 

6. For Certificate pull-down, select app1.tls.nccoe.org-<value>. 2709 

7. For Key pull-down, select app1.tls.nccoe.org-<value>. 2710 

8. Click Finished. 2711 

2.4.2.3.4 Create a Virtual Server to Manage https Traffic 2712 
A virtual server can be specified to be either a host virtual server or a network virtual server to manage 2713 
https traffic. 2714 
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1. On the Main tab, click Local Traffic > Virtual Servers. 2715 

 The Virtual Server List screen opens. 2716 

2. Click the Create button. 2717 

 The New Virtual Server screen opens. 2718 

3. In the Name field, type app1_vs. 2719 

4. In the Destination Address field, type 192.168.5.85. 2720 

5. In the Service Port field, type 443. 2721 

6. In the HTTP Profile setting, select http in the pull-down. 2722 

7. In the SSL Profile (Client) setting, from the Available list, select app1_client-ssl, and click the 2723 

button to move over to the Selected list. 2724 

8. In the SSL Profile (Server) setting, from the Available list, select app1_server-ssl, and click the 2725 

button to move over to the Selected list. 2726 

9. In the Source Address Translation setting, select Auto Map in the pull-down. 2727 

10. In the Default Pool setting, select app1_pool in the pull-down. 2728 

11. In the Default Persistence Profile setting, select cookie in the pull-down. 2729 

12. Click Finished. 2730 

The https virtual server appears in the Virtual Server List screen. 2731 

2.4.2.3.5 Create Redirect Virtual Server from http to https 2732 
When a user types http://<virtual server> in the browser, this virtual server redirects the user to the 2733 
secure site https://<virtual server>. 2734 

1. On the Main tab, click Local Traffic > Virtual Servers. 2735 

 The Virtual Server List screen opens. 2736 

2. Click the Create button. 2737 

 The New Virtual Server screen opens. 2738 

3. In the Name field, type app1_redir_vs. 2739 

4. In the Destination Address field, type 192.168.5.85. 2740 
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5. In the Service Port field, type 80. 2741 

6. In the HTTP Profile setting, select http in the pull-down. 2742 

7. In the iRules setting, select _sys_https_redirect in Available, and click the button to move 2743 
over to the Enabled list. 2744 

8. Click Finished. 2745 

The http redirect virtual server appears in the Virtual Server List screen. 2746 

2.4.3 Day N: Ongoing Security Management and Maintenance 2747 

2.4.3.1 Software Updates 2748 

BIG-IP VE updates in the same major version are installed in a similar manner as updates to BIG-IP 2749 
software already installed on BIG-IP hardware. There is no need to reinstall BIG-IP VE in the hypervisor 2750 
guest environment to upgrade the system. To update a BIG-IP VE virtual machine, use the Software 2751 
Management tool in the Configuration utility, or upgrade the software from the command line. The 2752 
update procedure described in this guide uses the Software Management tool. 2753 

2.4.3.1.1 Download the Latest Software 2754 
Software release notes contain instructions for that specific installation. 2755 

To find the latest software version for an F5 product: 2756 

1. Navigate to F5 Downloads (downloads.f5.com). 2757 

2. Click Find a Download. 2758 

3. Find the product desired for download, and click the link for the appropriate version. 2759 

4. Find and click the link for the update to download. 2760 

5. Read and accept the End User Software license agreement. 2761 

6. Click the file name, choose a download location, and save the file to the computer. 2762 

2.4.3.1.2 Upgrading BIG-IP Software 2763 
Before upgrading the BIG-IP software, we recommend reviewing the release notes on AskF5 2764 
(support.f5.com) in the Documentation section of the product and version. In particular, verify the new 2765 
version supports the hardware, and carefully review these items: 2766 

 known issues list 2767 

 behavior change section(s) 2768 
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 upgrading from earlier versions section 2769 

 upgrading from earlier configurations section 2770 

 installation checklist 2771 

2.4.3.1.3 Import a BIG-IP VE Software Update 2772 
To install an update, BIG-IP software needs access to the ISO file previously downloaded. 2773 

1. Open browser, and navigate to the BIG-IP address https://192.168.3.85 2774 
2. Log in as an admin. 2775 
3. On the Main tab, click System > Software Management. 2776 

The Software Management Image List screen opens. 2777 

4. At the right side of the screen, click Import. 2778 

The New Image screen opens. 2779 

5. Click Browse to navigate to the downloaded installation file. 2780 
6. When the image name appears in the Software Image field, click Import to begin the operation. 2781 

The system presents a progress indicator during the operation. 2782 

2.4.3.1.4 Installing a BIG-IP VE update 2783 
After import the software image, initiate the installation operation. 2784 

1. On the Main tab of the navigation pane, click System > Software Management. 2785 

The Software Management Image List screen opens. 2786 

2. From the Available Images table, select the software image you want to install. 2787 

The image properties screen opens. 2788 

3. Click Install. 2789 

The Install Software screen opens. 2790 

4. Select the disk you want to install the image on, and type or select a volume name, and click 2791 
Install. 2792 

The upgrade process installs the software on the inactive disk location that you specify. This 2793 
process usually takes between three and ten minutes. 2794 

Tip: If a problem arises during installation, use log messages to troubleshoot a solution. The 2795 
system stores the installation log file as /var/log/liveinstall.log. 2796 

5. The software image is installed. 2797 
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2.4.3.1.5 Reboot BIG-IP VE to update 2798 
When the installation operation is complete, you can safely reboot into the newly installed volume or 2799 
partition. 2800 

1. On the Main tab of the navigation pane, click System > Software Management. 2801 

The Software Management Image List screen opens. 2802 

2. On the menu bar, click Boot Locations. 2803 

The Boot Locations screen opens. 2804 

3. In the Boot Location column, click the link representing the boot location you want to activate. 2805 

The properties screen for the boot location opens. 2806 

4. Click Activate. 2807 

A confirmation screen opens. 2808 

5. Click OK to initiate the reboot operation. 2809 

The system presents progress messages during the restart operation. 2810 

When the BIG-IP VE system reboot is complete, the system presents the login screen. To configure the 2811 
system, log in using an account that has administrative permissions. 2812 

2.4.3.2 License and Entitlement 2813 

If support is purchased from F5, it is associated with a particular BIG-IP system. A system with an active 2814 
support contract is considered entitled until the contract expires. To continue receiving support, the 2815 
contact must be renewed. 2816 

Licenses are also associated with modules purchased to run a specific system. Model licenses are 2817 
considered add-ons to the main license for a system, and are automatically linked to the main BIG-IP 2818 
system license and eligible for technical support if that system is entitled. 2819 

Major software upgrades are only supported for entitled systems and require relicensing of the BIG-IP 2820 
system. Minor upgrades do not require relicensing. 2821 

2.4.3.2.1 Viewing and verifying a BIG-IP system license 2822 
Test the validity of the BIG-IP software license by obtaining license information in any of the following 2823 
ways: 2824 

 view license information at the command line 2825 

 request a product license profile from F5 2826 
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 view license profile in BIG-IP iHealth® 2827 

 view license profile in the Configuration utility 2828 

 At the command line, type the following command: tmsh show /sys license 2829 

Output displays licensing information for the BIG-IP system should include a list of active modules. For a 2830 
system with a valid license, output appears similar to the following example: 2831 

2.4.3.2.2 Provisioning licenses 2832 
If a license is installed for an add-on module on a BIG-IP system, you must provision resources for the 2833 
module. 2834 

Until provisioned, module function is limited in the following ways: 2835 

 the system does not perform the functions of the licensed module 2836 

 items related to the module do not appear in Configuration utility menus 2837 

 the TMOS Shell (tmsh) does not present or permit configuration of objects related to the 2838 
module. 2839 

 the bigstart status command returns output similar to the following example for daemons 2840 
related to the unprovisioned module:  <daemon_name> down, Not provisioned For information 2841 
on provisioning modules, refer to “Modules.” 2842 

When you upgrade a BIG-IP system, the install script verifies the Service Check Date with the license 2843 
check date of the version being installed. If the service check date is missing or the verification process 2844 
finds your license pre-dates the software’s release date, a line displays in the /var/log/liveinstall.log with 2845 
a note about the service check date verification, and the installation of the software may continue. 2846 

2.4.3.2.3 Reactivating a BIG-IP System License 2847 
F5 recommends reactivating the BIG-IP system license before conducting a software upgrade. 2848 

Follow these steps to reactivate a BIG-IP system license using the Configuration utility: 2849 

1. Navigate to System > License. 2850 
2. Click Re-activate. 2851 
3. In the Activation Method area, select Automatic (requires outbound connectivity). 2852 
4. Click Next. 2853 

2.4.3.2.4 Moving a BIG-IP VE license 2854 
BIG-IP VE licenses are permanently associated with the virtual instance. To move a license, contact F5 2855 
Technical Support for assistance. However, with BIG-IP 12.1.3.3 and BIG-IP 13.1 and later, you can move 2856 
the RegKey without contacting support by revoking the instance’s license from tmsh, the Configuration 2857 
utility, and iControl/REST by using the ‘tmsh revoke sys license’ command on that virtual instance. This 2858 
action revokes the license and unlocks the RegKey—enabling the user to activate a new virtual machine. 2859 
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Call F5 Technical Support for assistance if the connection is lost and you want to move the license to the 2860 
current VE, if hypervisor crashes, or if you can’t access the password or network address. 2861 

2.4.3.3 Backup and Data Recovery 2862 

BIG-IP software offers two supported methods for backing up and restoring the configuration: user 2863 
configuration set (UCS) archives and single configuration files. This guide focuses on using the UCS 2864 
archive only. To create, delete, upload, or download an archive, you must have either administrator or 2865 
resource administrator role privileges. 2866 

2.4.3.3.1 Backup Configuration Data to a UCS Archive 2867 
A UCS archive contains BIG-IP configuration data that can fully restore a BIG-IP system in the event of a 2868 
failure or return material authorization. 2869 

Each time you back up the configuration data, the BIG-IP system creates a new UCS archive file in the 2870 
/var/local/ucs directory. In addition to configuration data, each UCS file contains various configuration 2871 
files necessary for the BIG-IP system to operate correctly. 2872 

A UCS archive contains the following types of BIG-IP system configuration data: 2873 

 system-specific configuration files (traffic management elements, system and network 2874 
definitions, and others) 2875 

 product licenses 2876 

 user accounts and password information 2877 

 DNS 2878 

 zone files 2879 

 installed SSL keys and certificates 2880 

To easily identify the file, include the BIG-IP host name and current time stamp as part of the file name. 2881 

F5 recommends keeping a backup copy of the UCS archives on a secure remote server. To restore the  2882 
BIG-IP system if you can’t access the /var /loca/ucs directory on the BIG-IP system, upload the backup 2883 
file from the remote server, and use it to restore your system. 2884 

2.4.3.3.2 To create a UCS archive using the Configuration utility 2885 
When creating a new archive, unless otherwise directed, the BIG-IP system automatically stores it in  2886 
/var/local/ucs directory—a default location. You can create as many archives as you want, but each 2887 
archive must have a unique file name. 2888 

All boot locations on a BIG-IP system use the same /shared directory, making it a good choice for a UCS 2889 
save location. Saving an archive to the /shared directory allows you to boot to another boot location and 2890 
access the archive, and can greatly simplify the recovery from a variety of issues. 2891 
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1. Navigate to System > Archives. 2892 

2. Click Create.  2893 

3. Type a unique file name. 2894 

4. To encrypt the archive for Encryption, click Enabled. 2895 

5. To include private keys in the BIG-IP system, for Private Keys, click Include. If you choose to 2896 
include private keys, store the archive file in a secure environment. 2897 

6. Click Finished. 2898 

7. Click OK after the data is backed up and the file is created. 2899 

2.4.3.3.3 To download and copy an archive to another system using the Configuration utility 2900 
1. Navigate to System > Archives. 2901 

2. Click the UCS file name you want to download. 2902 

3. In Archive File, click Download <filename>.ucs. 2903 

4. Save the file. 2904 

5. Find the file in your computer’s Downloads folder and copy it. 2905 

2.4.3.3.4 Restoring Configuration Data from a UCS Archive 2906 
If the BIG-IP System configuration data becomes corrupted, you can restore the data from the archive 2907 
currently stored in the directory /var/local/ucs. 2908 

When restoring configuration data, F5 recommends running the same version of the BIG-IP software on 2909 
the BIG-IP system from which it was backed up. 2910 

F5 also recommends restoring a UCS file to another platform of the same model where the UCS file was 2911 
created. Certain core hardware changes can cause a UCS to load properly on dissimilar hardware, 2912 
requiring manual intervention to correct. 2913 

2.4.3.3.5 To restore a configuration in a UCS archive using the Configuration utility 2914 
1. Navigate to System > Archives. 2915 

2. Click the name of the UCS archive you want to restore. 2916 

3. To initiate the UCS archive restore process, click Restore. 2917 

When the restoration process is completed, examine the status page for any reported errors 2918 
before proceeding to the next step. 2919 

4. To return to the Archive List page, click OK. 2920 
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If you receive activation errors after restoring a UCS archive on a different device, you must reactivate 2921 
the BIG-IP system license. Restarting the system ensures that the configuration is fully loaded after 2922 
relicensing,  2923 

2.4.3.3.6 Downloading a UCS Archive to a Remote System 2924 
Downloading a copy of an existing archive to a remote system protects the configuration data should 2925 
you need to restore your BIG-IP system and be unable to access the /var/local/ucs directory on the BIG-2926 
IP system.  2927 

To download an existing archive, first display the properties of the archive to specify the complete path 2928 
name of the location where you want to save the archive copy. 2929 

1. Navigate to System > Archives. 2930 

2. Click the name of the archive that you want to view. 2931 

The General Properties for that archive display. 2932 

3. Click Download: <ucs filename>. 2933 

4. Click Save. 2934 

The BIG-IP system downloads a copy of the UCS file to the system from which you initiated the 2935 
download. 2936 

2.4.3.3.7 Uploading a UCS Archive from a Remote System 2937 
If a UCS archive on your BIG-IP system is unavailable or corrupted, upload a previously created archive 2938 
copy from a remote or backup system to replace it. 2939 

1. Navigate to System > Archives. 2940 

2. Click Upload. 2941 

3. Type the complete path and file name of the archive that you want to upload onto the BIG-IP 2942 
system. 2943 

If you do not know the path or file name, click Browse and navigate to the location. 2944 

4. Click Upload. 2945 

The specified archive uploads to the /var/local/ucs directory on the BIG-IP system. 2946 

2.4.3.3.8 Deleting a UCS Archive 2947 
Use the Configuration utility to delete any archive on the BIG-IP system that is stored in the directory 2948 
/var/ local/ucs. 2949 

1. Navigate to System > Archives. 2950 
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2. Select the check box next to the name of the file you want to delete. 2951 

3. Click Delete. 2952 

4. Click Delete again. 2953 

The archive is deleted from the /var/local/ucs directory on the BIG-IP system. 2954 

2.4.3.4  Log Files and Alerts 2955 

This section provides context for our recommended procedures in the form of overviews and 2956 
supplemental information, including the following topics: 2957 

• Config for Syslog 2958 

• Set up SMTP for email alerts 2959 

2.4.3.4.1 Managing Log files on a BIG-IP System 2960 
Log files track usage or troubleshoot issues—if left unmanaged, they can grow to an unwieldy size. The 2961 
BIG-IP system uses a utility called logrotate to manage local log files. The logrotate script deletes log files 2962 
older than the number of days specified by the Logrotate.LogAge database variable. By default, the 2963 
variable is set to eight. Therefore, the system is configured to delete archive copies that are older than 2964 
eight days. 2965 

To modify the Logrotate.LogAge database variable: 2966 

1. Log in to tmsh at the command line by typing the following command:  tmsh 2967 

2. Modify the age at which log files are eligible for deletion by using the following command 2968 
syntax:  modify /sys db logrotate.logage value <value 0 - 100> 2969 

3. Save the change by typing the following command:  save /sys config 2970 

2.4.3.4.2 Audit Logging 2971 
Audit logging is an optional way to log messages pertaining to configuration changes that users or 2972 
services make to the BIG-IP system configuration. Audit logging is also known as master control 2973 
program. 2974 

LOG FILES AND ALERTS—PROCEDURES 2975 

(MCP) Audit Logging. As an option, you set up audit logging for any tmsh commands that users type on 2976 
the command line. 2977 

For MCP and tmsh audit logging, select a log level. The log levels will not affect the severity of the log 2978 
messages but may affect the initiator of the audit event. 2979 
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2.4.3.5  Technical Support 2980 

In addition to Support Centers around the world, there are many technical resources available to 2981 
customers. 2982 

2.4.3.5.1 Phone Support 2983 
Open a Case at any of the Network Support Centers:  2984 

 1-888-882-7535 or (206) 272-6500 2985 

 International contact numbers: http://www.f5.com/training-support/customer-2986 
support/contact/  2987 

2.4.3.5.2 AskF5 - Web Support 2988 
F5 self-support portal: http://www.askf5.com 2989 

2.4.3.5.3 DevCentral - F5 User Community 2990 
More than 360,000 members—including F5 engineering resources—are actively contributing, sharing 2991 
and assisting our peers. 2992 

http://devcentral.f5.com 2993 

2.4.3.5.4 BIG-IP iHealth 2994 
BIG-IP iHealth comprises BIG-IP iHealth Diagnostics and BIG-IP iHealth Viewer. BIG-IP iHealth Diagnostics 2995 
identifies common configuration problems and known software issues. It also provides solutions and 2996 
links to more information. With BIG-IP iHealth Viewer, you can see the status of your system at-a-glance, 2997 
drill down for details, and view your network configuration. 2998 

https://ihealth.f5.com/ 2999 

2.4.3.5.5 Subscribing to TechNews 3000 
AskF5 Publications Preference Center provides email publications to help keep administrators up-to-3001 
date on various F5 updates and other offerings: 3002 

 TechNews Weekly eNewsletter Up-to-date information about product and hotfix releases, new 3003 
and updated articles, and new feature notices. 3004 

 TechNews Notifications Do you want to get release information, but not a weekly eNewsletter? 3005 
Sign up to get an HTML notification email any time F5 releases a product or hotfix. 3006 

 Security Alerts Receive timely security updates and ASM attack signature updates from F5. 3007 

To subscribe to these updates: 3008 

1. Go to the Communications Preference Center (https://interact.f5.com/F5-Preference-3009 
Center.html).  3010 

http://www.f5.com/training-support/customer-support/contact/
http://www.f5.com/training-support/customer-support/contact/
http://www.askf5.com/
http://devcentral.f5.com/
https://ihealth.f5.com/
https://interact.f5.com/F5-Preference-Center.html
https://interact.f5.com/F5-Preference-Center.html
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2. Under My preferences click Show. 3011 

3. Select the updates you want to receive. 3012 

4. Click Submit. 3013 

2.4.3.5.6 AskF5 recent additions and updates 3014 
You can subscribe to F5 RSS feeds to stay informed about new documents pertaining to your installed 3015 
products or products of interest. The Recent additions and updates page on AskF5 provides an overview 3016 
of all the documents recently added to AskF5. 3017 

New and updated articles are published over RSS. You can configure feeds that pertain to specific 3018 
products, product versions, and/or document sets. You can also aggregate multiple feeds into your RSS 3019 
reader to display one unified list of all selected document. 3020 

2.5 Symantec SSL Visibility Appliance  3021 

The Symantec SSL Visibility appliance is a high-performance transparent proxy for SSL network 3022 
communications. It enables a variety of applications to access the plaintext (that is, the original 3023 
unencrypted data) in SSL encrypted connections, and is designed for security and network appliance 3024 
manufacturers, enterprise IT organizations, and system integrators. Without compromising any aspect 3025 
of enterprise policies or government compliance, the SSL Visibility appliance permits network appliances 3026 
to deploy with highly granular flow analysis while maintaining line rate performance. 3027 

2.5.1 Day-0: Install and Standard Configuration 3028 

2.5.1.1 Prerequisites 3029 

 120V or 220V Power Source 3030 

 computer with browser access to activate license and configure appliance 3031 

 putty or a terminal emulator 3032 

 four-post equipment rack with a depth of 27.75” to 37.00” with square mounting holes 3033 

 category 5E network cables or better (Category 6 or 6A) 3034 

 license key for SSL Visibility appliance 3035 

 MySymantec account 3036 

 DNS Server 3037 

 SSL VISIBILITY running version 3.X 3038 
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2.5.1.2 Unpacking the Appliance 3039 

Before racking and configuring the SSL Visibility Appliance, ensure the following contents are included in 3040 
the SSL Visibility shipping package: 3041 

 3042 

2.5.1.3 Rack-Mount the Appliance 3043 

The list below shows the requirements to install the SSL Visibility Appliance. 3044 

 At least 1U rack space (deep enough for a 27” device)–power and management ports at rear 3045 

 Phillips (cross head) screwdriver 3046 

 Weight Capacity: 28lb (12.7kg) 3047 

 Dimensions: 17.5” (W) x 19.5” (D) x 1.75” (H) (444.5mm x495.3mm x 44.5mm) 3048 

 Two available power outlets (110 VAC or 220-240 VAC) 3049 

 Two IEC-320 power cords (normal server/PC power cords) should the supplied power cords not 3050 
be suitable for your environment 3051 

 Cooling for an appliance with two 450W power supply units 3052 

To see detailed instructions for installing the SSL Visibility in a rack, please refer to Symantec’s Quick 3053 
Start guide located at the below link: 3054 

https://symwisedownload.symantec.com//resources/sites/SYMWISE/content/live/DOCUMENTATION/13055 
0000/DOC10294/en_US/SSL 3056 
VISIBILITY_Quick_Start_Guide.pdf?__gda__=1556050986_e4bd9c26d33192a730d884f8137ce9e6 3057 

2.5.1.4 Connect Cables 3058 

To connect the appliance’s cables: 3059 

https://symwisedownload.symantec.com/resources/sites/SYMWISE/content/live/DOCUMENTATION/10000/DOC10294/en_US/SSLV_Quick_Start_Guide.pdf?__gda__=1556050986_e4bd9c26d33192a730d884f8137ce9e6
https://symwisedownload.symantec.com/resources/sites/SYMWISE/content/live/DOCUMENTATION/10000/DOC10294/en_US/SSLV_Quick_Start_Guide.pdf?__gda__=1556050986_e4bd9c26d33192a730d884f8137ce9e6
https://symwisedownload.symantec.com/resources/sites/SYMWISE/content/live/DOCUMENTATION/10000/DOC10294/en_US/SSLV_Quick_Start_Guide.pdf?__gda__=1556050986_e4bd9c26d33192a730d884f8137ce9e6
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1. Connect a network cable between the Management Ethernet 1 port, on the rear of the SSL 3060 
VISIBILITY appliance, and Datacenter Secure network.  3061 

Warning: When deploying the SV1800, SV2800, and SV3800 appliances, do not connect 3062 
to the Management Ethernet 2 port. This port is not functional. 3063 

2. Connect the two AC power cords to the appliance’s AC power inlets on the rear panel. Two 3064 
power supplies are provided for redundant operation. 3065 

3. Connect the other ends of the power cords to a 120V or 220V power source. 3066 

2.5.1.5 Power on the Appliance and Verify LEDs 3067 

1. Confirm the appliance’s power cord or power cords are securely connected to a 120V or 220V 3068 
power source. 3069 

2. Power on the appliance by pressing its front-panel power button. 3070 

 3071 
3. As the appliance boots verify the following: 3072 

o The LCD displays startup messages while the appliance boots (Appliance Startup, 3073 
Validating Firmware, Appliance Boot, etc.). 3074 

o The System Status indicator for the SV1800 changes from red to off. 3075 

o The LEDs for the Management Ethernet port (connected to a management workstation) 3076 
light up. 3077 

o When the boot process is complete, the LCD displays the appliance’s model, software 3078 
version, and the Up/Down arrows. 3079 

2.5.1.6 Initial Appliance Configuration 3080 

1. To perform initial configuration of the SSL Visibility Appliance, connect a serial cable to the DB9 3081 
Serial port on the rear of the Appliance. 3082 
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 3083 
2. On the management laptop, open up the Putty Application and select a Connection type of 3084 

Serial with a Speed of 115200. 3085 

 3086 
 

3. Navigate to the Serial Category on the bottom left side of the window. 3087 
4. Configure the serial connection to support the SSL Visibility Appliance’s console speeds by 3088 

selecting the following options: 3089 

o Speed (baud): 115200 3090 

o Data bits: 8 3091 

o Stop bits: 1 3092 
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o Parity: None 3093 

o Flow Control: None 3094 

 3095 
5. Login into the appliance by using the default credentials of: 3096 

o Username: bootstrap 3097 

o Password: bootstrap 3098 

 3099 
6. Next, create the master key by running the command: 3100 

 master key create 3101 
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 3102 
7. Create a new user by running the command: 3103 

 user add admin manage-pki manage-appliance manage-policy audit 3104 

 3105 
Tip: This step created a single admin user account with all four roles allocated to it. The only 3106 
requirements for completing the bootstrap phase are that there is a user account with the 3107 
Manage Appliance role and a user account with the Manage PKI role. These may be the same or 3108 
different accounts. In most cases, creating a single account with all four roles is the simplest 3109 
approach. 3110 

8. Run the following command to configure the management network interface with a static IP 3111 
address:  3112 
network set ip 192.168.1.95 netmask 255.255.255.0 gateway 192.68.1.1 3113 

9. Reboot the system for the changes to take effect (confirm that you wish to reboot) with the 3114 
following command: platform reboot 3115 
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 3116 
10. On reboot, confirm that the “SSL Visibility startup stage 3: CONFIRMED” is displayed as shown 3117 

below. 3118 

 3119 
11. Confirm you can log in to the appliance via your browser. Log in via a web browser, using the 3120 

format https://192.168.1.95. Log in with the username and password you created. 3121 
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 3122 
 

2.5.1.7 Date and Time (NTP) 3123 

1. To configure Date and Time, login into the WebUI by browsing to https://192.168.1.95.  3124 
2. Navigate to localhost > Date/Time. 3125 

 3126 
 

3. Click on the Add button  under NTP Servers.  3127 
4. In the server field type time.nist.gov and click OK. 3128 
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 3129 
5. Click Apply Changes to save the new NTP server. 3130 

2.5.1.8 Additional Configuration 3131 

To add a host name and DNS for the SSL Visibility Appliance, perform the following steps: 3132 

1. Log in to the SSL Visibility by opening a web browser and navigating to https://192.168.1.95. 3133 
2. From the Dashboard page navigate to localhost > Management Network. 3134 

 3135 
 

3. Click the Edit button  under the Management Network Field. 3136 
4. Enter the following information into the fields: 3137 

• MTU: 1500 3138 
• Host Name: SSL Visibility.int-nccoe.org 3139 
• Primary Nameserver: 192.168.1.6 3140 

 3141 
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5. Click Apply Changes. 3142 
6. Click Reboot to restart the system and apply changes (required). 3143 

2.5.1.9 MySymantec Account Creation 3144 

1. To create a MySymantec Account, navigate to the following link: 3145 
https://login.symantec.com/sso/idp/SAML2 3146 

2. Click the Create an Account tab. 3147 

 3148 
3. Enter the requested information and click Create Account. 3149 

2.5.1.10  License the SSL Visibility Appliance 3150 

2.5.1.10.1 Download a Blue Coat License 3151 
1.  Using your BlueTouch Online account, log in to the Blue Coat Licensing Portal. 3152 

(https://services.bluecoat.com/eservice_enu/licensing/register.cgi).  3153 

2. From the menu on the left side, select SSL Visibility, then select License Download. 3154 

3. When prompted, enter the serial number of your appliance, then press Submit. 3155 

4. Once the license is generated, press Download License File for the required SSL Visibility 3156 
Appliance. 3157 

https://login.symantec.com/sso/idp/SAML2
https://services.bluecoat.com/eservice_enu/licensing/register.cgi
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2.5.1.10.2 Install a Blue Coat License 3158 
1. Select SSL Visibility.int-nccoe.org > License. 3159 

 3160 

2. Click the Add button  in the License field. 3161 

3. On the Upload File tab, use the Choose File button to browse to the license file location. 3162 

 3163 

4. Click Add. You will see a confirmation message and the specific appliance platform model. The license 3164 
is now installed, and all standard SSL Visibility Appliance features are operational. 3165 

2.5.2 Day 1: Product Integration Configuration 3166 

2.5.2.1 Prerequisites 3167 

1. Install version 3.x on the SSL Visibility Appliance. 3168 
2. Complete initial configuration as outlined in the Day 0 Section 2.5.1 above. 3169 
3. Required Ports, Protocols and Services: 3170 

SSL Visibility 3.x uses the following ports while operating—allow these ports when setting up SSL 3171 
Visibility: 3172 
Inbound Connection to SSL Visibility Appliance 3173 
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 3174 
Outbound Connections from SSL Visibility Appliance 3175 
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   3176 

 3177 
*Common Values For this Port 3178 

Required URLs 3179 

Ensure connectivity from SSL Visibility to the following URLs: 3180 
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 3181 

2.5.2.2 Venafi Integration 3182 

Venafi TPP was used to copy known server key and certificates to the SSL Visibility appliance for TLS 3183 
decryption. 3184 

For information on integration with Venafi TPP, see Section: 2.6.13.9. 3185 

2.5.2.3 Ruleset Creation 3186 

To ensure your SSL Visibility Appliance is connected and configured properly, create a basic ruleset to 3187 
test that traffic isn't getting blocked. To perform this test, create a ruleset with a Catch All Action of Cut 3188 
Through. 3189 

Note: At least one rule must be added to the ruleset for SSL Visibility Appliance to start processing SSL 3190 
traffic. 3191 

1. Select Policies > Rulesets. 3192 

               3193 

2. In the Rulesets panel, click the Add icon. 3194 

3. In the Add Ruleset window, enter a name for the ruleset and click OK. 3195 
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               3196 

4. In the Ruleset Options panel, click the Edit icon. 3197 

 3198 

5. Confirm the Catch All Action is Cut Through. 3199 

6. Apply the Policy Changes. 3200 

2.5.2.4 Segment Creation 3201 

Note: Before creating the segment, determine your deployment mode and create a ruleset for the 3202 
segment.  3203 

The following pictures demonstrate various passive tap deployment types: 3204 

(i).     (ii).      (iii).  3205 

For purpose of this document we used (i).  3206 

Note: The latter two tap modes combine traffic from two or three network taps onto a single SSL 3207 
Visibility Appliance segment. These ports are called aggregation ports. 3208 
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2.5.2.4.1 Add a Segment 3209 
1. Select Policies > Segments. 3210 

               3211 

2. Click the Add icon in the Segments field. 3212 

3. Click Edit to select the Mode of Operation. 3213 

4. For Mode of Operation, choose  Passive Tap mode. 3214 

5. Click OK. 3215 

6. Select the Ruleset you previously created. 3216 

7. Choose the desired Session Log Mode. 3217 

8. Enter a brief description of the segment in the Comments box. 3218 

9. Click OK. The new segment appears in the Segments panel. 3219 

10. Apply the Policy Changes. 3220 

2.5.2.4.2 Activate a Segment 3221 
1. Select Policies > Segments. 3222 

               3223 

2. In the Segments panel, select the segment to activate. 3224 

3. Click the Activate  icon. The Segment Activation window displays. 3225 

Note: During segment activation, a series of screens appear that allow you to select the ports 3226 
the segment will use, and any copy ports and modes where the copy ports will operate. Connect 3227 
any copy ports to your passive security devices (for example, Symantec DLP Network Monitor, 3228 
Security Analytics, or an IDS). 3229 
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4. Follow the prompts. Once the segment is active, the system dashboard displays a green 3230 
background for the segment, and there are entries under Main Interfaces and Copy Interfaces (if 3231 
applicable to your deployment). 3232 

5. Apply the Policy Changes. 3233 

2.5.2.5 Verification 3234 

This section walks through verifying that the SSL Visibility is seeing SSL traffic without blocking it (cut 3235 
through). 3236 

1. To see a list of recent SSL sessions, select Monitor > SSL Session Log. 3237 

2. Look for the domains of the servers that were accessed, and observe the value in the Action 3238 
column. Since the initial rule you created cuts through all traffic, the Action should say Cut 3239 
Through for all sessions. 3240 

 3241 

2.5.2.5.1 Create a Rule to Test Decryption 3242 
To test the SSL Visibility Appliance is decrypting SSL traffic, add a rule that decrypts everything from 3243 
a specific source IP (e.g., your laptop). 3244 

Note: At least one rule must be added to the ruleset for SSL Visibility Appliance to start processing 3245 
SSL traffic. 3246 

1. Select Policies > Rulesets. 3247 

 3248 

2. In the Rulesets panel, select the ruleset that was previously created. 3249 
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3. In the Rules panel, click the Insert  icon to add a new rule. The Insert Rule dialog displays. 3250 

4. For Action, select Decrypt (Certificate and Key Known). 3251 

5. Select one of the following: 3252 

o If you imported one certificate, select Known Certificate with Key, and choose the 3253 
certificate you imported. 3254 

o If you imported multiple certificates, select Known Certificates with Keys and All Known 3255 
Certificates with Keys. 3256 

6. For Source IP, enter the IP address of your computer. 3257 

7. Click OK. 3258 

8. Apply the Policy Changes. 3259 

9. Next Step: Use the SSL Session Log to verify that the SSL Visibility Appliance is decrypting 3260 
properly.  3261 

2.5.2.5.2 Verify Decryption 3262 
View the SSL Session log to test, and verify the SSL Visibility Appliance is decrypting traffic according 3263 
to the rules you created. 3264 

1. Access a variety of websites or internal SSL servers. If you have created policies for specific host 3265 
categories, domains, IP addresses, etc., visit websites that test these policies. 3266 

2. To see a list of recent SSL sessions, select Monitor > SSL Session Log. 3267 
3. Look for the domains of the websites/servers you visited, and observe the value in the Action 3268 

column. Is the value you expected listed? For example, if you wanted the SSL Visibility Appliance 3269 
not to decrypt a particular type of traffic, does the Action say Cut Through? For sessions 3270 
designated as decrypted, does the Action say Decrypt? If unexpected values appear, review your 3271 
policies. 3272 

Note: When a session is decrypted, the Action column will show either Resign Certificate (if the 3273 
deployment is using the certificate resigning method) or Certificate and Key Known (if you have 3274 
imported known certificates and keys). 3275 



NIST SP 1800-16D: Securing Web Transactions: TLS Server Certificate Management 149 

 

2.5.2.5.3 Other Ways to Learn About this Deployment Method  3276 
  Download a PDF (https://origin-symwisedownload.symantec.com/resources/webguides/SSL 3277 
Visibility/SSL Visibilitya_first_steps/Content/PDFs/Deployment6.pdf) 3278 

View a video tutorial (https://www.youtube.com/watch?v=qxSDDXhE_B8&feature=youtu.be) 3279 

2.5.3 Day N: Ongoing Security Management and Maintenance 3280 

2.5.3.1 Alerting & Monitoring 3281 

2.5.3.1.1 Alerts 3282 
Use the Alerts panels to configure the email details the system will use to send out alerts, monitor 3283 
events, and assess the conditions where an alert is generated. Click Edit to bring up the upper Edit Alert 3284 
Mail Configuration window to construct details of the email system.  3285 

2.5.3.1.2 SNMP Support 3286 
The SSL Visibility Appliance supports the more secure SNMP version 3, which maintains authentication 3287 
and encryption for SNMP monitoring. Symantec recommends disabling SNMP versions 1 and 2c, and  3288 
the default options of using AES for encryption, and SHA for authentication for SNMP version 3.  3289 

For more details, see the SSL Visibility Appliance 3.x Administration & Deployment Guide 3290 
https://symwisedownload.symantec.com//resources/sites/SYMWISE/content/live/DOCUMENTATION/13291 
1000/DOC11119/en_US/SSL 3292 
VISIBILITY_Admin_31231.pdf?__gda__=1556286966_fb942bb8532ca7c1a67d0e2720faa76d 3293 

2.5.3.1.3 Logging Options 3294 
Use Platform Management (SSL Visibility-int.nccoe.org) > Logging Options to enable or disable WebUI 3295 
TLS logging and to configure remote syslog servers.  3296 

Use Logging Options to include Web UI TLS trusted channel establishment and termination logs in the 3297 
System Log. These events are not included in the System Log by default. 3298 

https://origin-symwisedownload.symantec.com/resources/webguides/sslv/sslva_first_steps/Content/PDFs/Deployment6.pdf
https://origin-symwisedownload.symantec.com/resources/webguides/sslv/sslva_first_steps/Content/PDFs/Deployment6.pdf
https://www.youtube.com/watch?v=qxSDDXhE_B8&feature=youtu.be
https://symwisedownload.symantec.com/resources/sites/SYMWISE/content/live/DOCUMENTATION/11000/DOC11119/en_US/SSLV_Admin_31231.pdf?__gda__=1556286966_fb942bb8532ca7c1a67d0e2720faa76d
https://symwisedownload.symantec.com/resources/sites/SYMWISE/content/live/DOCUMENTATION/11000/DOC11119/en_US/SSLV_Admin_31231.pdf?__gda__=1556286966_fb942bb8532ca7c1a67d0e2720faa76d
https://symwisedownload.symantec.com/resources/sites/SYMWISE/content/live/DOCUMENTATION/11000/DOC11119/en_US/SSLV_Admin_31231.pdf?__gda__=1556286966_fb942bb8532ca7c1a67d0e2720faa76d
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2.5.3.2 Software Update 3299 

Use the Update menu item to load and apply a file that will update the system software. Update files 3300 
are digitally signed and checked before being applied to the system. An invalid update file will not be 3301 
applied. 3302 

 3303 

Click Choose File to open a window where you browse the system and select the update file to use. Click 3304 
OK, and the file is checked; if valid, it is copied to the system and applied. 3305 

2.6 Venafi Trust Protection Platform (TPP) 3306 

2.6.1 Prerequisites  3307 

Venafi TPP requires the following in order to be installed: 3308 

 Windows Server 3309 

 Microsoft SQL Server Database 3310 

 Hardware Security Module (if one will be used) 3311 

 Microsoft .NET Framework 3312 

2.6.2 Installation  3313 

We installed Venafi TPP on Microsoft Windows Server 2012. Before starting the Venafi TPP installation, 3314 
make sure you have configured your database and HSM.  3315 

The installation can be automated via a configuration file or manually performed with an installation 3316 
wizard. The automated installation configuration file for installation into the production environment is 3317 
typically created based on the Venafi TPP deployment in the DEV testing environment and placed in the 3318 
user acceptance environment to formally test it. We recommend using the automated installation to 3319 
reduce the possibility of errors during the installation into the production environment. 3320 

Because we were only configuring a single server in our lab environment, we manually installed and 3321 
configured the product using the wizard. To install the Venafi TPP binaries and supporting files using the 3322 
wizard, follow steps 1-7 in the Venafi Trust Protection Platform Installation Guide chapter titled 3323 
“Installing using the Venafi Configuration Console wizard.” 3324 
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Following step 7, the Venafi Configuration Console is automatically launched and is explained in steps 8-3325 
22 where specific integrations with the HSM and database are performed. We performed the following 3326 
steps in our implementation: 3327 

1. At the prompt for first time or existing installation, select “first-time installation.”  3328 

 3329 
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2. The Venafi Certificate Manager manages TLS server certificates, so it was selected. The Mobile 3330 
Certificate and SSH Key Managers were not enabled. 3331 

 3332 
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3. We recommend using an HSM with Venafi TPP to protect the symmetric key that encrypts 3333 
private keys and credentials in the Venafi TPP database. In our implementation, we integrated 3334 
with the SafeNet AT HSM. We entered the following configuration:  3335 

 3336 



NIST SP 1800-16D: Securing Web Transactions: TLS Server Certificate Management 154 

4. Windows authentication was used to authenticate to Microsoft SQL Server from Venafi TPP. 3337 
Windows authentication is recommended, because it consolidates user account management, 3338 
including control of password rules, failed logins, etc. 3339 

 3340 
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5. The initial Master Administrator account username was set to “admin,” and the password was 3341 
also set.  3342 

 3343 

6. The Venafi TPP server was configured to process logs, as it was the only server in the 3344 
environment.  3345 

 3346 
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7. The organization name was set to “NCCoE”; the environment was set to “Test.” 3347 

 3348 

8. The collection of usage statistics was enabled.  3349 

 3350 
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9. The default log file location was used.  3351 

 3352 

10. The Finish button was selected, and the configuration of the Venafi TPP server was completed 3353 
successfully.  3354 

 3355 
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2.6.3 CA Integration  3356 

In our implementation, we integrated Venafi TPP with two CAs: DigiCert was used for publicly trusted 3357 
certificates, and Active Directory Certificate Services for internally trusted certificates. 3358 

2.6.3.1 DigiCert 3359 

To configure integration with DigiCert so that Venafi TPP can automatically enroll for and retrieve 3360 
certificates, follow the instructions in the “DigiCert CertCentral” section of the Venafi Trust Protection 3361 
Platform Certificate Authority and Hosting Platform Integration Guide. 3362 

In our implementation, we used DigiCert Multi-SAN SSL certificates. The following configuration was 3363 
used: 3364 

 3365 

2.6.3.2 Active Directory Certificate Services 3366 

We used Microsoft ADCS to issue certificates to TLS servers inside the lab firewall. To configure 3367 
integration with ADCS so Venafi can automatically enroll for and retrieve certificates, follow the 3368 
instructions in the “Microsoft Active Directory Certificate Services (ADCS) - Enterprise and Standalone—3369 
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CA template configuration” section of the Venafi Trust Protection Platform Certificate Authority and 3370 
Hosting Platform Integration Guide. 3371 

In our implementation, we configured the host name, service name, and credential information in 3372 
Venafi TPP to access the ADCS Issuing CA: 3373 

 3374 

In our implementation, a certificate template named “VenafiRSAWebServer” was configured in ADCS to 3375 
issue TLS server certificates. The CA template object we used in Venafi TPP to request certificates 3376 
pointed to this template in ADCS and had the following configuration: 3377 

 3378 

We recommend enabling “Subject Alt Name Enabled” and “Automatically include CN as DNS SAN,” as 3379 
SANs in lieu of using CNs. Including a CN and SAN in certificates ensures backward compatibility with 3380 
older clients that only support CNs and compatibility with newer clients that require SANs. 3381 

2.6.4 Folder Creation  3382 

To create a folder hierarchy for organizing certificate, application, and device objects, refer to the 3383 
section titled “Managing your policies (folders)” in the Venafi Trust Protection Platform Administration 3384 
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Guide. The following folder structure was created in our implementation of Venafi TPP to match the 3385 
three ficticious departments of certifciate owners in the lab: 3386 

 3387 

2.6.5 Custom Fields  3388 

Follow the instructions in the section titled “Working with Custom Fields” in the Venafi Trust Protection 3389 
Platform Administration Guide to define additional metadata fields for certificates and other objects. 3390 
Two custom fields were defined in our Venafi TPP implementation: Biz Owner and Cost Center.  3391 

We configured the Biz Owner custom field with a field type of “Identity” to allow the selection of user 3392 
identities in AD. 3393 

The Cost Center custom field was configured with a “String” field type, including a regex to validate that 3394 
the cost centers that were entered matched the pattern of two letters, one dash, and four numbers. 3395 



NIST SP 1800-16D: Securing Web Transactions: TLS Server Certificate Management 161 

(e.g., AB-1234). A custom error message displays if a cost center doesn’t match the regex pattern 3396 
entered by a user. 3397 

 3398 

2.6.6 Assigning Certificate Owners  3399 

The assignment of certificate owners was done with AD groups Venafi TPP folders in our 3400 
implementation, to ensure new certificates automatically had the correct owner assigned. The AD 3401 
groups were created to represent the certificate owners in the four fictitious departments in our 3402 
implementation. These groups were assigned as contacts and granted permissions at the folder level. 3403 

2.6.6.1 Contacts 3404 

For information about assigning Contacts to folders in Venafi TPP, refer to the section titled “General 3405 
configuration options” in the Venafi Trust Protection Platform Administration Guide. Each certificate 3406 
owner AD group was assigned as a contact to their respective Venafi TPP folder, so  they would receive 3407 
notifications (e.g., impending expirations, errors, etc.). 3408 

 3409 
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2.6.6.2 Permissions 3410 

For instructions on assigning permissions in Venafi TPP, refer to the section titled “Assigning permissions 3411 
to objects in Aperture” in the Venafi Trust Protection Platform Administration Guide. In our 3412 
implementation, we assigned each group representing a certificate owner View, Read, Write, Create, 3413 
Delete, Rename, Associate, and Revoke.  3414 

For example, the DATAC-GRP was assigned the following privileges to the C-Datacenter folder in our 3415 
implementation of Venafi TPP. 3416 

 3417 

2.6.7 Setting Policies  3418 

For information about defining policies on folders in Venafi TPP, refer to the chapter titled “Using 3419 
policies to manage encryption assets” in the Venafi Trust Protection Platform Administration Guide.  3420 

In our Venafi TPP implementation, the following policies were set: 3421 

 The Organization, City/Locality, State/Province, and Country fields within Subject DNs were 3422 
locked on a top-level folder, so that those values were required in certificates across all groups. 3423 
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 3424 

 Specific domains were whitelisted. See the Domain Whitelisting section 2.6.8 of this document 3425 
for more information. 3426 

 Approvers were assigned and locked at the folder level. See the “Workflow – RA Reviews” 3427 
Section 2.6.9 of this document for more information. 3428 

 The key length was set to 2048 on the Certificate Management folder and locked. 3429 

 3430 

 The following policies for certificate authorities were configured: 3431 

• The internal Issuing CA was enforced on the following folders to ensure only internally 3432 
issued certificates could be used: 3433 

o DMZI 3434 

o Datacenter 3435 

o Datacenter Secure 3436 

 3437 



NIST SP 1800-16D: Securing Web Transactions: TLS Server Certificate Management 164 

o The publicly trusted DigiCert Mulit-SAN CA was enforced on the DMZE folder to ensure 3438 
only publicly trusted EV certificates could be provisioned to the public facing interfaces 3439 
of the F5 LTM. 3440 

 3441 

2.6.8 Domain Whitelisting  3442 

To limit security exposure, control the domains for which certificates can be issued. For instructions on 3443 
configuring the domains for which certificates can be requested in Venafi TPP (domain whitelisting), 3444 
refer to the section titled “To configure certificate policy on a folder” in the Venafi Trust Protection 3445 
Platform Certificate Management Guide. 3446 

In our implementation, we allowed two internal domains (int-nccoe.org and ext-nccoe.org) for all 3447 
folders that contained internal resources in Venafi TPP. 3448 

 3449 

In the DMZE folder containing all the external resources, we also allowed the externally accessible 3450 
domain (tls.nccoe.org). 3451 

 3452 
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2.6.9  Workflow – RA Reviews  3453 

For instructions on configuring workflow gates in Venafi TPP, refer to the section titled “Creating a 3454 
certificate workflow” in the Venafi Trust Protection Platform Certificate Management Guide. In our 3455 
implementation, we established a workflow gate for the Datacenter Secure zone. To do so, perform the 3456 
following steps: 3457 

1. Create a workflow object. Assign the stage to “0.” Select “Approver assigned to object” for 3458 
Request Approval From. 3459 

 3460 
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2. Assign the workflow to the Datacenter Secure folder policy. 3461 

 3462 

3. Assign the appropriate AD group (datacs_apprvr) to the Approver(s) for certificates on the 3463 
Datacenter Secure folder. 3464 

 3465 

2.6.10  CA Import  3466 

Once folder structure, policies, certificate owners, and other configurations are completed, begin 3467 
building the inventory of certificates—start by importing certificates from the ADCS-issuing CA.  3468 

For instructions on configuring imports from ADCS, refer to the chapter titled “Importing certificates 3469 
from a certificate authority” in Venafi Trust Protection Platform Administration Guide.  3470 
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In our implementation, we configured Venafi TPP to import certificates from a particular ADCS template 3471 
named, “WebBulkCertTemplate.” We included expired—not revoked—certificates. We chose not to 3472 
define any placement rules and placed all certificates into a single folder named ADCS Import. 3473 

 3474 

A total of 523 certificates were imported from the ADCS issuing CA. 3475 
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2.6.11 Network Discovery 3476 

It’s possible to accomplish network discovery scanning for TLS server certificates in several ways, 3477 
including using existing vulnerability assessment tools or the certificate management solution. In our 3478 
implementation, we used Venafi TPP to perform network discovery scans using two different methods: 3479 
scanning using Venafi TPP servers and the Scanafi utility.  3480 

Venafi TPP Server 3481 

In our implementation, we used Venafi TPP servers to perform network discovery scans in the 3482 
Datacenter and Datacenter-Secure network zones. For instructions on performing network discoveries 3483 
with Venafi TPP servers, see the chapter titled “Discovering certificates and keys” in the Venafi Trust 3484 
Protection Platform Certificate Management Guide. 3485 

2.6.11.1 Scanafi 3486 

For information on using Scanafi to perform network discovery scans, refer to the section titled 3487 
“Automatically calling Discovery/Import from Scanafi” in Venafi Trust Protection Platform Web SDK 3488 
Developer’s Guide.  3489 

In our implementation, we installed Scanafi on a Fedora Linux system in the DMZ network zone. The 3490 
following command was used to execute a network discovery scan. 3491 

./scanafi_linux_x64 --tppurl=https://venafi1.int-nccoe.org \ 3492 
--tppuser=vscanuser --tpppass=******** --range=192.168.4.0/23 \ 3493 
--zone="\\VED\\Policy\\Certificate Management\\UNKNOWN ORIGIN" \ 3494 
--certsonly 3495 

2.6.12  Identify Certificate Risks/Vulnerabilities  3496 

Following the import of certificates from the ADCS-issuing CA and the network discovery scans, we used 3497 
the Venafi TPP dashboard to identify certificate risks and vulnerabilities. The following shows the 3498 
dashboard micro-widgets for our implementation. 3499 

 3500 
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We used this information to identify certificates not compliant with policy (e.g., certificates issued by 3501 
unapproved CAs or with weak lengths), so they could be replaced. 3502 

The dashboard was also used to identify outage risks related to certificate expirations. The following 3503 
figure displays the Expiration widget of the dashboard that shows the expiration profile for certificates 3504 
in our implementation.  3505 

Figure 2-2 Venafi Dashboard Expiration Widget showing the Certificate Expiration Profile 3506 

  3507 

2.6.13  Automate Management  3508 

2.6.13.1  F5 BIG-IP LTM  3509 

2.6.13.1.1 Discover Existing F5 Certificates and Manage 3510 
Venafi TPP can automatically discover existing certificates and configuration through its Onboard 3511 
Discovery feature. Because most organizations have F5 systems with existing certificates installed, this is 3512 
a common process for F5 systems we used in our implementation, which included the following steps: 3513 

1. Create an Onboard discovery job to discover certificates on F5 systems. For instructions on how 3514 
to create Onboard Discovery jobs, refer to the section titled “Using Onboard Discovery” in the 3515 
Venafi Trust Protection Platform Certificate Management Guide. 3516 

2. Create a device object in Venafi TPP with the address and credentials for the F5 device on which 3517 
you want to discover and manage certificates. 3518 

 3519 
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3. Run the F5 Onboard Discovery job by clicking Run Now. 3520 

 3521 

4. Ensure the discovered certificate(s) are set to automatically renew when they are nearing 3522 
expiration. 3523 

 

5. With this discovered configuration, including the certificate, Venafi TPP was set to automatically 3524 
replace the existing certificate with a new certificate prior to expiration. 3525 

2.6.13.1.2 Install a New Certificate on F5 3526 
In our implementation, Venafi TPP was used to enroll for and install a new certificate on the F5 LTM in 3527 
the DMZ. The following steps were used to perform these operations: 3528 

1. Create a new certificate object in the Venafi TPP Aperture console. 3529 

 

2.  Select the appropriate folder. 3530 

 

3. Select a name for the certificate. 3531 
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4. Select the “Provisioning” Management Type to configure the certificate for automated 3532 
management. 3533 

 

5. Enter the CN for the certificate. 3534 

 

6. Enter the SANs for the certificate. 3535 

 

7. Configure the certificate for automatic renewal and installation when it is nearing expiration. 3536 

 

8. Add a new installation for the certificate, and indicate that management will be automated for 3537 
that installation. 3538 

 3539 

9. Select the F5 device where the certificate will be installed. 3540 

 3541 

10. Indicate that the Installation Type is “F5 BIG-IP Local Traffic Manager.” 3542 

 3543 
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11. The certificate we were installing was not for securing the administrative interface to the F5 3544 
LTM, therefore, we selected “No” for the Device Certificate. 3545 

 3546 

12. We indicated that Venafi TPP should update the profile when the new certificate was installed. 3547 
This ensures the configuration was properly set up to use the new certificate. 3548 

 3549 

13. We instructed Venafi TPP to install the CA certificates with the new certificate—enabling clients 3550 
connecting to the F5 to validate the certificate signature with the chain. 3551 

 3552 

14. We chose to have Venafi TPP bundle the CA certificates with the new certificate (in the same file 3553 
on the F5 device). 3554 

 3555 

15. An HSM was not installed on the F5 device we were using, so we indicated this to Venafi TPP. 3556 

 3557 

16. We instructed Venafi TPP to overwrite the existing certificate each time it installed a new 3558 
certificate (prior to expiration). 3559 

 3560 

17. We instructed Venafi TPP to delete the existing certificate when the new certificate was 3561 
installed. 3562 

 3563 



NIST SP 1800-16D: Securing Web Transactions: TLS Server Certificate Management 173 

18. To ensure the certificate was associated with the correct SSL profile on the F5 LTM, we 3564 
configured the following: 3565 

 3566 

19. We provided Venafi TPP information about the virtual server where the certificate should be 3567 
associated. 3568 

 3569 

20. We indicated to Venafi TPP that we did not use mutual authentication or other advanced 3570 
features on the F5 LTM. 3571 

 3572 

21. After configuring these settings, we clicked Save. 3573 

 3574 

22. Click Renew Now on the certificate to start to enroll a new certificate and to install it on the F5 3575 
LTM with these configuration settings. 3576 
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2.6.13.2 Microsoft IIS – Agentless  3577 

The Microsoft IIS system we used in our implementation to demonstrate automated management had 3578 
an existing certificate. Venafi TPP can automatically discover existing certificates and configuration 3579 
through its Onboard Discovery feature. Consequently, the following process was used: 3580 

1. Create an Onboard discovery job to discover certificates on Microsoft IIS systems. For 3581 
instructions on how to create Onboard Discovery jobs, refer to the section titled “Using Onboard 3582 
Discovery” in the Venafi Trust Protection Platform Certificate Management Guide. 3583 

2. Confirm Windows Remote Management (WinRM) service was running on the Windows server 3584 
hosting IIS. 3585 

 3586 

3. Enable WinRM at the command line. 3587 

C:\>winrm quickconfig 3588 

4. Create a device object in Venafi TPP with the address of the Windows server hosting IIS and a 3589 
credential for Venafi TPP to authenticate to the system. 3590 

 3591 
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5. Execute the IIS Onboard Discovery job that applied to the folder where the device was located. 3592 
The certificate and binding configuration on IIS were discovered.  3593 

 3594 

6. The certificate is discovered. 3595 

 3596 

7. In addition, IIS binding information is discovered, so that all the necessary configuration for 3597 
automated management is populated in Venafi TPP. 3598 

 3599 

8. To ensure the certificate automatically renews and is replaced when nearing expiration, confirm 3600 
the certificate was set to automatically renew prior to expiration. 3601 

 3602 

2.6.13.3  Microsoft IIS with SafeNet AT HSM – Agentless  3603 

The Venafi TPP server was used to remotely trigger the generation of a key pair and CSR on the SafeNet 3604 
AT HSM. The HSM is connected to the Microsoft IIS server in the Datacenter Secure zone and can enroll  3605 
a certificate using the generated CSR. It can also install the certificate in the Windows server with the 3606 
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proper configuration for the Microsoft IIS server. The following steps are used to perform these 3607 
operations: 3608 

1. Ensure the SafeNet AT HSM client is installed and configured on a Windows server hosting 3609 
Microsoft IIS. See Section 2.2.2.4 for instructions. 3610 

2. Create a new certificate object in the Venafi TPP Aperture console. 3611 

 3612 

3.  Select the appropriate folder. 3613 

 3614 

4. Select a name for the certificate. 3615 

 3616 

5. Select the “Provisioning” Management Type to configure the certificate for automated 3617 
management. 3618 

 3619 

6. Enter the CN for the certificate. 3620 

 3621 

7. Enter the SANs for the certificate. 3622 

 3623 
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8. Configure the certificate for automatic renewal and installation when it is nearing expiration. 3624 

 3625 

9. Add a new installation for the certificate and indicate that management is automated for that 3626 
installation. 3627 

 3628 

10. Enter the address for the device where the certificate will be installed. 3629 

 3630 

11. Select the folder where the device object should be created. 3631 

 3632 

12. Indicate that the application type for the installation is “Windows CAPI & IIS.” 3633 

 3634 

13. Select the credential to authenticate to the system for management operations. 3635 

 3636 

14. Enter a CAPI-friendly name for the certificate to be installed. 3637 

 3638 

15. Click Renew Now on the certificate to start generating a new key pair on the HSM and to start 3639 
getting a new corresponding certificate. 3640 
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2.6.13.4  Apache – Agentless  3641 

1. Create a new certificate object in the Venafi TPP Aperture console. For instructions on creating a 3642 
new certificate, refer to “Creating a new certificate in Aperture” in Venafi Trust Protection 3643 
Platform Working with Certificates.  3644 

2. Add an installation location for the certificate for the Apache where the certificate will be 3645 
installed. For instructions on adding an Apache installation in Aperture, refer to the section 3646 
titled “Creating an Apache application object” in the Venafi Trust Protection Platform Certificate 3647 
Authority and Hosting Platform Configuration Guide. Notable configuration information that we 3648 
used in our implementation, includes: 3649 

a. Set the private-key file location to correspond to the Virtual Host configuration on the 3650 
Apache server. 3651 

 3652 

b. Set the certificate file location to correspond to the Virtual Host configuration on the 3653 
Apache server. 3654 

 3655 

c. Set the CA certificate chain file location to correspond to the Virtual Host configuration 3656 
on the Apache server. 3657 

 3658 

d. Instruct Venafi TPP to update the CA chain. 3659 

 3660 

3. Click Install in the Actions menu to deploy the certificate to the Apache system. 3661 

2.6.13.5  Apache – ACME  3662 

Venafi TPP was configured as an ACME server in our implementation to support ACME-based requests 3663 
from internal systems. For instructions on using ACME with Venafi TPP, refer to the section titled “ACME 3664 
integration with Trust Protection Platform” in the Venafi Trust Protection Platform Certificate 3665 
Management Guide.  3666 
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2.6.13.6  Configuring Venafi TPP for ACME 3667 

The following steps are needed for configuring Venafi TPP to request certificates using an ACME client. 3668 

1. Configure Venafi TPP to enable the ACME server. 3669 
a. The ACME server is not enabled by default in Venafi TPP.  3670 
b. When ACME is enabled, select the folder where ACME-enrolled certificates are placed. 3671 
c. Enter the address of the Venafi TPP server that will service ACME clients. 3672 

 3673 

2. Assign an email address to the requesting account. The ACME protocol requires an email 3674 
address be provided during the registration process. Venafi TPP must be able to find the entered 3675 
email address in the local Venafi TPP identity directory or AD (depending on which directory is 3676 
used).  3677 

2.6.13.7  Configuring Certbot for Apache 3678 

Certbot is the standard client use for ACME on many systems. Find instructions on installing certbot at 3679 
the following address: https://certbot.eff.org/. We installed certbot on a Fedora Linux system to 3680 
automate certificate requests and installation for Apache.  3681 

We performed the following steps in our implementation. 3682 

1. Ensure the virtual host is configured in Apache. 3683 
2. Install certbot for Apache. 3684 

sudo dnf install certbot certbot-apache 3685 
 

3. The root certificate for the CA that issued the Venafi TPP server’s certificate must be trusted on 3686 
the system where certbot is run. This is done by adding it to one of the following files depending 3687 
on the OS: 3688 

https://certbot.eff.org/
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/etc/ssl/certs/ca-certificates.crt",                // Debian/Ubuntu/Gentoo etc. 3689 
/etc/pki/tls/certs/ca-bundle.crt",                  // Fedora/RHEL 6 3690 
/etc/ssl/ca-bundle.pem",                            // OpenSUSE 3691 
/etc/pki/tls/cacert.pem",                           // OpenELEC 3692 
/etc/pki/ca-trust/extracted/pem/tls-ca-bundle.pem", // CentOS/RHEL 7 3693 

 

4. Run certbot to request a certificate. A certificate was installed on the Apache system. 3694 

certbot certonly \ 3695 
--server “https://venafi1.int-nccoe.org/vacme/v1/directory” \ 3696 
--cert-name apache1 --domains apache1.int-nccoe.org \ 3697 
--apache --email acmeuser@int-nccoe.org --no-eff-email 3698 

 

2.6.13.8  Kubernetes  3699 

Instructions for installing, configuring, and using Kubernetes are available on https://kubernetes.io/. 3700 

We installed a three-node Kubernetes cluster on three CentOS Linux systems in the Datacenter network 3701 
zone in our implementation. We installed the following for the Kubernetes deployment: 3702 

 Docker version 18.09.3, build 774a1f4 3703 

 kubelet, kubeadm, and kubectl v1.13.4 3704 

 Weave (as our overlay network) 3705 

Once these components were installed, we installed and configured cert-manager in Kubernetes to 3706 
automatically request certificates for ingresses in Kubernetes. We performed the following steps: 3707 

1. Verified a user account with Venafi TPP WebSDK access and permissions to the folder(s) where 3708 
certificates are being requested from cert-manager (see the definition of the issuer below). We 3709 
created a user named “vapirequester” in AD for this purpose. The account was granted Create, 3710 
Write, Read, and View permissions to a folder named DevOps. We also granted that account 3711 
WebSDK access. 3712 

 3713 

https://kubernetes.io/


NIST SP 1800-16D: Securing Web Transactions: TLS Server Certificate Management 181 

2. Verified Jetstack Cert-Manager was installed with the necessary components to request 3714 
certificates from Venafi TPP. This automatically creates a namespace named “cert-manager,” 3715 
which we used for the rest of our configuration. 3716 

 3717 
kubectl apply -f https://raw.githubusercontent.com/jetstack \ 3718 
/cert-manager/venafi/contrib/manifests/cert-manager/with-rbac.yaml 3719 

3. Created Kubernetes secret for authenticating to Venafi TPP. 3720 

kubectl create secret generic tppsecret \ 3721 
--from-literal=username='vapirequester' \ 3722 
--from-literal=password='********' \ 3723 
--namespace cert-manager 3724 

https://raw.githubusercontent.com/jetstack%20/
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4. Copied the Root CA certificate that the certificate on the Venafi TPP chains up to (this is used by 3725 
cert-manager to validate the Venafi TPP certificate). This was copied to a file named rootca.pem. 3726 

5. Generated a base64 representation of the Root CA certificate. 3727 

cat rootca.pem | base64 | tr -d '\n' 3728 
 

6. Created a yaml file (tppvenafiissuer.yaml) for the configuration for a cert-manager issuer that 3729 
points to Venafi TPP. Note that the base64 representation of the Root CA certificate is placed 3730 
after “caBundle:” with a single space separating (there is no carriage return). The “zone” sets 3731 
the folder where the requested certificate will be placed. 3732 

apiVersion: certmanager.k8s.io/v1alpha1 3733 
kind: Issuer 3734 
metadata: 3735 
  name: tppvenafiissuer 3736 
  namespace: cert-manager 3737 
spec: 3738 
  venafi: 3739 
    zone: 'Certificate Management\C-Datacenter\DevOps' 3740 
    tpp: 3741 
      url: https://venafi1.int-nccoe.org/vedsdk 3742 
      credentialsRef: 3743 
        name: tppsecret 3744 
      caBundle: 3745 
LS0tLS1CRUdJTiBDRVJUSUZJQ0FURS0tLS0tCk1JSUMvVENDQWVXZ0F3SUJBZ0lRSnBydys5NUMyNnh3746 
Kd2FEeXFsWUhXekFOQmdrcWhraUc5dzBCQVFzRkFEQVIKTVE4d0RRWURWUVFERXdaU1QwOVVRMEV3SG3747 
hjTk1UZ3dOekE1TWpNME1EUTVXaGNOTWpBd056QTVNak0xTURRNApXakFSTVE4d0RRWURWUVFERXdaU3748 
1QwOVVRMEV3Z2dFaU1BMEdDU3FHU0liM0RRRUJBUVVBQTRJQkR3QXdnZ0VLCkFvSUJBUURaaHZxUXk33749 
ckZrTnlWenZxSW5GeE4ydVBLTEJRdzl1Mk5kb1NmTXhMTVU5TlB4UUcwOVNyT1V1SSsKYmhkckJNeEt3750 
FbStzMm5PTUNtY3g2SDN1dGp0UmtWU2pxQVZkYnQrVkN0TmtQWlZYTlRKaWlkOFVlTmRYY1dDMQpjMk3751 
M5RUVBNDVUOG94eG10TEkvd0l0N2RaMHpwVldxSitvT1VLVGFIZWpRTFcveUxYWkIvU3AvZzFuUmFOM3752 
XhqCjFZVllRQ2dCMWxVZ0lGQ3lXUzJJSmwvQXMrRjN6ckFOazg1K0krYlBCQ050ZUFYVTNkS0xTU0Nx3753 
WmxqdVZ1YncKa2QwVzhzMDRPRmdCR2lCM2o2MXBydEZZc1N5WlZKYjNKVDRFWnpTMlNBbXlHZlFteVF3754 
heEpJWC9RbmIzSGp5NwpHa0ViaVFqT1FLNE9mYlZiU2tKcTh5bHdmNkhEQWdNQkFBR2pVVEJQTUFzR03755 
ExVWREd1FFQXdJQmhqQVBCZ05WCkhSTUJBZjhFQlRBREFRSC9NQjBHQTFVZERnUVdCQlRZKzBtL3dwR3756 
EptaEdmUCtxbHJQcUI2M0t5akRBUUJna3IKQmdFRUFZSTNGUUVFQXdJQkFEQU5CZ2txaGtpRzl3MEJB3757 
UXNGQUFPQ0FRRUFGZk5EeWVlK1ZSSGhrUEx1Y1pGeQpmTlNEb0d0alZQckl5Q2J3aXMyQUFOL0xYV2J3758 
MVzlYUG1YOWVwSFJOQ3Zla1RFa0RQam1OVWxFd0cwTGUwbnByCmM3bTVrbDhjYTBNaHhkMUhURm1Xbm3759 
tydjdmRy80dmt6eUhXR0FwekNTcFlyUEhsS0lEaisxUlpmY1VrQ2lWWVQKb2RJL3V3K1A1RTNHalNJZ3760 
HdaK0RoODRFVURhQ0JHc1I1MzZOMnlaMURjekRTUWg5SHBPaTh6b3dYcnFWbzdkcApCYVpsUUNRUGlj3761 
N0hRaE0rS0VLMlVha1J4U1Z2ciszOEJRVyszOS9zbUFET1QxN2o0MmxEcHFpdjRBTWd4cUxWCmdXMFR3762 
sc1pwK1FHRnU1TExjSnVqS3llT09nM2NYanI3S1lwU0FoOVpWNzFpcFRzL2Q4NzdidWdPYURkL2Yrdl3763 
kKSFE9PQotLS0tLUVORCBDRVJUSUZJQ0FURS0tLS0tCgo= 3764 
 

7. Created the issuer in Kubernetes using the newly created file. 3765 

kubectl apply -f tppvenafiissuer.yaml 3766 
 

8. Created a yaml file for the ingress to the nginx service. Note the annotation 3767 
‘certmanager.k8s.io/issuer: "tppvenafiissuer"’ in the yaml file. This tells Jetstack Cert-Manager 3768 
that it should automatically request and install a certificate from this ingress using the issuer we 3769 
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defined earlier. Cert-manager uses the host name under tls and hosts (kube-ingress.int-3770 
nccoe.org) for the CN and SAN it submits in the certificate request to Venafi TPP. 3771 

apiVersion: extensions/v1beta1 3772 
kind: Ingress 3773 
metadata: 3774 
  name: nginx-ingress 3775 
  namespace: cert-manager 3776 
  annotations: 3777 
    kubernetes.io/ingress.class: "nginx" 3778 
    certmanager.k8s.io/issuer: "tppvenafiissuer" 3779 
 3780 
spec: 3781 
  tls: 3782 
  - hosts: 3783 
    - kube-ingress.int-nccoe.org 3784 
    secretName: nginx-cert 3785 
  rules: 3786 
  - host: kube-ingress.int-nccoe.org 3787 
    http: 3788 
      paths: 3789 
      - path: / 3790 
        backend: 3791 
          serviceName: nginx 3792 
          servicePort: 80 3793 
 

9. Created the ingress. 3794 

kubectl create -f nginx-ingress.yaml 3795 
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10. Once the ingress was created, connected with a browser kube-ingress.int-nccoe.org to confirm 3796 
that a certificate was properly issued through Venafi TPP and installed for the ingress. 3797 

 3798 

2.6.13.9 Symantec SSL Visibility  3799 

In our implementation, we configured Venafi TPP to automatically install TLS certificates and private 3800 
keys used on several of the TLS servers—including IIS and Apache—onto the Symantec SSL Visibility to 3801 
inspect traffic going to those servers.  3802 

1. Device object was created in Venafi TPP with the address and credentials for the Symantec SSL 3803 
Visibility. For instructions on adding a device object, refer to the section titled “Adding Objects” 3804 
in the Venafi Trust Protection Platform Administration Guide.  3805 
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2. To ensure all required certificates and private keys are copied to the TLS inspection device, 3806 
Venafi includes a feature called Bulk Provisioning. We created a bulk provisioning job. 3807 

 3808 

3. We named the job to distinguish it from other bulk provisioning jobs. 3809 

 3810 

4. We selected the device object created above for the Symantec SSL Visibility Appliance as the 3811 
target to which private keys would be provisioned. 3812 

 3813 

5. Venafi TPP was instructed to provision private keys associated with certificates in two folders: 3814 

 3815 

6. The default options excluded expired and revoked certificates and included historical 3816 
certificates. Historical certificates are certificates that Venafi replaced by Venafi TPP. These 3817 
certificates are still valid (not expired) and active on certain systems, though a new certificate 3818 
was issued. Consequently, it is important to provision them to the TLS inspection appliance to 3819 
ensure all traffic can be decrypted.  3820 

 3821 

7. The bulk provisioning job was configured to run every Sunday at midnight to ensure  new 3822 
certificates and private keys are deployed to the TLS inspection device. 3823 
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 3824 

8. Venafi TPP uses an adaptable framework for bulk provisioning, so these jobs can be customized 3825 
based on the environment’s requirements. To support bulk provisioning to the Symantec SSL 3826 
Visibility, the bulk provisioning script has the Venafi TPP copied into the C:\Program 3827 
Files\Venafi\Scripts\AdaptableBulk directory. The bulk provisioning job was configured to use 3828 
this script. 3829 

 3830 

9. The bulk provisioning job will run once it is saved. The private keys were confirmed to be on the 3831 
device. 3832 

10. To check if keys are saved in the SSL VISIBILITY, login to the SSL VISIBILITY WebUI by going to 3833 
https://192.168.1.95 3834 

 3835 

11. Go to PKI > Known Certificates and Keys. 3836 
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 3837 

12. In the Known Certificates with Keys Lists field, click on the all-known-certificates-with-keys 3838 
field. 3839 

 3840 

13. The imported certificates and keys are then shown under the Known Certificate with Keys field. 3841 

 3842 

2.6.14 Continuous Monitoring  3843 

Venafi TPP provides several tools that can continuously monitor TLS certificates within an enterprise, 3844 
including scheduled network discovery scanning, monitoring certificates for expiration, and monitoring 3845 
the operational status of known certificates. 3846 

2.6.14.1  Regular Network Scanning 3847 

In the lab, Venafi TPP was configured to perform weekly network discovery scans of the Datacenter and 3848 
Datacenter Secure networks zones from the Venafi TPP server. The scans were scheduled to run at 2:00 3849 
a.m. each Sunday. The lab network was small enough for network scans to complete within a few 3850 
minutes. Nonetheless, blackout periods were configured from 6:00 a.m. to 7:00 p.m. weekdays to 3851 
ensure network scans were not performed during “normal business hours.”  3852 

A notification rule was defined to send an alert to the certificate services team upon discovery of either 3853 
new certificates or previously unknown certificates (indicating they may have been issued and installed 3854 
outside of standard processes) installations. 3855 
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2.6.14.2  Certificate Expiration Monitoring 3856 

Significant application outages can occur when a certificate expires while in use. Consequently, it is 3857 
critical that certificate owners track certificate expiration dates and replace them. The certificate 3858 
services team can help certificate owners by implementing automated processes that monitor 3859 
certificate expiration dates and notify the owners.  3860 

We used Venafi TPP in the lab to monitor certificate expiration dates and notify certificate owners. The 3861 
methodology used in the lab followed the recommendations in SP 1800-16 Volume B. A weekly 3862 
expiration report was scheduled giving certificate owners a list of certificates set to expire within the 3863 
next 120 days. The following shows an example expiration report from the lab environment. The top of 3864 
the report summarizes the status of certificates associated with a particular certificate owner. 3865 

 3866 

The expiration report lists all of the applicable certificates. 3867 

 3868 
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In addition to the reports, notification rules were configured to send emails to the owners of certificates 3869 
expiring within 30 days. These notifications were configured to send daily, until the certificate was 3870 
replaced. For any certificate expiring in less than 20 days, a notification rule was configured to send an 3871 
additional email to escalation contacts, including the person identified as the Biz Owner and an incident 3872 
response team. The objective was to minimize the amount of email that certificate owners received if all 3873 
of their certificates were replaced in a timely fashion—ensuring sufficient alerts were sent for those 3874 
certificates that still needed replacement. 3875 

2.6.14.3  Certificate Operation Monitoring 3876 

Network discovery scans provide insight into newly installed certificates, however, it’s equally important 3877 
to monitor the operational state of known certificates. For example, a certificate owner may get a 3878 
replacement certificate for an installed certificate set to expire. If the certificate isn’t installed prior to its 3879 
expiration date, an outage can result. They may install the new certificate on several but not all of the 3880 
systems where the existing certificate is installed, causing the systems that were not updated to fail 3881 
when the existing certificate expires. Finally, they may install the new certificate in all necessary 3882 
locations, but not reset the application so the new certificate is read and use by the application, 3883 
resulting in an outage, because the application is continuing to use the existing certificate that expires. 3884 

Venafi TPP provides a service call network certificate validation that automatically checks deployed 3885 
certificates to ensure the correct certificate is installed and operational, thereby addressing the issues 3886 
described above. If a certificate issue is detected, the certificate owner is notified. Network certificate 3887 
validation was enabled on Venafi TPP in the lab.  3888 

2.6.14.4  Logging of Certificate-related Security Events 3889 

Venafi TPP logs all management operations performed on certificates, including changes that 3890 
administrators make within the user interfaces, changes via API, and all automated operations that are 3891 
performed. Errors are also logged. All logged events are automatically stored in the Venafi TPP database. 3892 
These events can be reviewed in the Venafi TPP console. It also is possible to sort, filter, and export the 3893 
log events. 3894 
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The following provides an example of several administrative events logged in our implementation, 3895 
created by filtering on specific types of administrative events focused on configuration changes: 3896 

  3897 

In addition to manually reviewing events within the console, it is possible to configure rules that will 3898 
automatically send events. These events can be sent via a variety of different channels, including via 3899 
email, to Splunk, to a syslog server, to an SNMP server, to a file, or to a database. Rules can be defined 3900 
to send events based on specific criteria. For example, it is possible to send alerts prior to certificate 3901 
expiration based on a configured set of days prior to expiration. 3902 

In our implementation, we configured Venafi TPP to send all events to the syslog server described in 3903 
Section 1.5.5.6. 3904 

A syslog channel was created that pointed to the syslog server. 3905 

 3906 

A rule was created to send a range of events from a severity of emergency to debug to the syslog 3907 
channel. 3908 

 3909 
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This approach to sending certificate-related events to an external security information and event 3910 
management (SIEM) system enables all security-related events to be centralized and analyzed 3911 
cohesively.3912 
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Appendix A Passive Inspection  3913 

The example implementation demonstrates the ability to perform passive inspection of encrypted TLS 3914 
connections. The question of whether or not to perform such an inspection is complex. There are 3915 
important tradeoffs between traffic security and traffic visibility that each organization should consider. 3916 
Some organizations prefer to decrypt internal TLS traffic, so it can be inspected to detect attacks that 3917 
may be hiding within encrypted connections. Such inspection can detect intrusion, malware, and fraud, 3918 
and can conduct troubleshooting, forensics, and performance monitoring. For these organizations, TLS 3919 
inspection may serve as both a standard practice and a critical component of their threat detection and 3920 
service assurance strategies. 3921 

The example implementation uses Symantec’s SSL Visibility to perform passive inspection and is one 3922 
example of how to accomplish passive inspection. The implementation demonstrates how to securely 3923 
copy private keys from several different TLS servers to the SSL Visibility Appliance.  The SSL Visibility 3924 
Appliance can also securely replace expiring keys on servers—and immediately copy those keys to the 3925 
SSL Visibility Appliance before expiration—manually and via standardized automated certificate 3926 
installation.  3927 

This appendix discusses how the SSL Visibility Appliance was configured to support passive inspection. 3928 
The goal was to demonstrate how to provision and revoke TLS certificates in an enterprise environment. 3929 
To verify this is being done, analysis of the traffic between the TLS clients and the TLS servers was 3930 
executed. The SSL Visibility Appliance can inspect traffic while located in line between the TLS clients 3931 
and TLS servers on the network, or it can perform passive observation of all the network traffic between 3932 
all the clients and servers mirrored to a port accessible to the server. The TLS lab configured its switching 3933 
fabric to support passive monitoring of traffic utilizing traffic mirroring.    3934 

Mirroring the traffic from the virtual TLS lab environment to its physical appliances presented a few 3935 
challenges. The TLS lab environment is housed within a larger VMWare and physical networking 3936 
architecture. VMware’s Virtual Distributed Switch Virtual Distributed Switch (VDS) provides a centralized 3937 
interface for the virtual machines’ access switching in the larger NCCoE environment where the TLS lab 3938 
lives as a resident. The TLS lab also has its own physical switching connections several routing hops away 3939 
from the NCCoE datacenter where VMWare resides. The VDS can route traffic internally between 3940 
multiple labs and virtual machines within each lab. However, VDS does not mirror VMWare’s local east-3941 
west traffic between virtual machines to other physical systems outside of the VDS environment. This 3942 
design limits the traffic that can be mirrored from TLS’ virtual machines that live on VMWare to physical 3943 
switches in the TLS lab.  3944 

To remediate this issue, the NCCoE IT team worked with VMWare senior engineers on a solution. 3945 
VMware advised the NCCoE IT team to configure remote SPAN (RSPAN) on the VDS. The IT team 3946 
mapped the traffic to a RSPAN port that resided in a VLAN on an external switch. This external switch 3947 
connects all the VMWare TLS hosts to the physical TLS lab. An additional RSPAN instance was configured 3948 
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on the TLS lab external switch, which is a physical NCCoE-managed and controlled device connected to 3949 
all the TLS team-managed and controlled physical internal switches. The external switch was configured 3950 
to carry the RSPAN traffic to the internal physical access switch in the TLS lab. A SPAN was created on 3951 
the internal access switch in the TLS lab and configured as source from the RSPAN VLAN. The destination 3952 
was set to the physical interface connected to the SSL Visibility Appliance. 3953 

Network packets captured from VMWare vSphere workloads must be forwarded to the physical remote 3954 
monitoring appliance; the packet must traverse the switch fabric between the VMWare ESXi cluster and 3955 
the physical remote monitoring appliance. Two factors must be considered from a solution feasibility 3956 
perspective:  3957 

 Low end switches–Have limitations on how many Remote SPAN sessions can be configured to 3958 
run concurrently. The switch fabric must establish a Remote SPAN Session between the 3959 
VMWare ESXi cluster and physical remote monitoring appliance. An alternative solution is to 3960 
deploy a robust network physical tap in lieu of leveraging the switch fabric between the 3961 
VMWare ESXi cluster and physical remote monitoring appliance. 3962 

 VMWare vSphere workloads–VMWare High Availability Features move from one ESXi host to 3963 
another, as computer resources are monitored and workloads are rescheduled. This requires 3964 
the ESXi cluster to automatically re-route the path that captured packets will take from a given 3965 
VM workload, as it moves from one ESXi host to another when migrated or when rescheduled 3966 
by Distributed Resource Scheduler to run on another host. The captured packets must egress 3967 
the ESXi cluster from the specific ESXi host on which the VM workload is running. 3968 

Successful deployment of this use case requires selection of the appropriate VMWare vSphere 6.x Port 3969 
Mirroring configuration option. VMWare vSphere 6.x offers 5 options: 3970 

 Distributed Port Mirroring 3971 

 Remote Mirroring Source 3972 

 Remote Mirroring Destination 3973 

 Encapsulated Remote Mirroring (L3) Source 3974 

 Distributed Port Mirroring (Legacy) 3975 

This use case that depends on the switch fabric having a Remote SPAN configured to pass traffic 3976 
between the VMWare ESXi cluster and the physical remote monitoring appliance, option 2, Remote 3977 
Mirroring Source, is the appropriate choice. When configured, this option will establish a Remote SPAN 3978 
VLAN that will span the VMWare distributed switch. It also utilizes the physical switch fabric and 3979 
leverages a distributed port group mapped to a pre-selected/pre-configured NIC on each ESXi host in the 3980 
ESXi cluster. Packets are automatically re-routed from captured VM workloads that are transient 3981 
between the ESXi hosts in a VMWare vSphere ESXi cluster. When a VM workload moves, vSphere will 3982 
note the change of the networking state of the VM and automatically re-establish an egress path for 3983 
captured packets on the NIC of the ESXi host on which the VM is running.3984 
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Appendix B Hardening Guidance 3985 

Hardening secures systems to reduce their vulnerabilities and minimizes the attack surface, which 3986 
improves security. To harden the systems, the TLS team implemented the Defense Information Agency’s 3987 
Security Technical Implementation Guides (STIGs). STIGs are technical configurations applied to systems 3988 
to maintain their security posture. This hardening guidance provides the baseline standard for a variety 3989 
of Operating Systems—see the link below to download the STIG guidance: 3990 

https://public.cyber.mil/stigs/ 3991 

NIST’s Security Content Automation Protocol (SCAP) is used to generate compliance reports of the 3992 
security health of systems. To further strengthen security of systems, use SCAP in conjunction with 3993 
STIGs. Nessus is another option that can scan for vulnerabilities and misconfigurations. 3994 

STIGs are implemented through GPOs that define policy settings for computer and user settings across 3995 
the network. Configure GPOs in AD to comply with STIGs. Refer to the link below to download the 3996 
current DISA STIG GPO Package and select those applicable to your environment. 3997 

https://public.cyber.mil/stigs/gpo/ 3998 

Follow the steps below to implement STIGs using GPOs in AD: 3999 

1. Open Group Policy Management Console (GPMC): 4000 

• Go to Start > Administrative Tools > Group Policy Management. 4001 

2. Create an OU in the domain: 4002 

• Go to GPMC > right-click on the <YOUR DOMAIN> > click New Organizational Unit. 4003 

• In the Name box on the New OU dialog box, type a descriptive name for the OU > click 4004 
OK. 4005 

3. Create a GPO in the domain: 4006 

• Go to GPMC > <YOUR DOMAIN> > right-click Group Policy Objects > click New. 4007 

• In New GPO dialog box enter a descriptive name > click OK. 4008 

4. Import DISA GPOs: 4009 

• Go to GPMC > <YOUR DOMAIN> > Group Policy Objects > right-click on the GPO to edit 4010 
> click Import Settings. 4011 

• The Import Settings Wizard appears > click Next > select the folder location of the DISA 4012 
GPO being used. The TLS lab used GPOs for MS Computer, MS User, DC Computer and 4013 
DC User. 4014 

Note: To apply desired security configurations edit settings in the specific GPO.  4015 

https://public.cyber.mil/stigs/
https://public.cyber.mil/stigs/gpo/
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5. Edit a GPO in the domain, an OU, or the Group Policy objects folder: 4016 

• Go to GPMC > <YOUR DOMAIN> > select Group Policy Objects to display all GPOs in the 4017 
domain.  4018 

• Right-click the desired GPO > click Edit > the GPO will open in the Group Policy 4019 
Management Editor (GPME). 4020 

• In the GPME, edit the Group Policy settings as preferred. 4021 

6. Link a GPO to a domain or OU: 4022 

• Go to GPMC> right-click <YOUR DOMAIN> or OU to link to the GPO > click Link an 4023 
Existing GPO. 4024 

• The Select GPO dialog box appears - > select the GPO you want linked to the domain or 4025 
OU > click OK. 4026 

*Shortcut: Drag the GPO from the Group Policy Objects folder and drop it onto the OU you 4027 
want it linked to. 4028 

7. Optional: 4029 
• Unlink a GPO from a domain or OU: 4030 

• Go to GPMC > click <YOUR DOMAIN> or OU containing the GPO you want to 4031 
unlink. 4032 

• Right-click the GPO > click Delete. 4033 

• In the Group Policy Management dialog box, confirm deletion and click OK. 4034 

Note: Unlink a GPO when it no longer applies. Unlinking a GPO from a domain or 4035 
OU does not delete the GPO—it deletes the link. After unlinking the GPO, you 4036 
can still find it in the Group Policy Objects folder. 4037 

• Add computer to OU: 4038 
 4039 

• Go to Start > Administrative Tools > Active Directory Users and Computers. 4040 

• Click on <YOUR DOMAIN> > refresh. The newly added OU will appear. 4041 

• Go to Computers > right-click the desired computer > click Move.  4042 

• Select the desired OU to move the computer to > click OK. 4043 

• To apply new settings > log out and log back in. 4044 
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Appendix C Venafi Underlying Concepts 4045 

The following background information may help users better understand some of the configurations we 4046 
made in the configuration management databases (CMDBs) implementation of Venafi TPP. 4047 

Venafi TPP is one machine identity protection platform that enables enterprises to address TLS server 4048 
certificate security and operational risks. Venafi TPP served as the certificate management platform for 4049 
the TLS lab.  4050 

The following diagram illustrates the process of architecting, deploying, configuring, and using Venafi 4051 
TPP to manage certificates and keys in enterprises. 4052 

 4053 

Venafi TPP interfaces with a variety of different types of systems and people/groups, including: 4054 

1. Venafi TPP Database: Venafi TPP requires a database to store certificates, private keys, and 4055 
configuration information (all private keys and credentials are encrypted prior to storage in the 4056 
database). Venafi TPP supports the use of Microsoft SQL Server to host its database.  4057 

2. HSM: Stores and protects the symmetric key used to encrypt private keys and credentials in the 4058 
Venafi TPP database. 4059 

3. Identity Directory: Venafi TPP integrates with identify management systems such as AD, LDAP 4060 
directories, or proprietary directories, and enables the use of existing user accounts and groups.  4061 

4. CAs: Venafi TPP integrates supports direct integration with over two dozen public and private 4062 
CAs for the automated enrollment, renewal, and revocation of certificates.  4063 

5. SIEM/Email/Ticketing: Venafi TPP integrates with SIEM systems to pass certificate and 4064 
cryptographic key event information. It integrates with ticketing systems for the automated 4065 
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creation of change tickets and approvals and with email systems for the notifications to 4066 
certificate owners for impending expirations or errors. 4067 

6. Other Enterprise Systems: Venafi TPP can be integrated with a variety of other enterprise 4068 
systems, such as CMDBs, enterprise dashboards, and custom applications. 4069 

7. Systems with Certificates: Venafi TPP communicates directly with systems with certificates to 4070 
automatically discover and manage those certificates. 4071 

8. Certificate Services Team: This team manages the Venafi TPP servers and supports Certificate 4072 
Owners. 4073 

9. Certificate Owners: These are groups and individuals responsible for systems where certificates 4074 
are deployed using Venafi TPP for automating a variety of functions, including scanning, 4075 
inventory, enrollments, and installation of certificates. 4076 

The following diagram is a high-level view of these components. 4077 

 4078 

Depending on an organization’s needs, it’s possible to deploy one or more Venafi TPP servers centrally 4079 
or distributed in different network zones as well as different geographies. The number and placement of 4080 
Venafi TPP servers is an important step to create an effective certificate management solution that 4081 
supports the environmental and operational needs of an enterprise. The criteria driving the number and 4082 
placement of Venafi TPP servers includes: 4083 

1. Venafi TPP Services: Each Venafi TPP can host one or more services, including network 4084 
discovery scanning, certificate enrollment, certificate installation, administrative UI, etc. 4085 
Depending on the size and structure of an organization, these services can be deployed on a 4086 
single Venafi TPP server or, more likely, across multiple servers. The services that a Venafi TPP 4087 
server can be configured to perform include: 4088 

a. Hosting administrative and user interfaces 4089 
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b. Network discovery scanning 4090 
c. Onboard discovery 4091 
d. CA import 4092 
e. Certificate expiration monitoring 4093 
f. Certificate operation monitoring (validation) 4094 
g. Automated certificate enrollment 4095 
h. Agentless certificate installation 4096 
i. Agent management 4097 
j. CRL expiration monitoring 4098 
k. Revocation status monitoring 4099 
l. Report generation 4100 
m. Venafi TPP REST API access 4101 
n. Log event management and notifications 4102 
o. Trust store management 4103 

2. Load and Performance Requirements: The number of certificates and systems that must be 4104 
managed by Venafi TPP plays an important part in the choice of how many Venafi TPP servers to 4105 
deploy. Venafi TPP is a based on a load-balanced architecture that enables multiple servers to 4106 
share in the processing of work. 4107 

3. Fault Tolerance: Due to the critical role of certificate management, deployment architectures 4108 
may include multiple Venafi TPP servers deployed across primary and disaster recovery sites to 4109 
ensure continuous availability of certificate management services.  4110 

4. Network Zones and Boundaries: Network architectures often place limits on the type of traffic 4111 
that can traverse between network zones (across firewalls). For example, a firewall may limit the 4112 
allowed ports between two network zones, necessitating the placement of a Venafi TPP server 4113 
directly inside a network zone to enable network discovery scans to run. 4114 

5. Geographic Distribution: Organizations are often distributed across multiple cities, states, 4115 
countries, and continents. Ensuring that network latencies do not negatively impact the 4116 
performance of certificate management services at each geographic location often involves 4117 
distributing Venafi TPP servers near the systems and certificates being managed. 4118 

C.1 Venafi TPP Object Model 4119 

To understand how Venafi TPP maintains inventory information, first review the Venafi TPP data model. 4120 
Venafi TPP uses an object-based storage model where configuration information for certificates, 4121 
associated devices, and applications are stored as objects and attributes in the Venafi TPP database. 4122 
Several different object types exist in Venafi TPP—each of which includes associated attributes that 4123 
store data relevant to the object. For example, a certificate object includes attributes for issuer, key 4124 
length, common name, organization, etc.  4125 

The object types in Venafi TPP include: 4126 
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1. Folder: Folders are containers that facilitate the hierarchical organization certificates, devices, 4127 
applications, and other objects within Venafi TPP.  4128 

2. Certificate: These objects hold configuration data for certificates managed by Venafi TPP, 4129 
including certificate authority (CA), key length, certificate owner, approver, and other 4130 
information. A certificate object can have one or more applications objects—each indicating a 4131 
location where the certificate is installed. 4132 

3. Device: These objects hold configuration information about the systems where certificates are 4133 
deployed, including the network address and port, authentication credentials, and other 4134 
information for the system. 4135 

4. Application: These objects hold information about the specific application (e.g., Apache, F5, 4136 
Java, etc.) that uses a certificate on a device. Each device may have one or more applications 4137 
that use certificates. The attributes and information stored in an application object depends on 4138 
the type of application. For example, an F5 application object stores information such as the SSL 4139 
profile, virtual server, and partition for the associated certificate on the F5 device. 4140 

5. Workflow: Workflow objects store the rules that are enforced for workflow gates within Venafi 4141 
TPP. They include the stage of the certificate lifecycle where approval is needed, the required 4142 
approvers, and even actions that may be automatically perform when the workflow gate is 4143 
triggered.  4144 

6. CA Template: These objects store information about CAs from which Venafi TPP requests 4145 
certificates and the specific certificate templates that the CAs will use. 4146 

7. Credential: These objects hold credential information that Venafi TPP uses to authenticate to 4147 
other systems, including CAs, systems where certificates are managed via agentless 4148 
management, etc. Passwords and private keys used in credentials are stored in encrypted form 4149 
in the Venafi TPP database. 4150 

C.2 Certificate Metadata in Venafi TPP 4151 

Certificates are stored in Venafi TPP in binary form (i.e., the DER encoded version of the certificate). In 4152 
addition, the individual X.509 fields and extensions of each certificate are parsed and stored in unique 4153 
database fields, to enable rapid searching and filtering. The certificate fields parsed and stored for rapid 4154 
searching in Venafi TPP include: 4155 

 X.509 Version: V1, V2, or V3 4156 

 Serial Number: A unique identifier assigned by the issuing certificate authority 4157 

 Issuer Distinguished Name: The full X.500 distinguished name of the issuing-CA.  4158 

 Valid From: The date and time from which the certificate was issued. This is commonly referred 4159 
to as an issue date. 4160 

 Valid To: The date and time after which the certificate should no longer be considered valid. 4161 
This is commonly referred to as the expiration date. 4162 
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 Subject Distinguished Name (SAN): The full X.500 distinguished name for the subject of the 4163 
certificate (the entity to which the certificate was issued)—for example: “CN = iis2.int-nccoe.org, 4164 
O = NCCOE, L = Gaithersburg, S = Maryland, C = US”. 4165 

 Subject Alternative Names: One or more identifiers for the subject of the certificate (the entity 4166 
to which the certificate was issued). There could be additional DNS host names (e.g., server1.int-4167 
nccoe.org), IP address, or other types of identifiers. 4168 

 Signature Algorithm: The asymmetric and hashing algorithms that sign the certificate (e.g., 4169 
sha256RSA). 4170 

 Subject Key Identifier: A unique identifier for the public key within the certificate. Because the 4171 
public and private key are inextricably associated, this identifier applies to both of them. 4172 

 Authority Key Identifier: A unique identifier for the public/private key that the certificate 4173 
authority uses to sign the certificate. 4174 

 CRL Distribution Points: One or more addresses where the CRL for the CA that issued the 4175 
certificate can be retrieved. 4176 

 AIA: The location(s) where information and services, such as where to retrieve the CA certificate 4177 
chain or access online certificate status protocol for the CA that issued the certificate. 4178 

 Key Usage: Defines the purposes for which the key within the certificate can be used, including 4179 
digital signature, key encipherment, and key agreement. 4180 

 Enhanced Key Usage: Defines the purposes for which the certified public key within the 4181 
certificate may be used, including server authentication, client authentication, and code signing. 4182 

 Basic Constraints: Defines whether the subject of the certificate is a CA and the maximum depth 4183 
of certification path (number of CAs below this CA allowed). 4184 

 Policy: Policies defined within the certificate. 4185 

 Key Size: The length of the public key in the certificate. 4186 

In addition to certificate field and extension information, Venafi TPP stores other metadata relevant to 4187 
each certificate, including: 4188 

 Certificate Owner(s): Groups and/or individual assigned to manage and receive notifications 4189 
(e.g., expiration notices, processing errors, etc.) for the certificate 4190 

 Approver(s): Groups and/or individuals assigned to approve operations for the certificate 4191 

 Processing Status: Indicates whether the certificate processing is proceeding normally, is in 4192 
error, or has completed 4193 

 Processing Stage: The current stage of processing (e.g., creating CSR, retrieving certificate from 4194 
CA, installing certificate) for the certificate 4195 
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 Last Network Validation Time & Date: The last date and time a network validation was 4196 
performed to determine the operational status of the certificate 4197 

 Network Validation Status: The result of last network validation 4198 

 Installation Location(s): The devices and applications where the certificate is installed 4199 

 CA Chain: The chain of CA certificates from the root to the TLS server certificate 4200 

 Management Method: Determines if the certificate should be automatically enrolled and 4201 
installed, or manually enrolled and installed 4202 

 Log Information: Logs of all administrative changes and automated operations performed on 4203 
the certificate via Venafi TPP 4204 

C.3 Custom Fields 4205 

With thousands of certificates, it is critical that organizationally-relevant information—such as cost 4206 
center, application identifiers, business unit, and applicable regulations—can be associated with 4207 
certificates. As a result, searches and reporting can return the certificates most relevant to a particular 4208 
group or business function. Venafi TPP supports the definition of “custom fields” that can be assigned to 4209 
certificates. The value of the custom fields (e.g., Cost Center = “B123”) can be assigned to individual 4210 
certificates or folders, thereby flowing down and applying to all subordinate certificates. It should be 4211 
noted that custom fields can be assigned to other assets such as devices associated with certificates. 4212 

C.3.1 Organizing Certificate Inventory 4213 

Many large enterprises have thousands or tens of thousands of certificates, often with hundreds of 4214 
certificate owners across many different groups. To help effectively manage certificates across these 4215 
broad environments, Venafi TPP enables the creation of a hierarchical folder structure where certificates 4216 
and associated system configuration information can be placed.  4217 

The design of a Venafi TPP folder hierarchy for the organization of certificates is dependent on the 4218 
needs and requirements of an enterprise—similar to having multiple approaches to create folder 4219 
hierarchies when organizing files. However, through experience in working with many large enterprises, 4220 
Venafi professional services has developed a set of guidelines, including: 4221 

 Certificate Ownership: The primary factor for designing a Venafi TPP hierarchy is based on the 4222 
organization of certificate owners. Once a folder is assigned to a certificate owner, certificates 4223 
and other assets placed within the folder automatically inherit the permissions, contacts, and 4224 
approvers, so that ownership does not need to be managed on individual certificates (though 4225 
ownership information can be managed on individual certificates in Venafi TPP, if necessary).  4226 

 Policies: Policies such as allowed key lengths, signing algorithms, and CAs are an important 4227 
consideration in the organization of Venafi TPP folders. 4228 
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 Workflow and Approvals: Workflow rules are assigned at the folder level in Venafi TPP. If an 4229 
enterprise applies different workflow rules across their organizational groups, the design of the 4230 
folder hierarchy may be adjusted to easily assign those rules as needed. 4231 

C.3.2 Policy Enforcement  4232 

Venafi TPP supports the enforcement of written policies through the assignment of policies to any folder 4233 
within the hierarchy. It is possible to define Venafi TPP policies for a broad set of areas, including 4234 
allowed CAs, allowable domains, certificate contents (e.g., key length), approvers, and application 4235 
configurations.  4236 

Policies set on a folder flow down to subordinate folders and objects within the folders. This makes it 4237 
possible to configure group-specific policies on folders assigned to those groups and policies with 4238 
broader applicability to higher level folders, so that they apply to all certificates, devices, applications 4239 
across subordinate folders. Policies can be set as suggested, to provide a default value that users are 4240 
able to change if desired, or enforced, where users are required to use the set value. 4241 

C.4 Domain Whitelisting 4242 

Because certificates serve as trusted credentials, they should only be issued for authorized domains. To 4243 
aid in this, Venafi TPP supports the whitelisting of domains that can be used in certificates. For example, 4244 
it is possible to only allow common names (CNs) and subject alternative names (SANs) that have the 4245 
suffix “.int-nccoe.org”, which only allow CNs and SANs such as server1.int-nccoe.org and server2.ops.int-4246 
nccoe.org. 4247 

C.4.1 Certificate Owner Assignment 4248 

The assignment and maintenance of certificate ownership is critical to prevent outages and respond to 4249 
security incidents. Depending on the size of groups and the number certificates they manage, certificate 4250 
management responsibilities may be assigned to one person or distributed among several different 4251 
individuals. For larger groups managing greater numbers of certificates across a broad set of systems, 4252 
the roles may vary for each team member. For example, a core group of technical people may be 4253 
responsible for managing the configuration of certificates. That same group plus a manager may need to 4254 
receive alerts and reports. To accommodate these differences in roles, Venafi TPP enables the 4255 
assignment of permissions and contact information (for sending alerts) at the certificate or folder level. 4256 

C.4.2 Permissions 4257 

In Venafi TPP, groups and individual users can be granted permissions to folders and individual objects 4258 
(e.g., certificates). Venafi TPP can assign the following permissions: 4259 
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 View: See an object in a folder and select it (but not see its configuration parameters). For 4260 
example, an administrator with view rights to an application can associate that application to a 4261 
certificate for which they are responsible. 4262 

 Read: Read an object’s configuration parameters and status. 4263 

 Write: Edit an object’s configuration parameters. 4264 

 Create: Create new objects under the object to which the Create permission is assigned. Applies 4265 
only to objects that contain other objects. 4266 

 Delete: Delete the specified object or objects contained within it (unless blocked below). 4267 

 Rename: Rename the object. 4268 

 Revoke: Revoke a certificate. This only applies to certificates only but can be set on policies, 4269 
devices, or applications for any certificates contained under them. 4270 

 Associate: Associate a certificate to one or more applications from within that certificate object. 4271 

 Admin: Grant users or groups permissions to the object. 4272 

 Private-Key Read: Retrieve the private-key for a certificate only applies to certificates but can be 4273 
set on policies, devices, or applications for any certificates contained under them. 4274 

 Private-Key Write: Upload or overwrite the private-key for a certificate. This only applies to 4275 
certificates but can be set on policies, devices, or applications for any certificates contained 4276 
within them. The private-key write privilege is required for an administrator to extract a private-4277 
key and certificate from an application to be stored in the Venafi TPP database. 4278 

 Permissions: Permissions assigned to a folder are inherited subordinate objects and folders. 4279 
Wherever possible, it’s a best practice to assign permissions to groups to quickly grant a new 4280 
team member the needed permissions simply by being added to the group. It is also best to 4281 
assign permissions at the folder level, applying to all subordinate certificates. When a new 4282 
system and certificate are needed, they can be added within the folder and the permissions 4283 
automatically apply. 4284 

C.4.3 Contacts 4285 

Effectively managing certificates in an enterprise requires the ability to automatically notify the 4286 
certificate owners of impending expirations, errors, or other events that affect their certificates. It’s 4287 
possible to assign one or more groups or individuals as “contacts” to folders or individual objects in 4288 
Venafi TPP. Contact assignment to folders are inherited by the objects below them.  4289 
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Appendix D List of Acronyms 4290 

ACME  Automated Certificate Management Environment  

AD  Active Directory  

ADCS Active Directory Certificate Services 

ADS Active Directory Services 

AIA Authority Information Access 

API  Application Programming Interface  

CA  Certificate Authority  

CAPI  Cryptographic Application Programming Interface (also known variously as 
CryptoAPI, Microsoft Cryptography API, MS-CAPI or simply CAPI)  

CDP CRL Distribution Point 

CEP Certificate Enrollment Policy 

CES Certificate Enrollment Service 

CMDB  Configuration Management Database  

CN  Common Name  

CNG  Cryptography API: Next Generation 

CPU Central Processing Units 

CRL Certificate Revocation List 

CSR  Certificate Signing Request  

DB Database 

DC Domain Controller 

DevOps  Development Operations 

DMZ Demilitarized Zone  

DNS Domain Name System 

EULA End User License Agreement 
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EV  Extended Validation  

FIPS  Federal Information Processing Standards  

FQDN Fully Qualified Domain Name 

GPMC Group Policy Management Console 

GPO Group Policies Objects 

HSM  Hardware Security Module  

HTML Hypertext Markup Language 

http  Hypertext Transfer Protocol  

https Hypertext Transfer Protocol Secure 

IdP Identity Provider 

IETF  Internet Engineering Task Force  

IIS Internet Information Server (Microsoft Windows) 

IMAP Internet Message Access Protocol 

IP  Internet Protocol  

IT Information Technology 

ITL Information Technology Laboratory 

KSP Key Storage Provider 

LDAP  Lightweight Directory Access Protocol  

LTM Local Traffic Manager (F5) 

MSQL Microsoft SQL 

MTA Mail Transfer Agent 

MUA Mail User Agent  

NAT Network Address Translation 

NCCoE National Cybersecurity Center of Excellence  

NIST  National Institute of Standards and Technology  
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NTL Network Trust Link 

NTLS Network Trust Link Service 

OS Operating System 

OVA Open Virtualization Appliance 

OVF Open Virtualization Format 

PCI-DSS  Payment Card Industry Data Security Standard   

PED PIN Entry Device 

PIN Personal Identification Number 

PKI  Public Key Infrastructure  

PSCP PuTTY Secure Copy Protocol 

RA  Registration Authority  

RAM Random Access Memory 

REST  Representational State Transfer (API)  

RHEL Red Hat Enterprise Linux 

RMF  Risk Management Framework  

RSA  Rivest, Shamir, & Adleman (public key encryption algorithm)  

RSPAN Remote Switched Port Analyzer 

SafeNet AT    SafeNet Assured Technologies 

SAN  Subject Alternative Name  

SCAP Security Content Automation Protocol 

SCEP  Simple Certificate Enrollment Protocol  

SCP Secure Copy Protocol 

SIEM Security Information and Event Management 

SMTP Simple Mail Transfer Protocol  

SOAP Simple Object Access Protocol 
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SP  Special Publication  

SPAN Switched Port Analyzer 

SQL Structured Query Language 

SSL  Secure Socket Layer (protocol) 

SSL VISIBILITY SSL Visibility (Symantec Appliance) 

STIGs Security Technical Implementation Guides 

TCP Transmission Control Protocol 

TLS  Transport Layer Security (protocol) 

TMSH Traffic Management Shell 

TPP  Trust Protection Platform (Venafi) 

UCS User Configuration Set 

UDP User Datagram Protocol 

UPN User Principal Name 

URL Uniform Resource Locator 

VDS Virtual Distributed Switch 

VE Virtual Edition 

VLAN Virtual Local Area Network 

WinRM Windows Remote Management 
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Appendix E Glossary 4292 

Active Directory  A Microsoft directory service for the management of identities in 
Windows domain networks.  

Application 1. The system, functional area, or problem to which information 
technology (IT) is applied. The application includes related manual 
procedures as well as automated procedures. Payroll, accounting, 
and management information systems are examples of applications. 
(NIST SP 800-16 ) 

2. A software program hosted by an information system. (NIST SP 
800-137) 

Authentication Verifying the identity of a user, process, or device, often as a 
prerequisite to allowing access to a system’s resources. (NIST SP 
800-63-3) 

Automated Certificate 
Management Environment  

A protocol defined in IETF RFC 8555 that provides for the 
automated enrollment of certificates.  

Certificate A set of data that uniquely identifies an entity, contains the entity's 
public key and possibly other information, and is digitally signed by 
a trusted party, thereby binding the public key to the entity. 
Additional information in the certificate could specify how the key is 
used and its validity period. (NIST SP 800-57 Part 1 Rev. 4 under 
Public-key certificate) (Certificates in this practice guide are based 
on IETF RFC 5280.) 

Certificate Authority  A trusted entity that issues and revokes public key certificates. 
(NISTIR 8149) 

Certificate Chain An ordered list of certificates that starts with an end-entity 
certificate, includes one or more certificate authority (CA) 
certificates, and ends with the end-entity certificate’s Root CA 
certificate, where each certificate in the chain is the certificate of 
the CA that issued the previous certificate. By checking to see if 
each certificate in the chain was issued by a trusted CA, the receiver 
of an end-user certificate can determine whether it should trust the 
end-entity certificate by verifying the signatures in the chain of 
certificates. 

https://doi.org/10.6028/NIST.SP.800-16
https://doi.org/10.6028/NIST.SP.800-137
https://doi.org/10.6028/NIST.SP.800-137
https://doi.org/10.6028/NIST.SP.800-63-3
https://doi.org/10.6028/NIST.SP.800-63-3
https://doi.org/10.6028/NIST.SP.800-57pt1r4
https://tools.ietf.org/html/rfc5280
https://tools.ietf.org/html/rfc5280
https://doi.org/10.6028/NIST.IR.8149
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Certificate Management Process whereby certificates (as defined above) are generated, 
stored, protected, transferred, loaded, used, and destroyed. (CNSSI 
4009-2015) (In the context of this practice guide, it also includes 
inventory, monitoring, enrolling, installing, and revoking.) 

Certificate Revocation List A list of digital certificates that have been revoked by an issuing CA 
before their scheduled expiration date and should no longer be 
trusted. 

Certificate Signing Request  A request sent from a certificate requester to a CA to apply for a 
digital identity certificate. The certificate signing request contains 
the public key as well as other information to be included in the 
certificate and is signed by the private key corresponding to the 
public key. 

Client  1. A machine or software application that accesses a cloud over a 
network connection, perhaps on behalf of a consumer. (NIST SP 
800-146) 

2. A function that uses the PKI to obtain certificates and validate 
certificates and signatures. Client functions are present in CAs and 
end entities. Client functions may also be present in entities that are 
not certificate holders. That is, a system or user that verifies 
signatures and validation paths is a client, even if it does not hold a 
certificate itself. (NIST SP 800-15) 

Cloud Computing A model for enabling ubiquitous, convenient, on-demand network 
access to a shared pool of configurable computing resources (e.g., 
networks, servers, storage, applications, and services) that can be 
rapidly provisioned and released with minimal management effort 
or service provider interaction. (NIST SP 800-145) 

Common Name An attribute type commonly found within a Subject Distinguished 
Name in an X.500 directory information tree. When identifying 
machines, it is composed of a fully qualified domain name or IP 
address.  

Configuration Management A collection of activities focused on establishing and maintaining the 
integrity of IT products and information systems, through control of 
processes for initializing, changing, and monitoring the 
configurations of those products and systems throughout the 
system development life cycle. (NIST SP 800-53 Rev. 4) 

https://rmf.org/wp-content/uploads/2017/10/CNSSI-4009.pdf
https://rmf.org/wp-content/uploads/2017/10/CNSSI-4009.pdf
https://doi.org/10.6028/NIST.SP.800-146
https://doi.org/10.6028/NIST.SP.800-146
https://doi.org/10.6028/NIST.SP.800-15
https://doi.org/10.6028/NIST.SP.800-145
https://doi.org/10.6028/NIST.SP.800-53r4
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Container A method for packaging and securely running an application within 
an application virtualization environment. Also known as an 
application container or a server application container. (NIST SP 
800-190 ) 

Cryptographic Application  

Programming Interface 

An application programming interface (API) included with Microsoft 
Windows operating systems that provides services to enable 
developers to secure Windows-based applications using 
cryptography. While providing a consistent API for applications, the 
Cryptographic Application Programming Interface (CAPI) allows for 
specialized cryptographic modules (cryptographic service providers) 
to be provided by third parties, such as Hardware Security Module 
(HSM) manufacturers. This enables applications to leverage the 
additional security of HSMs while using the same APIs they use to 
access built-in Windows cryptographic service providers. (Also 
known variously as CryptoAPI, Microsoft Cryptography API, MS-CAPI 
or simply CAPI) 

Cryptography API: Next Generation  The long-term replacement for the CAPI.  

Demilitarized Zone A perimeter network or screened subnet separating a more-trusted 
internal network from a less-trusted external network. 

Development Operations (DevOps) A set of practices for automating the processes between software 
development and IT operations teams, so they can build, test, and 
release software faster and more reliably. The goal is to shorten the 
systems development life cycle and improve reliability while 
delivering features, fixes, and updates frequently in close alignment 
with business objectives. 

Digital Certificate Certificate (as defined above). 

Digital Signature The result of a cryptographic transformation of data that, when 
properly implemented, provides origin authentication, assurance of 
data integrity and signatory non-repudiation. (NIST SP 800-133) 

Digital Signature Algorithm A Federal Information Processing Standard for digital signatures, 
based on the mathematical concept of modular exponentiations 
and the discrete logarithm problem. (FIPS 186-4) 

Directory Service A distributed database service capable of storing information, such 
as certificates and CRLs, in various nodes or servers distributed 
across a network. (NIST SP 800-15 ) (In the context of this practice 

https://doi.org/10.6028/NIST.SP.800-190
https://doi.org/10.6028/NIST.SP.800-190
https://doi.org/10.6028/NIST.SP.800-133
https://doi.org/10.6028/NIST.SP.800-15
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guide, a directory services stores identity information and enables 
the authentication and identification of people and machines.) 

Distinguished Name An identifier that uniquely represents an object in the X.500 
directory information tree. (RFC 4949 Ver 2) 

Domain A distinct group of computers under a central administration or 
authority.  

Domain Name A label that identifies a network domain using the Domain Naming 
System. 

Domain Name System The system by which Internet domain names and addresses are 
tracked and regulated as defined by IETF RFC 1034 and other 
related RFCs. 

Extended Validation (EV) 
Certificate 

A certificate used for https websites and software that includes 
identity information, subjected to an identity verification process 
standardized by the CA Browser Forum in its Baseline 
Requirements, which verifies the identified owner of the website for 
which the certificate has been issued has exclusive rights to use the 
domain; exists legally, operationally, and physically; and has 
authorized the issuance of the certificate.  

Federal Information Processing 
Standards (FIPS) 

A standard for adoption and used by federal departments and 
agencies that has been developed within the Information 
Technology Laboratory (ITL) and published by the National Institute 
of Standards and Technology, a part of the U.S. Department of 
Commerce. A FIPS covers some topic in IT to achieve a common 
level of quality or some level of interoperability. (NIST SP 800-161) 

Hardware Security Module (HSM) A physical computing device that provides tamper-evident and 
intrusion-resistant safeguarding and management of digital keys 
and other secrets, as well as crypto-processing. FIPS 140-2 specifies 
requirements for HSMs. 

Host Name Host names are most commonly defined and used in the context 
of DNS. The host name of a system typically refers to the fully 
qualified DNS domain name of that system. 

Hypertext Transfer Protocol (HTTP) A standard method for communication between clients and Web 
servers. (NISTIR 7387) 

https://tools.ietf.org/html/rfc4949
https://tools.ietf.org/html/rfc1034
https://cabforum.org/baseline-requirements-documents/
https://cabforum.org/baseline-requirements-documents/
https://doi.org/10.6028/NIST.SP.800-161
https://csrc.nist.gov/publications/detail/fips/140/2/final
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Internet Engineering Task 
Force (IETF) 

The internet standards organization made up of network designers, 
operators, vendors, and researchers that defines protocol standards 
(e.g., IP, TCP, DNS) through process of collaboration and consensus. 

Internet Message Access Protocol A method of communication used to read electronic mail stored in a 
remote server. (NISTIR 7387) 

Internet Protocol (IP) The IP, as defined in IETF RFC 6864, is the principal communications 
protocol in the IETF Internet protocol suite for specifying system 
address information when relaying datagrams across network 
boundaries.  

Lightweight Directory Access 
Protocol (LDAP) 

The LDAP is a directory access protocol. In this document, LDAP 
refers to the protocol defined by RFC 1777, which is also known as 
LDAP V2. LDAP V2 describes unauthenticated retrieval mechanisms. 
(NIST SP 800-15) 

Microservice A set of containers that work together to compose an application. 
(NIST SP 800-190) 

Organization An entity of any size, complexity, or positioning within an 
organizational structure (e.g., a federal agency or, as appropriate, 
any of its operational elements). (NIST SP 800-39) This publication is 
intended to provide recommendations for organizations that 
manage their own networks (e.g., that have a chief information 
officer). 

Outage A period when a service or an application is not available or when 
equipment is not operational. 

Payment Card Industry Data 
Security Standard 

An information security standard administered by the Payment Card 
Industry Security Standards Council that is for organizations that 
handle branded credit cards from the major card schemes. 

PIN Entry Device   An electronic device used in a debit, credit or smart card-based 
transaction to accept and encrypt the cardholder's personal 
identification number. 

Post Office Protocol A mailbox access protocol defined by IETF RFC 1939. POP is one of 
the most commonly used mailbox access protocols. (NIST SP 800-45 
Version 2) 

https://tools.ietf.org/html/rfc6864
https://doi.org/10.6028/NIST.SP.800-15
https://doi.org/10.6028/NIST.SP.800-190
https://doi.org/10.6028/NIST.SP.800-39
https://doi.org/10.6028/NIST.SP.800-45ver2
https://doi.org/10.6028/NIST.SP.800-45ver2
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Private Key The secret part of an asymmetric key pair that is used to digitally 
sign or decrypt data. (NIST SP 800-63-3) 

Public CA A trusted third party that issues certificates as defined in IETF RFC 
5280. A CA is considered public if its root certificate is included in 
browsers and other applications by the developers of those 
browsers and applications. The CA/Browser Forum defines the 
requirements public CAs must follow in their operations. 

Public Key The public part of an asymmetric key pair that is used to verify 
signatures or encrypt data. (NIST SP 800-63-3) 

Public Key Cryptography Cryptography that uses separate keys for encryption and 
decryption; also known as asymmetric cryptography. (NIST SP 800-
77) 

Public Key Infrastructure (PKI) The framework and services that provide for the generation, 
production, distribution, control, accounting, and destruction of 
public key certificates. Components include the personnel, policies, 
processes, server platforms, software, and workstations used for 
the purpose of administering certificates and public-private key 
pairs, including the ability to issue, maintain, recover, and revoke 
public key certificates. (NIST SP 800-53 Rev. 4) 

Registration Authority An entity authorized by the certification authority system (CAS) to 
collect, verify, and submit information provided by potential 
Subscribers which is to be entered into public key certificates. The 
term RA refers to hardware, software, and individuals that 
collectively perform this function. (CNSSI 4009-2015) 

Representational State 
Transfer (REST) 

A software architectural style that defines a common method for 
defining APIs for web services.  

Risk Management Framework  The Risk Management Framework (RMF), presented in NIST SP 800-
37, provides a disciplined and structured process that integrates 
information security and risk management activities into the system 
development life cycle.  

Rivest, Shamir, & Adleman (RSA)  An algorithm approved in [FIPS 186] for digital signatures and in [SP 
800-56B] for key establishment. (NIST SP 800-57 Part 1 Rev. 4 ) 

Root certificate A self-signed certificate, as defined by IETF RFC 5280, issued by a 
root certificate authority. A root certificate is typically securely 

https://doi.org/10.6028/NIST.SP.800-63-3
https://doi.org/10.6028/NIST.SP.800-63-3
https://doi.org/10.6028/NIST.SP.800-77
https://doi.org/10.6028/NIST.SP.800-77
https://doi.org/10.6028/NIST.SP.800-53r4
https://rmf.org/wp-content/uploads/2017/10/CNSSI-4009.pdf
https://nvlpubs.nist.gov/nistpubs/SpecialPublications/NIST.SP.800-37r2.pdf
https://nvlpubs.nist.gov/nistpubs/SpecialPublications/NIST.SP.800-37r2.pdf
https://doi.org/10.6028/NIST.SP.800-57pt1r4
https://tools.ietf.org/html/rfc5280
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installed on systems, so they can verify end-entity certificates the 
receive. 

Root certificate authority In a hierarchical public key infrastructure (PKI), the CA whose public 
key serves as the most trusted datum (i.e., the beginning of trust 
paths) for a security domain. (NIST SP 800-32) 

Subject Alternative Name  A field in an X.509 certificate that identifies one or more fully 
qualified domain names, IP addresses, email addresses, URIs, or 
UPNs to be associated with the public key contained in a certificate.  

Simple Certificate Enrollment 
Protocol (SCEP) 

A protocol defined in an IETF internet draft specification that is used 
by numerous manufacturers of network equipment and software 
who are developing simplified means of handling certificates for 
large-scale implementation to everyday users, as well as referenced 
in other industry standards. 

Secure Hash Algorithm 256  A hash algorithm that can be used to generate digests of messages. 
The digests are used to detect whether messages have been 
changed since the digests were generated. (FIPS 180-4 [March 
2012]) 

Secure Transport Transfer of information using a transport layer protocol that 
provides security between applications communicating over an IP 
network. 

Server A computer or device on a network that manages network 
resources. Examples include file servers (to store files), print servers 
(to manage one or more printers), network servers (to manage 
network traffic), and database servers (to process database 
queries). (NIST SP 800-47) 

Service Provider A provider of basic services or value-added services for operation of 
a network; generally refers to public carriers and other commercial 
enterprises. (NISTIR 4734) 

Simple Mail Transfer Protocol 
(SMTP) 

The primary protocol used to transfer electronic mail messages on 
the internet. (NISTIR 7387) 

Special Publication  A type of publication issued by NIST. Specifically, the Special 
Publication 800-series reports on the ITL’s research, guidelines, and 
outreach efforts in computer security, and its collaborative activities 

https://doi.org/10.6028/NIST.SP.800-32
https://tools.ietf.org/html/draft-nourse-scep-23
https://csrc.nist.gov/publications/detail/fips/180/4/archive/2012-03-06
https://csrc.nist.gov/publications/detail/fips/180/4/archive/2012-03-06
https://doi.org/10.6028/NIST.SP.800-47
http://nvlpubs.nist.gov/nistpubs/ir/1992/ir4734.pdf
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with industry, government, and academic organizations. The 1800 
series reports the results of NCCoE demonstration projects. 

System Administrator Individual responsible for the installation and maintenance of an 
information system, providing effective information system 
utilization, adequate security parameters, and sound 
implementation of established Information Assurance policy and 
procedures. (CNSSI 4009-2015) 

Team A number of persons associated together in work or activity. 
(Merriam Webster) As used in this publication, a team is a group of 
individuals assigned by an organization’s management the 
responsibility to carry out a defined function or set of defined 
functions. Designations for teams as used in this publication are 
simply descriptive. Different organizations may have different 
designations for teams that carry out the functions described 
herein. 

Transport Layer Security (TLS) An authentication and security protocol widely implemented in 
browsers and web servers. TLS is defined by RFC 5246 and RFC 
8446.  

Trust Protection Platform (TPP) The Venafi Machine Identity Protection platform used in the 
example implementation described in this practice guide. 

User Principal Name In Windows Active Directory, this is the name of a system user in 
email address format, i.e., a concatenation of username, the “@” 
symbol, and domain name. 

Validation The process of determining that an object or process is acceptable 
according to a pre-defined set of tests and the results of those tests. 
(NIST SP 800-152) 

Web Browser A software program that allows a user to locate, access, and 
display web pages. 
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Appendix G Supplemental Architecture Configurations 4317 

G.1 Mail Server Configuration Files 4318 

The Postfix mail server and Dovecot mail client were both used to create an alert and administrative 4319 
email server for all alerts received from the various TLS security components used in the TLS lab. The 4320 
main.cf is the primary configuration file for Postfix and the dovecot.conf is used to configure the 4321 
Dovecot mail user agent.  Links to both files used in the TLS lab are provided below as a quick start to 4322 
setting up the same mail server and client used in the TLS lab.  The main.cf and dovecot.conf files are 4323 
stored in the same repository as this Volume D document on the NCCoE web page. 4324 

 https://www.nccoe.nist.gov/sites/default/files/library/supplemental-files/sp1800-16/main.cf  4325 
 4326 

 https://www.nccoe.nist.gov/sites/default/files/library/supplemental-files/sp1800-4327 
16/dovecote.conf 4328 
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